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EINFÜHRUNG IN MINDMANAGER 

ERSTE SCHRITTE 

KENNENLERNEN VON MINDMANAGER 

Mit den nachstehenden Ressourcen erhalten Sie mehr Informationen über Maps und die 

Verwendung von MindManager.  

Ü B E R S I C H T  

 In dieser kurzen Einführung erfahren Sie mehr über Maps und was Sie mit MindManager 

erreichen können. 

K U R Z A N L E I T U N G  

 Wenn Sie schnell loslegen wollen, erhalten Sie mit dieser Kurzanleitung einen schnellen 

Einstieg in MindManager. 

L E R N P R O G R A M M E  

 In den animierten Lernprogrammen zeigen wir Ihnen, wie Sie mit MindManager arbeiten 

können. 

HINWEIS: Für die Anzeige der Lernprogramme benötigen Sie eine Internetverbindung und 

einen flash-fähigen Webbrowser. 

B E I S P I E L E  U N D  V O R L A G E N  

 Schauen Sie sich online die Beispiele in Maps for That an, um einen Eindruck davon zu 

bekommen, welche Arten von Maps Sie anlegen können. 

T A S T A T U R K U R Z B E F E H L E  

 Hier finden Sie Kurzbefehle für häufig zu erledigende Aufgaben in MindManager. 

M E H R  U N T E R  M I N D J E T . C O M  

 Besuchen Sie auch unsere Website. Dort finden Sie noch weitere Informationen zu unseren 

Visual-Mapping- und Collaboration-Lösungen. 

 

http://onlinehelp.mindjet.com/help/mmmac/9/GER/QuickStartGuide/QuickStartGuide_MM9_Mac.pdf
http://www.mindjet.com/mac/tutorials/
http://www.mapsforthat.com/
http://www.mindjet.com/
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ÜBERSICHT MINDJET MINDMANAGER 

Visuelles Verknüpfen von Ideen, Informationen und Menschen 

Um fundierte geschäftliche Entscheidungen treffen zu können, benötigen Entscheider ein 

effizienteres Werkzeug zur Erfassung und Strukturierung von Ideen (ihrer eigenen und die der 

Teammitglieder), zum Festlegen der Priorität von Aufgaben und Ressourcenzuteilungen sowie das 

präzise und anschauliche Kommunizieren der Ergebnisse. Die in Team-Meetings ausgetauschten 

Ideen, Einblicke und Meinungen sind essentiell. Im Zuge ihrer Erfassung gehen jedoch häufig 

Informationen und ihr Kontext verloren oder werden als unstrukturierte Ansammlung von Notizen 

erfasst. Das erschwert es enorm, die vielen Beiträge in einen schlüssigen Maßnahmenplan 

umzusetzen. 

Das visuell orientierte Informations-Mapping von MindManager ist die effizienteste Methode, Ideen 

und Informationen zu erfassen, zu strukturieren und zu kommunizieren. Sie versetzt den Nutzer in 

die Lage, in ein- und derselben Ansicht gleichzeitig das Gesamtbild und die relevanten Details zu 

erfassen. Mit MindManager gelingt Ihnen mühelos die Umsetzung von Ideen, unstrukturierten 

Forschungsergebnissen und erfassten Anforderungen in fertige Strategien, Präsentationen und 

Projektpläne – und das alles in derselben visuellen Umgebung. 

B R I N G E N  S I E  M I T  V I S U E L L E M  I N F O R M A T I O N S - M A P P I N G  O R D N U N G  I N S  C H A O S  

 Nutzen Sie MindManager-Maps als virtuelle Whiteboards zum einfachen Erfassen von 

Ideen und visuellen Strukturieren von Projekten, Präsentationen und Strategien. 

 Durch einfaches Erfassen der Beiträge der Beteiligten (Schnelleingabemodus), Ziehen von 

Verbindungen und Neuanordnen des Inhalts fördern Sie das Brainstorming und die 

teambasierte Problemlösung. 

 In einer dynamischen Ansicht, in der die Möglichkeit besteht, Zweige ein- und 

auszublenden, zugehörige Dokumente anzuhängen oder zu verlinken, Kalkulationstabellen 

einzubetten und im Web zu suchen, erfassen Sie gleichzeitig das Gesamtbild und alle 

relevanten Details. 

 Importieren Sie Inhalte aus Microsoft Word und Apple iWork Pages, damit Sie mit allen 

relevanten Daten in einer visuellen Umgebung arbeiten können. 

K O M M U N I Z I E R E N  S I E  E F F E K T I V E R  B E I  K Ü R Z E R E R  V O R B E R E I T U N G S Z E I T  

 Schlagen Sie zwei Fliegen mit einer Klappe: Nutzen Sie ein- und dieselbe Lösung, um Ihr 

Anliegen zunächst in einem visuellen Format zu skizzieren und es anschließend 

verständlicher und einprägsamer zu präsentieren. Stellen Sie sicher, dass sich die 

Beteiligten einbringen und am selben Strang ziehen, indem Sie das erhaltene Feedback 

noch während der Präsentation einpflegen. 
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 Sprechen Sie mittels effektiver Kommunikation mehrere Zielgruppen an, indem Sie ein 

interaktives Folienformat nutzen, das flexibel genug ist, sowohl Projekte im Überblick als 

auch die detaillierte Aufschlüsselung von Aufgaben präsentieren zu können. 

 Halten Sie verbindlichere Meetings ab, indem Sie einen dynamischen Rahmen für das 

Präsentieren von Informationen und die Erfassung von Kommentaren nutzen. 

 Reduzieren Sie die Anzahl der Überarbeitungszyklen, indem Sie den Inhalt visuell 

strukturieren und vor der endgültigen Veröffentlichung in Microsoft PowerPoint oder 

iWork Keynote Feedback einpflegen. 

D E F I N I E R E N  S I E  P R Ä Z I S E  D E N  U M F A N G  V O N  P R O J E K T L E I S T U N G E N  U N D  R E S S O U R C E N  

 Dokumentieren Sie erfolgreich alle Aspekte jedes Projekts, und versichern Sie sich der 

Zustimmung aller wichtigen Beteiligten. 

 Analysieren Sie Prioritäten, und stellen Sie die aktive Beteiligung der Projektbeteiligten in 

Bezug auf Ziele, Termine, Ressourcen und Strategien sicher, indem Sie Projektpläne in einer 

visuellen, interaktiven Map erarbeiten. 

 Planen Sie Aufgaben, teilen Sie Ressourcen ein, und verfolgen Sie Start-/Fälligkeitstermine, 

um die Grundlagen für eine erfolgreiche Umsetzung des Projekts zu legen. 

 Führen Sie im Sinne einer fundierten Entscheidungsfindung alle Informationen in einer 

zentralen Map zusammen, in der sich alle relevanten Details einfach überprüfen lassen. 

 

WAS IST EINE MINDMANAGER-MAP? 

Vereinfacht gesagt funktionieren Mindjet® MindManager®-Maps wie Straßenkarten. Sie bilden 

komplexe Informationen in einem geordneten, einfach zu erfassenden Format ab. Darüber hinaus 

lassen sich in Ihnen aber auf einfache Weise Verbindungen, Hindernisse und Pfade sichtbar machen. 

Da erleichtert die Ermittlung der besten Vorgehensweise. Statt das Reisen zu vereinfachen, 

optimieren MindManager-Maps jedoch Prozesse, Projekte und Planungsvorgänge. Ein weiterer 

Unterschied: Sie legen sie selbst an. 

E R L E I C H T E R T  D E N  E I N S T I E G :  E R F A S S E N  

Mit ihrer intuitiven, hochgradig interaktiven Oberfläche erleichtert eine MindManager-Map den 

Einstieg. Zunächst geben Sie ein Hauptthema ein. Davon ausgehend können Sie und Ihr Team Ihrer 

Kreativität freien Lauf lassen. Es lassen sich sogar externe Informationen von Websites, aus 

Kalkulationstabellen, Blogs usw. einbinden. Durch schnellen Zugriff auf die Bibliothek und die 

Informationsbereiche sowie die konfigurierbaren Vorlagen gelingt das Erstellen von Maps in 

optimierter und gewisser Weise standardisierter Form. 
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Sie beginnen eine Map, indem Sie Zweige einfügen. 

E R L E I C H T E R T  D A S  W E I T E R E  V O R G E H E N :  S T R U K T U R I E R E N  

MindManager-Maps geben Ihnen den Überblick über das Gesamtbild: mit einander 

überschneidenden Verbindungen zwischen zusammengehörigen Punkten und Unterpunkten sowie 

grafischen Anhaltspunkten wie Hervorhebungen, Icons, Formaten und Grafiken. Schon bald werden 

Sie in kürzerer Zeit bessere Entscheidungen treffen. Und dies ist erst der Anfang. Maps sind auch 

Vorlagen für das weitere Vorgehen. Mit ihnen weisen Sie Aufgaben zu, überwachen deren 

Erledigung, teilen Sie Ressourcen ein und legen Sie Termine und Zielvorgaben fest. 

 

Fügen Sie optische Anhaltspunkte und Links zu Informationsquellen hinzu. 

E I N F A C H  Z U  P R Ä S E N T I E R E N ,  Z U  V E R S C H I C K E N  U N D  Z U  V E R Ö F F E N T L I C H E N :  
F R E I G E B E N   

Zeigen Sie Diashows, und erstellen Sie mühelos Präsentationen. Mit der Freigabefunktion von 

Mindjet Share veröffentlichen und verteilen Sie Links zu interaktiven Online-Versionen Ihrer Maps in 

Blogs und auf stark frequentierten Social-Networking-Sites und beziehen so Ihre Kollegen stärker ein. 

Sie senden interaktive Viewer-Maps als E-Mail-Anhang oder wählen unter einer Vielzahl weiterer 

Formate. Mit iChat übermitteln Sie Maps in Echtzeit an andere Benutzer. 
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Freigeben< und exportieren Sie Maps in eine Vielzahl von Formaten. 

 

KLEINE TIPPS 

Nachstehend finden Sie einige Tipps, die Ihnen den Einstieg in MindManager erleichtern. Für viele 

häufig genutzte Befehle können Sie Tastaturkurzbefehle verwenden. Unter Tastaturkurzbefehle 

finden Sie eine vollständige Liste mit diesen Kurzbefehlen. 

A L L G E M E I N  

 In MindManager können Sie viele Aufgaben durch Verschieben von Elementen per 

Drag&Drop erledigen.  

 Schnellen Zugang zu vielen Befehlen erhalten Sie durch Klicken in die Zweige und 

Elemente bei gedrückter Control-Taste (oder mit der rechten Maustaste). 

H I N Z U F Ü G E N  U N D  A N O R D N E N  V O N  Z W E I G E N  

 Zum schnellen Einfügen eines Zweigs drücken Sie einfach den Zeilenschalter. 

 Zum Anlegen eines neuen Unterzweigs wählen Sie einen Zweig aus und drücken Befehl-

Zeilenschalter. 

 Zum Verschieben von Zweigen ziehen Sie diese einfach an eine neue Stelle (zum 

Kopieren halten Sie dabei die Wahltaste gedrückt). 

 Zum Hinzufügen häufig verwendeter Zweige ziehen Sie Map Parts aus der Bibliothek in 

die Map. 

 Ziehen oder kopieren Sie Zweige und Elemente aus anderen offenen Maps einfach per 

Drag&Drop in Ihre Map. 

A N Z E I G E N  U N D  N A V I G I E R E N  

 Mit Tab-Taste und der Shift-Tab springen Sie von Zweig zu Zweig. 

 Verwenden Sie Lesezeichen, um durch die wichtigsten Zweige zu navigieren. 

 Durch Reduzieren oder Verwenden eines Filter-Befehls können Sie Zweige zeitweilig 

ausblenden. 
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 Mit dem Befehl Zweig fokussieren können Sie die Aufmerksamkeit auf einen bestimmten 

Bereich der Map konzentrieren. 

 Blenden Sie Elemente aus, ohne Sie aus der Map zu entfernen, indem Sie Darstellung > 

Einblenden & Ausblenden wählen. 

H I N Z U F Ü G E N  V O N  I N F O R M A T I O N E N  M I T  H I L F E  V O N  M A R K I E R U N G E N ,  A N H Ä N G E N  
U N D  L I N K S  

 Fügen Sie mit Icons, Tags und Farbmarkierungen aus den Informationen für 

Markierungen visuelle Informationen hinzu. Klicken Sie in die Icon-Markierung eines 

Zweigs, um alle Markierungen dieser Gruppe zu durchlaufen (nur einander 

ausschließende Icon-Markierungen). 

 Gestalten Sie Ihre Maps einfach und übersichtlich, indem Sie detaillierte Informationen 

in den Zweignotizen unterbringen. 

 Fügen Sie Zweigen bestehende Dokumente als Bestandteil Ihrer Map hinzu. 

 Verweisen Sie mit Hyperlinks auf externe Dokumente, Webseiten und Zweige in anderen 

Maps. 

 Fügen Sie Aufgabeninformationen wie Datum, Dauer, Priorität, Fortschritt und 

Ressourcen aus dem Aufgabenbereich im Informationsfenster hinzu. 

G R U P P I E R E N ,  Z U S A M M E N F A S S E N  U N D  V E R B I N D E N  V O N  Z W E I G E N  

 Verwenden Sie Umrandungen, um Gruppen von Unterzweigen zusammenzufassen und 

hervorzuheben. 

 Verwenden Sie eine Klammer mit Anmerkung, um eine Gruppe von Unterzweigen 

zusammenzufassen. 

 Machen Sie durch Verbindungspfeile Zusammenhänge zwischen nicht verbundenen 

Zweigen deutlich und verwenden Sie eine Anmerkung zur Beschriftung. 

V I S U E L L E  H E R V O R H E B U N G E N  

 Weisen Sie Ihrer Map einen anderen Stil aus dem Menü Format hinzu, um das 

Gesamterscheinungsbild der Map zu ändern und ihr ein unverkennbares Aussehen zu 

geben. 

 Wählen Sie mehrere Zweige oder Elemente aus und ändern Sie mit den Informationen 

schnell und mühelos deren Formatierung und Layout. 

 Legen Sie interaktiv die Standardformatierung für Zweige und Elemente fest. Diese 

Formatierung wird dann automatisch auf neue Zweige und Elemente übertragen. 

 Ziehen Sie Bilder und Hintergründe zur visuellen Hervorhebung aus der Bibliothek in Ihre 

Map. 

F R E I G E B E N  V O N  M A P S  

 Senden Sie Maps im Ursprungsformat an andere Nutzer der Mindjet-Mapping-Software, 

indem Sie sie per E-Mail oder noch schneller per iChat verschicken.  
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 Stellen Sie interaktive Viewer-Maps online, damit Sie über einen standardmäßigen flash-

fähigen Browser von jedem geöffnet werden können.  

 Exportieren und verteilen Sie Maps in einer Vielzahl weiterer Formate wie iWork- und 

Office-Dokumente. 

 Binden Sie Bilder, die Sie in anderen Anwendungen erstellen, in Dokumente ein. 

M A P S  A L S  D Y N A M I S C H E  U N D  V I S U E L L E  H I L F S M I T T E L  F Ü R  B R A I N S T O R M I N G ,  
M E E T I N G S  U N D  P R Ä S E N T A T I O N E N  

 Erzeugen Sie Folien zur Verwendung in einer MindManager-Präsentation oder 

exportieren Sie sie, um eine PowerPoint- oder Keynote-Präsentation zu erzeugen. 

 Nutzen Sie den Schnelleingabemodus, um Ideen bei Brainstorming-Sitzungen ungeordnet 

einzugeben, und ziehen Sie sie dann zur Erzeugung einer logischen Struktur in die Map. 

 Zeigen Sie Ihre Meeting-Agenda in Map-Form an, und nutzen Sie die Werkzeuge für die 

Navigation, um nacheinander die relevanten Zweige zu fokussieren. 

 Starten Sie den Timer, damit Sie bei Ihrem Meeting oder Ihrer Brainstorming-Sitzung im 

Zeitplan bleiben. 

V E R W E N D U N G  V O N  M A C  O S  X - W E R K Z E U G E N  M I T  M I N D M A N A G E R  

 Suchen Sie mit Spotlight nach Maps. Maps werden für Spotlight-Suchen automatisch 

indiziert. 

 Automatisieren Sie häufige Aufgaben in MindManager mit AppleScript-Befehlen. Öffnen 

Sie das MindManager-Wörterbuch im AppleScript Script Editor, um die verfügbaren 

MindManager-Befehle anzuzeigen.  

 Nutzen Sie die Mac OS X-Werkzeuge für die Rechtschreibprüfung, um Ihre Map zu 

überprüfen. MindManager greift zur Prüfung der Rechtschreibung auf das Mac OSX-

Wörterbuch zu.  

Mehr Informationen über die hier beschriebenen Aufgaben erhalten Sie, wenn Sie das Gesuchte 

in das oben befindliche Suchfeld eingeben. 

 

WAS IST NEU IN MINDMANAGER 9 FÜR MAC? 

Folgende neue Funktionen und Verbesserungen sind in diese Version eingeflossen: 

N E U E  F O L I E N - P R Ä S E N T A T I O N E N  

 Präsentieren Sie Ihre Arbeit auf einfach nachvollziehbaren Folien. Wählen Sie zu 

präsentierende Zweige, ändern Sie deren Reihenfolge und steuern Sie exakt, wie jeder 

Zweig angezeigt werden soll. 

 Zeigen Sie Ihre Folien in einer MindManager-Diashow an oder exportieren Sie sie in eine 

Keyonote- oder PowerPoint-Präsentation. 
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W Y S I W Y G - D R U C K F U N K T I O N E N  

 Das Ausdrucken von Maps ist jetzt einfacher denn je zuvor. Legen Sie fest, dass die gesamte 

Map oder nur ausgewählte Folien gedruckt werden sollen. So drucken Sie exakt das aus, 

was Sie benötigen. 

Ü B E R A R B E I T E T E  B E N U T Z E R O B E R F L Ä C H E  

 Finden Sie genau das, wonach Sie suchen – dank verbesserter Struktur der Menüoptionen 

und weiterentwickelter Benutzeroberfläche. 

 Die neue Map-Galerie erleichtert den Einstieg durch Wahl einer Vorlage bzw. die 

Wiederaufnahme der Arbeit an einer bestehenden Map. 

 Symbolleiste für das Formatieren: Hier haben Sie schnellen Zugriff auf die Befehle zum 

Formatieren und Bearbeiten von Map-Elementen. 

 Verbesserte Informationen: Die Informationen wurden bedienfreundlicher gestaltet. 

Zudem können Sie mehrere Informationen gleichzeitig öffnen, um schnell auf die am 

häufigsten verwendeten Optionen zuzugreifen. 

 Verbesserte Notizen: Zweignotizen lassen sich jetzt im Kontext des Notizenfensters 

formatieren. 

L O K A L E ,  E R W E I T E R T E  I M P O R T -  U N D  E X P O R T - T R A N S F O R M A T I O N E N  

 Für den Import/Export von Dateien benötigen Sie keine Internetanbindung mehr. 

Stattdessen profitieren Sie ab sofort von der produktinternen Kompatibilität mit MS Office 

Mac 2011 und iWork 09. 

 Weitere Export-Optionen ermöglichen den Export Ihrer Map oder Folien in eine Vielzahl 

von Formaten.  

 Jetzt haben Sie die Möglichkeit, Freemind-Maps ohne Umwege in MindManager zu 

importieren. 

V E R B E S S E R T E  F I L T E R  U N D  A U S W A H L  

 Das Filtern und Auswählen von Map-Elementen gelingt jetzt dank hilfreicher Tool-Tipps 

sowie vereinfachter Erstellung und Verwendung gesicherter Regeln viel intuitiver. 

S C H N E L L E I N G A B E M O D U S  

 Beschleunigen Sie die Eingabe und Strukturierung von Ideen in die Map, und optimieren Sie 

so das Brainstorming und die Mapping-Erfahrung. 
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V E R B E S S E R T E  B I L D E R ,  S T I L E  U N D  V O R L A G E N  

 Zur Aufwertung Ihrer Präsentationen und zur Lieferung von mehr Kontext für Maps steht 

Ihnen eine große Auswahl an geschäftsorientierten Icons, Bildern, Vorlagen und Stilen zur 

Verfügung. 
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STARTEN EINER NEUEN MAP 

ERSTELLEN EINER NEUEN MAP 

Jede neue Map, die Sie erstellen, basiert auf einer Vorlage. Wenn Sie MindManager starten, 

erscheint standardmäßig die Map-Galerie. Dort können Sie eine Vorlage für die neue Map wählen. 

Wenn Sie nach Öffnen von MindManager lieber sofort mit einer neuer Map beginnen möchten, 

können Sie dieses Verhalten ändern. In MindManager können Sie eine neue Map auf der Basis der 

Standardvorlage oder einer von Ihnen gewählten Vorlage anlegen. 

So beginnen Sie beim Starten von MindManager mit einer neuen Map: 

1. Klicken Sie in der Map-Galerie in die Map-Vorlage, die als Basis für die neue Map dienen soll.  

2. Klicken Sie in Auswählen. 

So beginnen Sie beim Start automatisch mit einer neuen Map: 

1. Wählen Sie MindManager > Einstellungen.  

2. Wählen Sie unter Bei Start die Option Neue Map erstellen. 

So beginnen Sie in MindManager mit einer neuen Map: 

 Wählen Sie Ablage > Neu, um unter Verwendung der Standardvorlage eine neue Map anzulegen. 

 Wählen Sie Ablage > Neu, um für die neue Map eine spezielle Vorlage auszuwählen. 

Für neue Maps wird standardmäßig die Vorlage "Leere Map" verwendet.  

 

VERWENDEN VON VORLAGEN ZUM ANLEGEN NEUER MAPS 

Zum Erstellen einer MindManager-Map auf der Basis einer Vorlage wählen Sie zunächst eine Vorlage 

aus der Map-Galerie aus. Die Galerie enthält, geordnet nach Kategorien, eine Vielzahl von Map-

Vorlagen für einige häufig verwendete Maps. Map-Vorlagen haben einen vordefinierten Inhalt und 

vordefinierte Formatierungen (wie bei Briefvorlagen in anderen Anwendungen). Daher müssen Sie 

häufig verwendete Map-Typen nicht jedes Mal neu erstellen. 

Verwenden Sie die Map-Vorlagen als Ausgangspunkt: Sie können die Vorlagen bearbeiten, um 

eigenen Inhalt hinzuzufügen. Außerdem können Sie sie verwenden, um einen Einblick zu bekommen, 

welche Funktionen und Formatierungsmöglichkeiten MindManager bietet. 

Wenn Sie eine Vorlage auswählen, öffnen Sie tatsächlich eine Kopie dieser Vorlage. Die 

Originalvorlage bleibt unverändert. 
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Wenn Sie beim Anlegen neuer Maps in der Regel eine bestimmte Map-Vorlage auswählen, können 

Sie festlegen, dass sie als Standardvorlage verwendet wird, wenn Sie eine neue Map anlegen. 

Außerdem können Sie in den MindManager-Einstellungen festlegen, dass MindManager bei jedem 

Start unter Verwendung dieser Vorlage automatisch eine neue Map beginnen soll. 

So legen Sie eine neue Map auf der Basis einer Vorlage an: 

Wenn beim Start von MindManager die Map-Galerie angezeigt wird, können Sie dort die Vorlage 

wählen. Wenn Sie MindManager gestartet haben, können Sie folgende Schritte verwenden: 

1. Wählen Sie Ablage > Neu aus Vorlage. 

2. Wählen Sie in der Map-Galerie eine Map-Vorlage aus. (Wählen Sie in der linken Spalte eine 

Kategorie, wenn die Vorlagen anhand ihrer Funktion nach Kategorien geordnet sein sollen.) 

3. Wenn Sie eine neue Map ohne jeglichen Inhalt beginnen möchten, wählen Sie die Vorlage "Leere 

Map". 

4. Klicken Sie in Auswählen. 

5. Es wird eine neue Map geöffnet, die auf der gewählten Vorlage basiert. 

6. Bearbeiten Sie die Map und fügen Sie Ihren eigenen Inhalt hinzu. 

7. Sichern Sie die neue Map. 

So ändern Sie die Standardvorlage für neue Maps: 

1. Wählen Sie MindManager > Einstellungen. 

2. Klicken Sie in der Liste Neue Map-Vorlage in Auswählen. 

3. Wählen Sie die Vorlage aus, die jedes Mal geöffnet werden soll, wenn Sie eine neue Map 

erstellen. 

4. Klicken Sie in Auswählen, und dann im Dialog Einstellungen in OK. 

Wenn Sie Ablage > Neu wählen, wird eine neue Map automatisch auf Basis der von Ihnen 

ausgewählten Vorlage angelegt. 

Wenn MindManager bei jedem Start automatisch eine neue Map beginnen soll, wählen Sie in den 

Einstellungen unter Bei Start die Option Neue Map erstellen. Die neue Map basiert auf der 

gewählten Vorlage. 

Wenn Sie mit dem Inhalt der Vorlage zufrieden sind, aber einen anderen Look für die Map wollen, 

können Sie einen anderen Stil anwenden. Sie können auch Ihre eigenen Vorlagen mit angepasstem 

Inhalt und angepasster Formatierung erstellen und sichern.  
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ANZEIGEN EINER MAP 

MAPANSICHT UND GLIEDERUNGSANSICHT 

In MindManager gibt es zwei Möglichkeiten eine Map anzuzeigen: in einer Mapansicht und einer 

Gliederungsansicht. 

In der Mapansicht werden die Zweige in einer strahlenförmigen, hierarchischen Form dargestellt - 

einer Map. In dieser Ansicht können Sie grafische Elemente sehen (z. B. Farben, Grafiken, 

Verbindungen und Umrandungen), Aufgabeninformationen anzeigen und Lesezeichen zur Navigation 

zwischen Zweigen verwenden. Diese Ansicht eignet sich am besten zum Anlegen und Formatieren 

von Maps. 

In der Gliederungsansicht werden dieselben Zweige in der vertrauten linearen Form dargestellt, in 

der Sie das Dokument von oben nach unten lesen und durch das Dokument von oben nach unten 

navigieren können. Wenn Sie gerade anfangen, mit MindManager zu arbeiten, kann diese Ansicht 

wertvolle Unterstützung bieten. Die Gliederungsansicht ist dahingehend eingeschränkt, dass keine 

Zweigfarbe bzw. -schrift, Aufgabeninformationen, Grafiken, Tags, Verbindungen, Umrandungen oder 

der Map-Hintergrund angezeigt werden. 

In beiden Ansichten werden jedoch Icons, Beschriftungen, Notizen, Hyperlinks und Anhänge 

berücksichtigt. 

So wechseln Sie zwischen Map- und Gliederungsansicht: 

 Klicken Sie in Darstellung > Gliederungsansicht oder Darstellung > Mapansicht. 

Neue und bestehende Maps werden immer in der Mapansicht geöffnet. Ihre Map wird immer wie 

angezeigt gedruckt: in der Mapansicht als Map und in der Gliederungsansicht als Gliederung. 

Wenn Sie die Map als Gliederung exportieren möchten, können Sie die Gliederungsansicht 

verwenden, um eine Vorschau der Zweige in linearer Anordnung anzuzeigen und evtl. notwendige 

Anpassungen vorzunehmen. 

 

VERGRÖßERN UND VERKLEINERN (ZOOM-FUNKTION) 

In der Mapansicht können Sie in die Ansicht zoomen, um diese zu vergrößern und mehr Details zu 

sehen. Das funktioniert natürlich auch umgekehrt. Darüber hinaus können Sie die Map oder die 

gerade ausgewählten Objekte an die Fenstergröße anpassen oder die Map in tatsächlicher Größe 

anzeigen (Zoomfaktor = 100 %). Wenn Ihr System die Verwendung von Fingergesten unterstützt, 

können Sie damit hinein- und herauszoomen. 
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So zoomen Sie: 

 Wählen Sie Darstellung > Zoom > Vergrößern bzw. Verkleinern. 

T I P P :  Wenn Ihr System Fingergesten unterstützt können Sie durch Spreizen/Zusammenführen 

(Pinch/Expand) der Finger heraus- bzw. hineinzoomen. 

 Zur Anpassung der Map an das Anwendungsfenster wählen Sie Darstellung > Zoom > An Fenster 

anpassen. 

 Zur Anpassung der Größe der ausgewählten Objekte an das Anwendungsfenster wählen Sie 

Darstellung > Zoom > Auswahl anpassen. 

 Wenn die Map in Originalgröße (100 %) angezeigt werden soll, wählen Sie Darstellung > Zoom > 

Tatsächliche Größe. 

Für diese Funktionen können Sie auch den Schieberegler links unten im Map-Fenster verwenden. 

Wenn Sie die Map sichern oder exportieren, wird ein Bild der Map mit dem aktuellen Zoomfaktor 

gesichert oder exportiert. Für das Ausdrucken spielt der Zoomfaktor keine Rolle: Die Map wird in 

dem unter Ablage > Papierformat festgelegten Maßstab ausgedruckt.  

Neben dem Zoomen erleichtern auch die Detail-Befehle das Navigieren in großen oder komplexen 

Maps. 

 

REDUZIEREN UND ERWEITERN VON ZWEIGEN 

In der Map- und Gliederungsansicht können Sie steuern die Detailebene (Anzahl der Unterzweig 

Ebenen) für jedes Thema einzeln oder als Gruppe angezeigt. 

So erweitern bzw. reduzieren Sie Zweige: 

 In der Mapansicht klicken Sie auf das Erweitern-Symbol  bzw. das Reduzieren-Symbol  

am Zweig. 

 In der Gliederungsansicht klicken Sie auf den Erweitern-Pfeil  bzw. den Reduzieren-Pfeil  am 

Zweig. 

So erweitern bzw. reduzieren Sie mehrere Zweige in der Mapansicht: 

1. Wählen Sie einen Zweig oder Zweige. Wenn Sie das Hauptthema auswählen, wird die gesamte 

Map einbezogen. 

2. Wählen Sie Darstellung > Detail. 

3. Wählen Sie die anzuzeigende Detailebene. 
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So fokussieren Sie einen Zweig in der Mapansicht (erweitern den Zweig und reduzieren alle übrigen): 

 Wählen Sie Darstellung > Detail und anschließend Zweig fokussieren. 

Das Ausdrucken, Exportieren und Sichern der Map erfolgt im angezeigten Zustand, das heißt, mit 

erweiterten bzw. reduzierten Zweigen. 

Zum Ausblenden können Sie die Zweige auch filtern. Weitere Informationen zum Filtern der Map 

finden Sie unter Filtern von Zweigen. 

 

FILTERN VON ZWEIGEN 

Wenn in Ihrer Map nur ein Teil der Zweige sichtbar sein soll, können Sie sie filtern. Dies kann manuell 

oder durch Einblenden/Ausblenden der gewählten Zweige erfolgen. Wahlweise können Sie auch eine 

gespeicherte Regel zum Definieren der Filterkriterien verwenden. 

So filtern Sie die Map manuell: 

1. Markieren Sie eine Gruppe von Zweigen: Sie können die Zweige markieren, die eingeblendet 

werden sollen (nur diese werden angezeigt, alle anderen ausgeblendet) oder ausgeblendet 

werden sollen (diese werden ausgeblendet, alle anderen angezeigt). 

T I P P : Klicken Sie bei gedrückter Befehlstaste auf einen Zweig, um ihn zu der Gruppe der bereits 

ausgewählten Zweige hinzuzufügen. 

2. Klicken Sie in der Symbolleiste in das Symbol Filter, oder wählen Sie Darstellung > Filter. 

3. Wählen Sie Auswahl ausblenden oder Andere ausblenden. 

Die gelbe Filteranzeige befindet sich am unteren Map-Rand. 

Das Filtern ist ein kumulativer Vorgang: Sie können mehrere Zweige auswählen und dann die Map 

erneut filtern. Diese Filter wirken nur auf die noch sichtbaren Zweige. 

So filtern Sie mit einer gespeicherten Regel: 

1. Klicken Sie in der Symbolleiste in das Symbol Filter, oder wählen Sie Darstellung > Filter.  

2. Wählen Sie im Menü die zu verwendende gespeicherte Regel. Es werden nur Zweige angezeigt, 

die der Regel entsprechen. 

3. Wenn Sie eine andere Regel verwenden möchten, wählen Sie Regeln bearbeiten, um eine Regel 

zu erstellen oder zu bearbeiten.  

So heben Sie alle aktiven Filter auf: 

 Wählen Sie Darstellung > Filter > Filter entfernen. 
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Wenn Sie die gefilterte Map sichern, ist der Filter auch beim nächsten Öffnen noch aktiv. Wenn ein 

Filter aktiv ist, werden ausgeblendete Zweige nicht in Folien bzw. die Druck- oder Export-Ausgabe 

übernommen. 

 

ERSTELLEN ODER BEARBEITEN GESPEICHERTER REGELN 

Wenn Sie in den Einblendmenüs Filter oder Auswählen die Option Regeln bearbeiten wählen, wird 

das Fenster Regeln geöffnet. Hier sind die gespeicherten Regeln aufgelistet. Sie können die 

angezeigten Regeln anwenden, neue Regeln erstellen und vorhandene Regeln bearbeiten oder 

löschen.  

Der schnellste Weg, eine gespeicherte Regel auf ausgewählte oder angezeigte Zweige anzuwenden, 

führt über die Menüs Filter oder Auswählen. Im Fenster Regeln erhalten Sie jedoch zusätzliche 

Informationen und Optionen.  

So rufen Sie das Fenster Regeln auf: 

 Wählen Sie Auswählen > Regeln bearbeiten oder Darstellung > Filter > Regeln bearbeiten. 

 Wählen Sie im Symbolleisten-Einblendmenü Filter oder Auswählen die Option Regeln 

bearbeiten. 

So filtern oder wählen Sie Zweige unter Verwendung einer Regel aus dem Fenster "Regeln": 

1. Zeigen Sie in den Namen der Regel, damit die Symbole Filter und Auswählen angezeigt werden. 

2. Wenn Sie in das Symbol Auswählen zeigen, sehen Sie, wie viele Zweige von der Regel 

ausgewählt werden. Das schließt auch die durch einen Filter ausgeblendeten Zweige ein. 

3. Klicken Sie auf das Symbol für die durchzuführende Aktion: 

 Filter zeigt nur die Zweige an, die den Filterkriterien genügen. 

 Auswählen zeigt alle Zweige an, die den Filterkriterien genügen. 

T I P P :  Sie können Regeln auch aus dem Einblendmenü Aktion am unteren Rand des Bereichs 

anwenden. Dieses Menü bietet die zusätzliche Filteroption zum Ausblenden von Zweigen, die den 

Regelkriterien genügen. 

So fügen Sie eine neue Regel hinzu: 

1. Klicken Sie in das Symbol + (Hinzufügen) am unteren Rand des Fensters Regeln. 

2. Geben Sie im daraufhin geöffneten Fenster Regel bearbeiten einen Regelnamen ein, definieren 

Sie die Kriterien, und klicken Sie dann in OK. 

Die neue Regel erscheint in der Auswahl der gesicherten Regeln in den Menüs Filter und Auswählen 

sowie im Fenster Regeln. 
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So bearbeiten Sie eine Regel: 

1. Wählen Sie eine der folgenden Verfahrensweisen: 

 Doppelklicken Sie in der Liste im Fenster Regeln in den Regelnamen. 

 Wählen Sie den Regelnamen in der Liste, klicken Sie in das Symbol des Menüs Aktion, und 

klicken Sie im Menü Aktion auf Bearbeiten. 

 Wenn Sie eine Kopie der Regel bearbeiten möchten, um eine neue Regel zu erstellen, klicken 

Sie in Duplizieren. Dann wählen Sie die Kopie der Regel und gehen wie oben beschrieben 

vor. 

2. Bearbeiten Sie im daraufhin geöffneten Fenster Regel bearbeiten den Regelnamen und die 

Kriterien, und klicken Sie dann in OK. 

So löschen Sie eine bestehende Regel: 

 Wählen Sie einen Regelnamen, und klicken Sie in das Symbol - (Löschen) am unteren Rand des 

Fensters Regeln. 

 

AUSBLENDEN VON MAP-ELEMENTEN 

Map-Elemente, die in der Mapansicht oder auf Folien zeitweilig nicht angezeigt werden sollen, 

müssen nicht zwangsläufig gelöscht werden. Sie können sie einfach ausblenden. Dies ist besonders 

dann hilfreich, wenn Sie Informationen in die Map aufnehmen, die nur für Sie bestimmt sind und 

nicht während einer Präsentation, beim Ausdrucken oder Weiterleiten der Map angezeigt werden 

sollen. Elemente werden dem Typ nach als Gruppe ausgeblendet und können nicht einzeln 

ausgeblendet werden. 

So blenden Sie Map-Elemente ein bzw. aus: 

1. Wählen Sie Darstellung > Einblenden & Ausblenden. 

2. Wählen Sie die Elemente, die Sie ausblenden möchten; heben Sie die Auswahl der Elemente auf, 

die eingeblendet werden sollen. 

Auch beim Festlegen von Optionen für Präsentationen können Sie Elemente ein- oder ausblenden. 

Wenn Sie die Map mit ausgeblendeten Elementen sichern, bleiben diese auch beim nächsten Öffnen 

der Map ausgeblendet. Ausgeblendete Elemente tauchen auf Folien, ausgedruckten Maps bzw. in 

exportierten Dateien nicht auf. 

Elemente werden dem Typ nach als Gruppe ausgeblendet und können nicht einzeln ausgeblendet 

werden. Mit dem Befehl Filtern lassen sich Zweige einzeln ausblenden. 
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ANZEIGEN MEHRERER MAPS 

Sie können mehrere Maps zur gleichen Zeit anzeigen, indem Sie sie einfach nacheinander öffnen. Mit 

dem Menü Fenster können Sie Map-Fenster unabhängig voneinander anordnen und in der Größe 

verändern sowie zwischen geöffneten Maps wechseln. 

So verwenden Sie Map-Fenster: 

 Wenn all Ihre Map-Fenster im Vordergrund angezeigt werden sollen, wählen Sie Fenster > Alle 

nach vorne bringen. 

 Zum Minimieren des aktuellen Map-Fensters wählen Sie Fenster > Im Dock ablegen.  

Zum Maximieren der Größe wählen Sie Fenster > Zoomen. 

 Um eine bestimmte Map in den Vordergrund zu bringen, wählen Sie Fenster. Dann klicken Sie in 

der Liste am unteren Rand des Menüs in den Map-Namen. 

Icons neben dem Namen der Map geben ihren Status an: 

  gibt die aktuelle Map an. 

  heißt, dass die Map nicht gesichert ist. 

  heißt, dass das Map-Fenster im Dock abgelegt ist. 
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NAVIGIEREN 

NAVIGIEREN IN DER MAPANSICHT 

Das Navigieren in der Mapansicht ist mit der Maus und den Bildlaufleisten ein Kinderspiel. Auch mit 

der Tastatur können Sie sich äußerst effizient durch Maps bewegen. Besonders hilfreich kann dies 

bei einer Präsentation sein, wenn Sie sich methodisch durch die Map vorarbeiten möchten. 

Wenn Ihr System die Verwendung von Fingergesten unterstützt, können Sie damit scrollen und 

zoomen. 

So navigieren Sie mit der Tastatur:E B N I S  

Tab, Shift+Tab Sie springen zum nächsten oder vorherigen Zweig, Unterzweig 

oder zur nächsten Anmerkung.  

Mit diesem Verfahren bewegen Sie sich der Reihe nach zu jedem 

Zweig in der Map. Freie Anmerkungen und Anmerkungen, die an 

Verbindungspfeile angehängt sind, werden übersprungen. 

Pfeiltasten Damit springen Sie zum Zweig über, unter, links oder rechts 

neben dem aktuellen Zweig.  

Bei Verwendung des Links- bzw. Rechtspfeils springen Sie vom 

Hauptthema zunächst zum obersten Hauptzweig. 

So navigieren Sie mit Hilfe von Gesten:R G E B N I S  

Ziehen mit zwei Fingern Sie scrollen die Map. 

Wischen (drei Finger) Sie scrollen die Map seitenweise. 

Pinch oder Expand Sie zoomen die Anzeige größer oder kleiner. 

Bei großen Maps ist es u. U. ratsam, Zweige zu reduzieren bzw. zu erweitern, um sich besser in der 

Map bewegen zu können. 

Weitere Tastenkombinationen dazu finden Sie unter Tastaturkürzel. 

NAVIGIEREN IN DER GLIEDERUNGSANSICHT 

 Zur Anzeige Ihrer Map-Zweige in der Gliederungsansicht wählen Sie Darstellung > 

Gliederungsansicht. 



Einführung in MindManager 

19 

Das Navigieren in der Gliederungsansicht ist mit der Maus und den Bildlaufleisten ein Kinderspiel. 

Alternativ können Sie sich auch mit der Tastatur durch die Gliederung bewegen. In der 

Gliederungsansicht sind freie Anmerkungen am Ende der Zweigliste aufgeführt. 

So navigieren Sie mit der Tastatur: 

G E D R Ü C K T E  T A S T E N  

Pfeil nach oben, Pfeil nach unten Zum nächsten oder vorherigen sichtbaren Zweig bewegen 

Pfeil nach rechts, Pfeil nach links Zweige erweitern und reduzieren 

Wahl-Pfeil nach oben Zum ersten Zweig bewegen 

Wahl-Pfeil nach unten Zum letzten Zweig bewegen 

Wenn Ihre Gliederung viele Zweige enthält, können Sie die Map filtern und so steuern, welche 

Zweige sichtbar sind. 

 

VERWENDEN VON LESEZEICHEN 

Sie können Ihrer Map in der Mapansicht Lesezeichen hinzufügen und damit Zweige zum Navigieren 

markieren. Dann können Sie durch Ihre Maps navigieren, indem Sie zwischen Zweigen mit 

Lesezeichen hin- und herwechseln und dabei andere Zweige überspringen. Dies ist besonders 

während einer Präsentation hilfreich, wenn Sie sich nur auf eine bestimmte Gruppe von Zweigen 

konzentrieren möchten. 

So markieren Sie Zweige mit Lesezeichen: 

1. Markieren Sie den Zweig bzw. die Zweige in der Mapansicht. 

2. Wählen Sie Bearbeiten > Lesezeichen > Lesezeichen hinzufügen oder drücken Sie Befehl-D. 

Am Zweig bzw. den Zweigen erscheint ein Lesezeichen-Symbol . 

So navigieren Sie von Lesezeichen zu Lesezeichen durch eine Map: 

 Um zum nächsten Lesezeichen zu springen, drücken Sie Wahl-Befehl-B. 

 Um zum vorherigen Lesezeichen zu springen, drücken Sie Wahl-Shift-Befehl-B. 

So entfernen Sie Lesezeichen: 

 Für ein Lesezeichen wählen Sie Bearbeiten > Lesezeichen > Lesezeichen entfernen oder drücken 

Sie Befehl-D. 

 Für alle Lesezeichen wählen Sie Bearbeiten > Lesezeichen > Alle Lesezeichen entfernen. 
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Wenn die Lesezeichensymbole bei einer Präsentation oder in Ihren ausgedruckten bzw. exportierten 

Maps nicht angezeigt werden sollen, können Sie sie mit Darstellung > Einblenden & Ausblenden 

auch ausblenden. 

 

AUSWÄHLEN VON ZWEIGEN UND ELEMENTEN 

Zum Bearbeiten oder Formatieren eines Zweigs oder Map-Elements wählen Sie dieses zunächst aus. 

Sie können Zweige und Elemente in der Map- oder Gliederungsansicht einzeln mit der Maus oder 

über Menübefehle auswählen. Zudem können Sie in der Mapansicht ein Rechteck zur 

Mehrfachauswahl um alle Zweige in einem Bereich ziehen. Wenn Sie nur die Zweige auswählen 

wollen, die bestimmten Kriterien entsprechen, können Sie eine gespeicherte Regel verwenden. 

So markieren Sie in der Map- oder Gliederungsansicht Zweige oder Elemente: 

 Zum Auswählen eines einzelnen Zweigs oder Elements klicken Sie in den Zweig bzw. in das 

Element. 

 Zum Auswählen zusätzlicher Zweige oder Elemente klicken Sie bei gedrückter Befehls- oder Shift-

Taste in sie. 

 Zum Aufheben der Auswahl für einen Zweig der Gruppe klicken Sie bei gedrückter Befehlstaste 

in ihn. 

 Wenn Sie die Markierung aller Zweige mit Ausnahme eines Zweigs aufheben möchten, klicken 

Sie bei gedrückter Shift-Taste in den gewünschten Zweig. 

 Um alle Zweige auf derselben Ebene wie der gerade ausgewählte Zweig auszuwählen, wählen 

Sie Auswählen > Nebenzweige. 

 Um alle Zweige auf der Ebene unter dem gerade ausgewählten Zweig auszuwählen, wählen Sie 

Auswählen > Unterzweige. 

 Um alle Zweige auszuwählen, die gerade nicht ausgewählt sind, und umgekehrt, wählen Sie 

Auswählen > Auswahl umkehren. 

 Zum Aufheben der Auswahl für alle Zweige oder Elemente wählen Sie Auswählen > Ohne. 

Ausgewählte Zweige und Elemente werden durch optische Anhaltspunkte angezeigt: 

                     
Beispiele für einen ausgewählten Zweig, eine ausgewählte Umrandung und eine ausgewählte 

Verbindung. 
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So wählen Sie in der Mapansicht Zweige innerhalb eines bestimmten Bereichs aus: 

 Klicken Sie und zeichnen Sie ein Rechteck, das alle Zweige berührt, die Sie auswählen möchten. 

 

Auswählen von Zweigen durch Zeichnen des Auswahlrahmens in der Mapansicht. 

Um Zweige zur Gruppe hinzuzufügen oder aus dieser zu entfernen, wählen Sie diese bei gedrückter 

Befehlstaste aus. (Hinweis: Sie können auf diese Weise andere Elemente wie z. B. 

Verbindungszweige und Umrandungen zu der ausgewählten Gruppe hinzufügen.) 

So wählen Sie Zweige unter Verwendung einer gespeicherten Regel: 

1. Klicken Sie in der Symbolleiste in das Symbol Auswählen, oder wählen Sie Auswählen.  

2. Wählen Sie im Menü die zu verwendende gespeicherte Regel. Es werden nur Zweige ausgewählt, 

die der Regel entsprechen. 

3. Wenn Sie eine andere Regel verwenden möchten, wählen Sie Regeln bearbeiten, um eine Regel 

zu erstellen oder zu bearbeiten.  

 

ERSTELLEN ODER BEARBEITEN GESPEICHERTER REGELN 

Wenn Sie in den Einblendmenüs Filter oder Auswählen die Option Regeln bearbeiten wählen, wird 

das Fenster Regeln geöffnet. Hier sind die gespeicherten Regeln aufgelistet. Sie können die 

angezeigten Regeln anwenden, neue Regeln erstellen und vorhandene Regeln bearbeiten oder 

löschen.  

Der schnellste Weg, eine gespeicherte Regel auf ausgewählte oder angezeigte Zweige anzuwenden, 

führt über die Menüs Filter oder Auswählen. Im Fenster Regeln erhalten Sie jedoch zusätzliche 

Informationen und Optionen.  

So rufen Sie das Fenster Regeln auf: 

 Wählen Sie Auswählen > Regeln bearbeiten oder Darstellung > Filter > Regeln bearbeiten. 

 Wählen Sie im Symbolleisten-Einblendmenü Filter oder Auswählen die Option Regeln 

bearbeiten. 

So filtern oder wählen Sie Zweige unter Verwendung einer Regel aus dem Fenster "Regeln": 

1. Zeigen Sie in den Namen der Regel, damit die Symbole Filter und Auswählen angezeigt werden. 
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2. Wenn Sie in das Symbol Auswählen zeigen, sehen Sie, wie viele Zweige von der Regel 

ausgewählt werden. Das schließt auch die durch einen Filter ausgeblendeten Zweige ein. 

3. Klicken Sie auf das Symbol für die durchzuführende Aktion: 

 Filter zeigt nur die Zweige an, die den Filterkriterien genügen. 

 Auswählen zeigt alle Zweige an, die den Filterkriterien genügen. 

T I P P :  Sie können Regeln auch aus dem Einblendmenü Aktion am unteren Rand des Bereichs 

anwenden. Dieses Menü bietet die zusätzliche Filteroption zum Ausblenden von Zweigen, die den 

Regelkriterien genügen. 

So fügen Sie eine neue Regel hinzu: 

1. Klicken Sie in das Symbol + (Hinzufügen) am unteren Rand des Fensters Regeln. 

2. Geben Sie im daraufhin geöffneten Fenster Regel bearbeiten einen Regelnamen ein, definieren 

Sie die Kriterien, und klicken Sie dann in OK. 

Die neue Regel erscheint in der Auswahl der gesicherten Regeln in den Menüs Filter und Auswählen 

sowie im Fenster Regeln. 

So bearbeiten Sie eine Regel: 

1. Wählen Sie eine der folgenden Verfahrensweisen: 

 Doppelklicken Sie in der Liste im Fenster Regeln in den Regelnamen. 

 Wählen Sie den Regelnamen in der Liste, klicken Sie in das Symbol des Menüs Aktion, und 

klicken Sie im Menü Aktion auf Bearbeiten. 

 Wenn Sie eine Kopie der Regel bearbeiten möchten, um eine neue Regel zu erstellen, klicken 

Sie in Duplizieren. Dann wählen Sie die Kopie der Regel und gehen wie oben beschrieben 

vor. 

2. Bearbeiten Sie im daraufhin geöffneten Fenster Regel bearbeiten den Regelnamen und die 

Kriterien, und klicken Sie dann in OK. 

So löschen Sie eine bestehende Regel: 

 Wählen Sie einen Regelnamen, und klicken Sie in das Symbol - (Löschen) am unteren Rand des 

Fensters Regeln. 
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ÖFFNEN VON MAPS 

ÖFFNEN VON MAPS UND ANDEREN DOKUMENTEN 

Für das Öffnen von MindManager-Maps und anderen Dokumenten gibt es mehrere Möglichkeiten. 

Map-Dateien  haben die Dateierweiterung .mmap und enthalten Maps, die mit MindManager 

Mac oder auf dem PC mit MindManager X5 oder höher erstellt wurden. 

So öffnen Sie beim Starten von MindManager eine Map: 

1. Klicken Sie in der Map-Galerie in Bestehende Map öffnen. 

2. Wählen Sie die Map, und klicken Sie dann in Öffnen. 

Bei jedem Start von MindManager wird standardmäßig die Map-Galerie angezeigt. In den 

MindManager-Einstellungen können Sie aber festlegen, dass beim Start von MindManager immer 

eine spezielle Map oder Vorlage geöffnet wird. 

So öffnen Sie beim Arbeiten in MindManager eine Map: 

1. Wählen Sie Ablage > Öffnen. 

2. Wählen Sie die Map, und klicken Sie dann in Öffnen. 

So öffnen Sie eine kürzlich verwendete Map: 

1. Wählen Sie Ablage > Benutzte Dokumente. 

2. Wählen Sie die gewünschte Map im Untermenü. 

Eine kürzlich verwendete Map können Sie auch über die Map-Galerie öffnen.  

So öffnen Sie eine Map über den Finder: 

 Doppelklicken Sie in das Map-Icon oder ziehen Sie es auf das MindManager-Icon im Dock. 

Andere Dokumente, die Sie öffnen können: 

 MindManager-Map-Vorlagen (.mmat). Siehe Erstellen einer benutzerdefinierten Map-

Vorlage. 

 MindManager-Stile (.mmas). Siehe Erstellen eines benutzerdefinierten Stils. 

 MindManager-Map Parts (.mmmp). Siehe Erstellen eines benutzerdefinierten Map Parts. 

 Maps im xml-Format (.xmmap). Siehe Tipps zur plattformübergreifenden Verwendung. 

 OPML-Dokumente (.opml) werden als Maps geöffnet. 

Zudem können Sie andere Dateitypen importieren, um Maps zu erzeugen.  
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DURCHSUCHEN VON MAPS MIT SPOTLIGHT 

Mithilfe der Spotlight-Funktion von Mac OS X können Sie auf Ihrem Computer befindliche Maps und 

Map-Vorlagen durchsuchen. Wenn Sie eine Map bzw. Vorlage sichern, wird diese automatisch für die 

Suche mit Spotlight indiziert. Spotlight findet in folgenden Teilen Ihrer Map gesuchten Text:  

 Zweigtext 

 Notizentext  

 Kategorien- und Ressourcen-Aufgabeninformationen 

 Hyperlinks in Zweigen und im Notizentext 

 Tags 

 Autorenangaben 

So durchsuchen Sie eine Map mit Spotlight: 

 Klicken Sie in das Symbol für die Spotlight-Suche und geben Sie den gesuchten Text in das 

Suchfeld ein. 

Bei Anzeige der Suchergebnisse werden MindManager-Maps und -Vorlagen unter den Dokumenten 

aufgelistet. Wenn Sie in den Dateinamen klicken, wird MindManager gestartet und die Map oder 

Vorlage geöffnet. 

H I N W E I S :  Der Suchtext kann möglicherweise in einigen gefundenen Dokumenten nicht angezeigt 

werden, wenn er sich in einer Hyperlink-Adresse oder den Autorenangaben befindet. 

Zum Suchen und Ersetzen von Text in der aktuellen Map können Sie auch die Befehle in 

MindManager verwenden.  
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ARBEITEN MIT MINDMANAGER-WERKZEUGEN 

VERWENDEN DES SCHNELLEINGABEMODUS 

Im Schnelleingabemodus können Sie die bei einer Brainstorming-Sitzung auftauchenden Ideen 

erfassen, ohne sich Gedanken darüber machen zu müssen, wie Ihre Map später strukturiert sein 

wird. Geben Sie einfach spontan Ihre Ideen ein, und ziehen Sie sie dann in die Map, um Struktur in 

sie zu bringen. 

So verwenden Sie den Schnelleingabemodus: 

1. Klicken Sie in der Symbolleiste in Schnelleingabe, oder wählen Sie Fenster > 

Schnelleingabefenster einblenden.  

2. Das Schnelleingabefenster wird geöffnet. 

3. Geben Sie in das obere Eingabefeld Ihre erste Idee ein, und drücken Sie dann Enter oder klicken 

Sie in Hinzufügen. 

4. Geben Sie weitere Ideen ein, so wie sie Ihnen kommen.  

5. Im unteren Bereich sehen Sie die Liste mit den von Ihnen eingegebenen Punkten. 

 Wenn Sie einen Punkt aus der Liste entfernen möchten, markieren Sie ihn. Dann klicken Sie 

in das Minuszeichen (-) in der linken unteren Fensterecke. 

 Wenn Sie die Eingabe von Ideen abgeschlossen haben, können Sie sie aus der Liste in eine 

offene Map ziehen, um eine logische Struktur anzulegen. 

 Schließen Sie das Schnelleingabefenster mit dem Schließen-Symbol, oder wählen Sie Fenster 

> Schnelleingabefenster ausblenden. 

 

VERWENDEN DER FORMATLEISTE 

Die Formatleiste befindet sich unter der Symbolleiste. Mit ihr können Sie das Aussehen von Zweigen 

und anderen Map-Elementen ändern sowie Elemente zu Ihrer Map hinzufügen.  

Welche Symbole und Optionen in der Formatleiste verfügbar sind, hängt davon ab, welchen 

Elementtyp Sie in der Map wählen. Zeigen Sie auf ein Steuerelement, um eine Beschreibung 

anzuzeigen. 

So blenden Sie die Formatleiste ein bzw. aus: 

 Wählen Sie Darstellung > Formatleiste einblenden oder Darstellung > Formatleiste ausblenden. 

T I P P :  Die Formatleiste enthält einen Teil der Befehle und Optionen, die Sie in den Informationen 

finden. 
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VERWENDEN DER INFORMATIONEN 

Die Informationen verwenden Sie für das Formatieren von Map-Zweigen und -Elementen sowie das 

Hinzufügen und Verwalten von Markierungen, Aufgabeninformationen, Hyperlinks und Anhängen. 

Das Fenster Informationen hat fünf Bereiche, auf die Sie durch Klicken in die Register am oberen 

Fensterrand zugreifen können. 

 Informationen zu Markierungen zum Kodieren von Zweigen mit Icons und Tags 

 Informationen zu Aufgaben zum Hinzufügen von Aufgabeninformationen 

 Informationen zu Hyperlinks und Anhängen zum Hinzufügen von Links und Anhängen von 

Dokumenten 

 Informationen zu Zweigen mit Optionen zum Formatieren von Zweigen und anderen Map-

Elementen und zum Ändern des Map-Layouts 

 Informationen zu Umrandungen / Verbindungen zum Formatieren von Umrandungen und 

Verbindungen 

Zum einfachen Zugriff auf die am häufigsten verwendeten Optionen können Sie mehrere Fenster 

Informationen öffnen. Beispielsweise können Sie in einem Fenster die Informationen zu Zweigen 

und in einem anderen die Informationen zu Hyperlinks und Anhängen öffnen.  

So blenden Sie die Informationen ein bzw. aus: 

 Klicken Sie in der Symbolleiste in das Symbol Informationen oder wählen Sie Fenster > 

Informationen einblenden. 

 Klicken Sie auf ein Symbol am oberen Rand des Fensters, um andere Informationen 

einzublenden. Zeigen Sie auf die Symbole, um den Namen der Informationen anzuzeigen. 

 Zum Öffnen eines anderen Fensters Informationen wählen Sie Fenster > Neue Informationen. 

Welche Optionen im Fenster Informationen zur Verfügung stehen, hängt davon ab, welche Kategorie 

von Map-Elementen Sie ausgewählt haben. Die von Ihnen gewählten Einstellungen werden auf die 

gegenwärtig ausgewählten Map-Elemente oder Zweige angewandt. Hinweis: Sie können mehrere 

Zweige und Elemente auswählen und ihnen dann als Gruppe die Einstellungen zuweisen. 

 

VERWENDEN DER BIBLIOTHEK 

Die Bibliothek enthält verschiedene Elemente, die Sie per Drag&Drop in Ihre Map ziehen können: 

Bilder, Map Parts und Hintergründe. Im Bibliotheksfenster gibt es für jede dieser Kategorien einen 

bestimmten Bereich, der angezeigt wird, wenn Sie die Kategorie aus der Liste im oberen Bereich 

auswählen. Bilder und Hintergründe werden ihrem Thema entsprechend in Unterkategorien 

eingeteilt. 
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Sie können die Bibliothek individuell anpassen, indem Sie Ihre eigenen Bilder, Hintergründe und Map 

Parts hinzufügen. 

So blenden Sie das Fenster "Bibliothek" ein: 

1. Klicken Sie in der Symbolleiste in das Symbol Bibliothek oder wählen Sie Fenster > Bibliothek 

einblenden. 

2. Wählen Sie die anzuzeigende Kategorie. 

So fügen Sie Bilder und Hintergründe zur Bibliothek hinzu: 

 Kopieren oder verschieben Sie Dateien in den Ordner Library von MindManager: 

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/  

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

 Legen Sie die Dateien in den entsprechenden Unterordnern ab:  

Bilder werden in Unterordnern des Ordners Images im PNG-Format abgelegt.  

Hintergrundbilder werden in Unterordnern des Ordners Background Images im PNG-Format 

abgelegt. 

H I N W E I S :  Sie können eigene benutzerdefinierte Map Parts anlegen und sie direkt in den Library-

Ordnern sichern. 

 

ANPASSEN DER SYMBOLLEISTE 

Die Symbolleiste enthält Symbole, mit denen Sie häufig verwendete Befehle in MindManager 

ausführen können. Sie können die Symbolleiste individuell anpassen, indem Sie Objekte, 

Zwischenräume und Trennlinien hinzufügen oder entfernen. 

So passen Sie die Symbolleiste an: 

1. Wählen Sie Darstellung > Symbolleiste anpassen. 

2. Um der Symbolleiste ein Objekt hinzuzufügen, ziehen Sie es aus dem Fenster in die Symbolleiste. 

Wenn die Symbolleiste beim Hinzufügen von Objekten zu voll wird, wählen Sie Kleine Symbole 

verwenden.  

3. Zum Löschen eines Objekts aus der Symbolleiste ziehen Sie das Objekt aus der Symbolleiste 

heraus. 

4. Klicken Sie in Fertig. 
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Wenn Sie die Symbolleiste nicht verwenden möchten, wählen Sie Darstellung > Symbolleiste 

ausblenden. Sie können sie jederzeit wieder einblenden, indem Sie Darstellung > Symbolleiste 

einblenden wählen. 

Über Tastenkombinationen und die Kontextmenüs, die erscheinen, wenn Sie bei gedrückter 

Befehlstaste auf ein Element klicken, haben Sie Zugriff auf viele weitere MindManager-Befehle. 
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ERSTELLEN UND BEARBEITEN VON MAP-ZWEIGEN 

ERSTELLEN NEUER ZWEIGE 

EINGEBEN EINES HAUPTTHEMAS 

Das Hauptthema enthält den Leitgedanken oder Titel für Ihre Map. Jede neue Map beginnt mit 

einem Platzhalter, in den Sie Ihren eigenen Text eingeben können. 

So geben Sie das Hauptthema ein oder bearbeiten es: 

1. Klicken Sie, um das Hauptthema auszuwählen. 

2. Geben Sie den Text ein, und drücken Sie Return. 

T I P P :  Zum Erzeugen eines mehrzeiligen Zweiges drücken Sie an der Stelle, an der ein Zeilenumbruch 

eingefügt werden soll, Shift-Return. 

Sie können Überarbeitungsinformationen innerhalb des Hauptthemas einfügen, indem Sie Ansicht > 

Einblenden & Ausblenden und anschließend Revisionsnummer & Änderungsdatum wählen.  

 

HINZUFÜGEN VON ZWEIGEN UND UNTERZWEIGEN 

In der Map- und Gliederungsansicht können Sie Zweige (auf gleicher Ebene wie der aktuelle Zweig) 

und Unterzweige (auf einer Ebene tiefer als der aktuelle Zweig) mithilfe der Tastaturkurzbefehle oder 

in der Symbolleiste mit der Taste Einfügen hinzufügen. 

So fügen Sie einen Zweig hinzu: 

1. Drücken Sie die Return-Taste, oder klicken Sie in der Symbolleiste in das Symbol Einfügen und 

wählen Sie aus dem Einblendmenü Zweig aus. 

2. Geben Sie den Zweigtext ein, und drücken Sie die Return-Taste. 

Neue Zweige werden im Uhrzeigersinn nach dem ausgewählten Zweig eingefügt. Zum Hinzufügen 

eines Zweigs in umgekehrter Reihenfolge drücken Sie Shift-Return, oder wählen Sie in der 

Symbolleiste das Symbol Einfügen und dann aus dem Einblendmenü Zweig davor aus. 

So fügen Sie einen Unterzweig ein: 

1. Markieren Sie einen Zweig und drücken Sie Befehl-Return. Wahlweise können Sie auch in der 

Symbolleiste in das Symbol Einfügen klicken und dann aus dem Einblendmenü Unterzweig 

auswählen. 
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2. Geben Sie den Zweigtext ein, und drücken Sie die Return-Taste. 

So fügen Sie einen neuen Oberzweig hinzu: 

1. Markieren Sie einen Zweig und drücken Sie Shift-Befehl-Return, oder klicken Sie in der 

Symbolleiste in das Symbol Einfügen und wählen Sie aus dem Einblendmenü Oberzweig aus. 

2. Geben Sie den Zweigtext ein, und drücken Sie die Return-Taste. 

Weitere Möglichkeiten, Zweige hinzuzufügen: 

Verwenden Sie die Kontextmenüs: 

 Zum Hinzufügen eines Hauptzweigs klicken Sie bei gedrückter Control-Taste in den Map-

Hintergrund (oder in der Gliederungsansicht unter die Zweigliste). Dann wählen Sie Hauptzweig 

einfügen. 

 Zum Hinzufügen eines Oberzweigs, Zweigs oder Unterzweigs klicken Sie bei gedrückter Control-

Taste in den Zweig. Wählen Sie dann die Zweigart aus dem Untermenü Einfügen aus. 

 Zum Hinzufügen von Zweigen im Brainstorming-Stil nutzen Sie den Schnelleingabemodus. 

 

HINZUFÜGEN VON ANMERKUNGEN 

Fügen Sie Anmerkungen zu Zweigen hinzu, um zusätzliche Informationen zu liefern oder an Termine 

zu erinnern.  

So fügen Sie eine Anmerkung hinzu: 

1. Wählen Sie einen Zweig aus; klicken Sie dann in der Symbolleiste in das Symbol Einfügen, und 

wählen Sie Anmerkung einfügen, oder wählen Sie Einfügen > Anmerkung. 

2. Geben Sie den Anmerkungstext ein, und drücken Sie Return. 

Sie können Unterzweige zur Anmerkung hinzufügen, indem Sie sie auswählen und dann Befehl-

Return drücken. 

T I P P :  Wenn Sie einen Zweig ausschneiden oder kopieren, können Sie ihn mit der Option Als 

Anmerkung einfügen als Anmerkung auf einem anderen Zweig einfügen.  

Ferner können Sie Umrandungen und Verbindungen Anmerkungen hinzufügen. Wenn Sie 

Anmerkungen als Erinnerungen zur eigenen Verwendung hinzufügen, können Sie diese ausblenden, 

wenn Sie die Map drucken oder exportieren oder in einer Präsentation anzeigen.  
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HINZUFÜGEN FREIER ANMERKUNGEN 

Freie Anmerkungen sind nicht mit dem Hauptthema verbunden und können frei positioniert werden. 

Sie können freie Anmerkungen für Annotationen wie einen Seitentitel, Fußnoten und mehr 

verwenden. 

So fügen Sie eine freie Anmerkung hinzu: 

1. Klicken Sie im Map-Hintergrund in die Stelle für den neuen Zweig, oder wählen Sie Einfügen > 

Freie Anmerkung. 

2. Geben Sie den Zweigtext ein, und drücken Sie die Return-Taste. 

T I P P S :  

 Sie können auch mit dem Kontextmenü freie Anmerkungen hinzufügen. Klicken Sie dazu bei 

gedrückter Control-Taste in den Map-Hintergrund, und wählen Sie im angezeigten Menü Freie 

Anmerkung einfügen. 

 In der Map-Ansicht können Sie freie Anmerkungen durch Ziehen an eine neue Stelle 

verschieben. Wenn Sie beim Ziehen die Shift-Taste gedrückt halten, verhindern Sie, dass Zweige 

an andere Zweige angehängt werden. 

 Wenn Sie beim Wegziehen des Zweiges vom übergeordneten Zweig die Shift-Taste gedrückt 

halten, wird der Zweig zu einer freien Anmerkung. 

 Sie können freie Bilder (ein Bild innerhalb einer freien Anmerkung) erzeugen, indem Sie das Bild 

aus der Bibliothek in die Map ziehen. 

 Sie können Unterzweige zur freien Anmerkung hinzufügen, indem Sie sie auswählen und dann 

Befehl-Return drücken. 

 Wenn Sie das Hinzufügen freier Anmerkungen mit einem Klick aktivieren möchten, wählen Sie 

MindManager > Einstellungen und dann Eingabe ersetzt Auswahl. 

 In der Gliederungsansicht erscheinen freie Anmerkungen am Ende der Zweigliste. 

 

VERWENDEN DES SCHNELLEINGABEMODUS 

Im Schnelleingabemodus können Sie die bei einer Brainstorming-Sitzung auftauchenden Ideen 

erfassen, ohne sich Gedanken darüber machen zu müssen, wie Ihre Map später strukturiert sein 

wird. Geben Sie einfach spontan Ihre Ideen ein, und ziehen Sie sie dann in die Map, um Struktur in 

sie zu bringen. 

So verwenden Sie den Schnelleingabemodus: 

1. Klicken Sie in der Symbolleiste in Schnelleingabe, oder wählen Sie Fenster > 

Schnelleingabefenster einblenden.  
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Das Schnelleingabefenster wird geöffnet. 

2. Geben Sie in das obere Eingabefeld Ihre erste Idee ein, und drücken Sie dann Enter oder klicken 

Sie in Hinzufügen. 

3. Geben Sie weitere Ideen ein, so wie sie Ihnen kommen.  

4. Im unteren Bereich sehen Sie die Liste mit den von Ihnen eingegebenen Punkten. 

 Wenn Sie einen Punkt aus der Liste entfernen möchten, markieren Sie ihn. Dann klicken Sie 

in das Minuszeichen (-) in der linken unteren Fensterecke. 

 Wenn Sie die Eingabe von Ideen abgeschlossen haben, können Sie sie aus der Liste in eine 

offene Map ziehen, um eine logische Struktur anzulegen. 

 Schließen Sie das Schnelleingabefenster mit dem Schließen-Symbol, oder wählen Sie Fenster 

> Schnelleingabefenster ausblenden. 

 

VERWENDEN DER TIMER-FUNKTION 

Mit Hilfe der Timer-Funktion können Sie bei Meetings, Präsentationen und Brainstorming-Sitzungen 

Ihren Zeitplan einhalten. 

So starten Sie den Timer: 

1. Wählen Sie Fenster > Timer einblenden. 

2. Verwenden Sie das Symbol neben der Zeitanzeige, um eine Zeit aus der Liste auszuwählen, oder 

verwenden Sie die Symbole unter der Zeitanzeige, um die Stunden, Minuten und Sekunden 

einzustellen. 

3. Zum Starten des Timers klicken Sie in Start. 

Sie können den Timer jederzeit anhalten oder neu starten. 

Besonders hilfreich ist der Timer im Schnelleingabemodus für das Brainstorming. 

 

EINFÜGEN VON KALENDER-EREIGNISSEN UND -AUFGABEN 

Sie können neue oder bestehende Kalender-Elemente (Ereignisse oder Aufgaben) als Zweige in Ihre 

Map einfügen. Diese Elemente werden automatisch mit den Elementen in Ihrem Kalender 

abgeglichen. Das heißt: Wenn Sie das Kalender-Element in Ihrer Map ändern, wird es auch im 

Kalender geändert, und umgekehrt. Wenn Sie das Element eingegeben haben, können Sie es in iCal 

anzeigen. 
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So fügen Sie ein Kalender-Ereignis oder eine Kalender-Aufgabe als Zweig ein: 

1. Wählen Sie Einfügen > Kalender-Ereignis bzw. Einfügen > Kalender-Aufgabe. 

2. Wählen Sie den gewünschten Kalender (z. B. "Arbeit" oder "Privat"). Welcher Standardkalender 

hier verwendet wird, wird von der Kalenderoption in den Einstellungen bestimmt. 

3. Wenn das Element nicht aus Ihrem Systemkalender übernommen werden soll, deaktivieren Sie 

die Option An Kalender anhängen. (Sie können das Anhängen später vornehmen, wenn Sie das 

Element bearbeiten.) 

4. Geben Sie die Informationen für das neue Element ein, oder wählen Sie Bestehendes Ereignis 

auswählen bzw. Bestehende Aufgabe auswählen, um ein vorhandenes Element hinzuzufügen. 

T I P P :  Zum Bearbeiten des Kalender-Elements doppelklicken Sie in den Zweig. Dann wählen Sie 

Bearbeiten > Kalenderzweig und ändern die Angaben. Vorgenommene Änderungen werden 

automatisch auf den Systemkalender übertragen, dem das Element angehört. Wenn Sie auf andere 

Kalenderfunktionen zugreifen möchten, können Sie das Element in iCal anzeigen. 

So zeigen Sie ein Kalender-Element in iCal an: 

1. Markieren Sie den Zweig mit dem Kalender-Element.  

2. Wählen Sie Darstellung > Kalender-Element in iCal. 

Änderungen, die Sie in iCal am Element vornehmen, werden auf den entsprechenden Kalenderzweig 

in der Map übertragen. 

Sie können Zweige erzeugen, die vorhandene Kalender-Ereignisse oder -Aufgaben zeigen, die 

bestimmten Kriterien genügen. Weitere Informationen dazu finden Sie unter Einfügen intelligenter 

Kalenderzweige. 

Weiterführende Informationen zu iCal finden Sie in der iCal-Hilfe. 
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BUILD RÜCKGRIFF AUF VORHANDENEN INHALT 

MAP-VORLAGEN 

Teil des Lieferumfangs von MindManager ist eine umfangreiche Auswahl an Map-Vorlagen, die Ihnen 

den Einstieg in das Anlegen einer Map erleichtern.  

Map-Vorlagen enthalten vordefinierten Inhalt plus Standardformatierung für alle Map-Elemente (die 

auch als Stil der Map bezeichnet wird). Map-Vorlagen bieten Ihnen einen einfachen Einstieg in das 

Anlegen häufig verwendeter Maps und sorgen für Einheitlichkeit von Inhalt und Struktur.  

Teil des Lieferumfangs von MindManager ist eine Auswahl an elementaren Map-Vorlagen für häufige 

Aufgaben. Wenn Sie MindManager starten, erscheint standardmäßig die Map-Galerie. Dort können 

Sie eine Vorlage wählen, um eine neue Map zu beginnen. Sie können aber auch jederzeit eine neue 

Map auf Basis einer Vorlage beginnen, indem Sie Ablage > Neu von Vorlage wählen. Ihre Auswahl ist 

nicht auf diese Map-Vorlagen beschränkt: Sie können Sie bearbeiten und so an Ihre Bedürfnisse 

anpassen oder selbst neue Map-Vorlagen anlegen. 

Eine besondere Vorlage mit der Bezeichnung "Leere Map" wird (standardmäßig) verwendet, wenn 

Sie mit Ablage > Neu eine neue Map anlegen. Eine andere Standardvorlage für neue Maps können 

Sie unter MindManager > Einstellungen festlegen.  

T I P P :  Unter MindManager > Einstellungen können Sie festlegen, ob beim Start von MindManager 

die Map-Galerie erscheinen soll. 

 

VERWENDEN VON VORLAGEN ZUM ANLEGEN NEUER MAPS 

Zum Erstellen einer MindManager-Map auf der Basis einer Vorlage wählen Sie zunächst eine Vorlage 

aus der Map-Galerie aus. Die Galerie enthält, geordnet nach Kategorien, eine Vielzahl von Map-

Vorlagen für einige häufig verwendete Maps. Map-Vorlagen haben einen vordefinierten Inhalt und 

vordefinierte Formatierungen (wie bei Briefvorlagen in anderen Anwendungen). Daher müssen Sie 

häufig verwendete Map-Typen nicht jedes Mal neu erstellen. 

Verwenden Sie die Map-Vorlagen als Ausgangspunkt: Sie können die Vorlagen bearbeiten, um 

eigenen Inhalt hinzuzufügen. Außerdem können Sie sie verwenden, um einen Einblick zu bekommen, 

welche Funktionen und Formatierungsmöglichkeiten MindManager bietet. 

Wenn Sie eine Vorlage auswählen, öffnen Sie tatsächlich eine Kopie dieser Vorlage. Die 

Originalvorlage bleibt unverändert. 

Wenn Sie beim Anlegen neuer Maps in der Regel eine bestimmte Map-Vorlage auswählen, können 

Sie festlegen, dass sie als Standardvorlage verwendet wird, wenn Sie eine neue Map anlegen. 
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Außerdem können Sie in den MindManager-Einstellungen festlegen, dass MindManager bei jedem 

Start unter Verwendung dieser Vorlage automatisch eine neue Map beginnen soll. 

So legen Sie eine neue Map auf der Basis einer Vorlage an: 

Wenn beim Start von MindManager die Map-Galerie angezeigt wird, können Sie dort die Vorlage 

wählen. Wenn Sie MindManager gestartet haben, können Sie folgende Schritte verwenden: 

1. Wählen Sie Ablage > Neu aus Vorlage. 

2. Wählen Sie in der Map-Galerie eine Map-Vorlage aus. (Wählen Sie in der linken Spalte eine 

Kategorie, wenn die Vorlagen anhand ihrer Funktion nach Kategorien geordnet sein sollen.) 

3. Wenn Sie eine neue Map ohne jeglichen Inhalt beginnen möchten, wählen Sie die Vorlage "Leere 

Map". 

4. Klicken Sie in Auswählen. 

5. Es wird eine neue Map geöffnet, die auf der gewählten Vorlage basiert. 

6. Bearbeiten Sie die Map und fügen Sie Ihren eigenen Inhalt hinzu. 

7. Sichern Sie die neue Map. 

So ändern Sie die Standardvorlage für neue Maps: 

1. Wählen Sie MindManager > Einstellungen. 

2. Klicken Sie in der Liste Neue Map-Vorlage in Auswählen. 

3. Wählen Sie die Vorlage aus, die jedes Mal geöffnet werden soll, wenn Sie eine neue Map 

erstellen. 

4. Klicken Sie in Auswählen, und dann im Dialog Einstellungen in OK. 

Wenn Sie Ablage > Neu wählen, wird eine neue Map automatisch auf Basis der von Ihnen 

ausgewählten Vorlage angelegt. 

Wenn MindManager bei jedem Start automatisch eine neue Map beginnen soll, wählen Sie in den 

Einstellungen unter Bei Start die Option Neue Map erstellen. Die neue Map basiert auf der 

gewählten Vorlage. 

Wenn Sie mit dem Inhalt der Vorlage zufrieden sind, aber einen anderen Look für die Map wollen, 

können Sie einen anderen Stil anwenden. Sie können auch Ihre eigenen Vorlagen mit angepasstem 

Inhalt und angepasster Formatierung erstellen und sichern.  
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HINZUFÜGEN VON ZWEIGEN UNTER VERWENDUNG VON MAP PARTS 

Mit Hilfe von Map Parts lassen sich auf schnelle und einfache Art häufig verwendete Zweige in Maps 

einfügen. Sie werden in der Bibliothek gespeichert und können zum Anlegen neuer Zweige in die 

Map oder Gliederung gezogen werden. 

So legen Sie unter Verwendung eines Map Parts Zweige an: 

1. Wenn die Bibliothek nicht bereits geöffnet ist, klicken Sie in der Symbolleiste in das Symbol 

Bibliothek, oder wählen Sie Fenster > Bibliothek einblenden. 

2. Wählen Sie in im oberen Popup-Menü der Bibliothek die Option Map Parts. 

3. Ziehen Sie den Map Part aus der Bibliothek in die Map oder Gliederung. Ein 

Visualisierungselement gibt die neue Position für die Zweige an. 

Wenn der Map Part nicht an einen Zweig angehängt werden soll, halten Sie beim Ziehen des Map 

Parts in die Map die Shift-Taste gedrückt. Das verhindert, dass der Part an einen anderen Zweig 

angefügt wird. 

Wenn Sie einen Map Part hinzufügen, den Sie angelegt haben, stimmt seine Formatierung unter 

Umständen nicht mit der übrigen Map überein. Zur Verwendung der Standardformatierung der Map 

wählen Sie in der Mapansicht den neuen Map Part und dann Format > Standardformat verwenden. 

Auf der Basis von Zweigen, die Sie häufig nutzen, können Sie eigene Map Parts anlegen. Wahlweise 

können Sie auch einen vorhandenen Map Part bearbeiten, um ihn an Ihre Bedürfnisse anzupassen. 

 

ANLEGEN VON ZWEIGEN DURCH EINSETZEN VON TEXT 

Sie können neue Zweige anlegen, indem Sie Text in die Map oder Gliederung einfügen. Dieser Text 

kann aus MindManager oder einer anderen Anwendung stammen. 

So legen Sie Zweige durch Einsetzen von Text an: 

1. Wählen Sie den gewünschten Text für die neuen Zweige (aus MindManager oder einer anderen 

Anwendung), und drücken Sie Befehl-C, um ihn zu kopieren. 

2. Wählen Sie in MindManager die gewünschte Einfügestelle für die neuen Zweige.  

 Wenn Sie einen Zweig wählen, wird der eingefügte Text zu seinem Unterzweig. Wenn Sie in 

den Hintergrund der Map klicken, wird der eingefügte Text als neue freie Anmerkung 

eingefügt. 

3. Drücken Sie Befehl-V, um den Text einzusetzen. 

Bei jedem Zeilenumbruch oder neuen Absatz im Ausgangstext beginnt ein neuer Zweig. 
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T I P P :  Wenn der ursprünglich kopierte Text formatiert ist, wird diese Formatierung in den erzeugten 

Zweigen übernommen. Wenn Sie die neuen Zweige auf die Standardformatierung der Map 

zurücksetzen möchten, markieren Sie sie. Dann wählen Sie Format > Standardformat verwenden.  

 

IMPORTIEREN VON DATEIEN 

Sie können eine neue Map anlegen, indem Sie ein Pages- bzw. Word-Dokument oder eine mit 

FreeMind angelegte Map importieren. Wenn Sie die Datei importieren, wird auf der Basis des 

Dateiinhalts eine neue Map erzeugt. 

So importieren Sie Ihr Dokument bzw. Ihre Map: 

1. Wählen Sie Ablage > Importieren. 

 Optional: Wählen Sie in der Aktivierungsliste die gewünschten Dateitypen. 

2. Wählen Sie das zu importierende Dokument. 

3. Klicken Sie auf Importieren. 

4. Der Inhalt der Datei wird importiert, und eine neue Map wird geöffnet. Detaillierte Schritte zum 

Importieren von Dateien finden Sie in diesen Tipps.  

H I N W E I S :  Wenn Sie Ihrer aktuellen Map Inhalt hinzufügen möchten, statt eine neue Map zu 

beginnen, können Sie Text aus einem anderen Dokument kopieren und in die Map einfügen. 

 

TIPPS ZUM IMPORTIEREN VON DATEIEN AUS PAGES, WORD ODER FREEMIND 

Dateien aus Pages, Word und FreeMind werden im Allgemeinen wie erwartet importiert. In den 

folgenden Tipps wird dies etwas eingehender beleuchtet. 

P A G E S - D O K U M E N T E  

Sie können Dateien aus Pages '09 importieren. 

MindManager nutzt die Überschriften im Dokument, um seine Struktur zu definieren. 

W O R D - D O K U M E N T E  

Sie können .doc- und docx-Dateien aus Microsoft Word:Mac 2008 und 2010 und Microsoft Word 

(Windows) 2010 importieren. 

MindManager nutzt die Überschriften im Dokument, um seine Struktur zu definieren. 

F R E E M I N D - M A P S  

Sie können Maps aus FreeMind 0.9.0 importieren. 
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EINFÜGEN INTELLIGENTER KALENDERZWEIGE 

Sie können Zweige erzeugen, die Unterzweige mit vorhandenen Kalender-Elementen (Ereignisse 

oder Aufgaben) zeigen, die bestimmten von Ihnen angegebenen Kriterien genügen. Diese werden als 

intelligente Kalenderzweige bezeichnet. Die den Kriterien genügenden Kalender-Elemente des 

Unterzweigs sind mit Ihrem Systemkalender verknüpft. Änderungen am Kalender werden 

automatisch in Ihre Map übernommen. Intelligente Kalenderzweige werden automatisch aktualisiert, 

wenn Sie die Map öffnen. Daher sehen Sie immer einen aktualisierten Satz übereinstimmender 

Kalender-Elemente. 

So fügen Sie einen intelligenten Kalenderzweig ein: 

1. Wählen Sie Einfügen > Intelligenter Kalenderzweig. 

2. Wählen Sie die Übereinstimmungskriterien, und klicken Sie dann auf OK. 

H I N W E I S : Wenn Sie die Verbindung eines Unterzweigs zum intelligenten Kalenderzweig aufheben, 

indem Sie ihn in einen anderen Teil der Map ziehen, wird er zu einem normalen Kalenderzweig. 

Dieses Element kann in Ihrer Map doppelt auftauchen, wenn der intelligente Kalenderzweig 

aktualisiert wird – einmal als unabhängiger Zweig, den Sie erstellt haben, und zum anderen als ein 

den Kriterien genügendes Kalender-Element für den intelligenten Kalenderzweig. 

So ändern Sie die Kriterien für einen intelligenten Kalenderzweig: 

1. Wählen Sie den intelligenten Kalenderzweig.  

2. Wählen Sie Bearbeiten > Kalender-Zweig. 

Sie können Zweige anlegen, die neue oder vorhandene Kalender-Elemente enthalten, und die 

Elemente entweder mit MindManager oder iCal bearbeiten. Weitere Informationen dazu finden Sie 

unter Einfügen von Kalender-Ereignissen und -Aufgaben. 

Weiterführende Informationen zu iCal finden Sie in der iCal-Hilfe. 
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BEARBEITEN VON MAP-ZWEIGEN 

BEARBEITEN DES ZWEIGTEXTES 

Sie können den Text von Zweigen bearbeiten, wenn Sie den Bearbeitungsmodus starten, oder durch 

Eingabe neuen Textes den gesamten Zweigtext ersetzen. 

So bearbeiten Sie den Text eines Zweigs: 

1. Wählen Sie einen Zweig in der Map- oder Gliederungsansicht. 

2. Klicken Sie erneut in die Mapansicht, um den Bearbeitungsmodus zu starten. 

3. Doppelklicken Sie in die Gliederungsansicht, um den Bearbeitungsmodus zu starten. 

Positionieren Sie dann den Mauszeiger, oder wählen Sie den Text, den Sie ersetzen wollen, und 

geben Sie den neuen Text ein. 

4. In der Mapansicht drücken Sie zum Beenden der Bearbeitung die Return-Taste. 

In der Gliederungsansicht drücken Sie zum Beenden der Bearbeitung die Enter-Taste oder die 

Return-Taste, um im Bearbeitungsmodus zu bleiben und einen Nebenzweig hinzuzufügen. 

T I P P :  Um den gesamten Zweig in der Mapansicht zu ersetzen, wählen Sie einfach den Zweig aus und 

geben neuen Text ein.  

Wenn Sie den bestehenden Text in der Regel um den neuen Eingabetext ergänzen möchten (anstatt 

ihn zu ersetzen), wählen Sie MindManager > Einstellungen. Dort deaktivieren Sie die Option Eingabe 

ersetzt Auswahl. Dadurch wird Ihr neuer Eingabetext immer am Ende des bestehenden Zweigtextes 

angefügt. 

So fügen Sie einem Zweig durch Einsetzen Text hinzu: 

1. Markieren Sie den Text in MindManager oder einer anderen Anwendung und drücken Sie dann 

zum Kopieren Befehl-C. 

2. Markieren Sie den Zielzweig in MindManager. 

3. Klicken Sie erneut in die Mapansicht, um den Bearbeitungsmodus zu starten. 

Doppelklicken Sie in die Gliederungsansicht, um den Bearbeitungsmodus zu starten. 

4. Positionieren Sie den Mauszeiger, oder wählen Sie den Text, der ersetzt werden soll. 

5. Drücken Sie zum Einsetzen des neuen Textes Befehl-V. 

Falls der eingesetzte Text formatiert ist, kann es u. U. passieren, dass die Formatierung nicht mit 

anderem Text in Ihrer Map übereinstimmt. Um die Formatierung der anderen Zweige anzugleichen, 
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wählen Sie in der Mapansicht die Zweige mit dem hinzugefügten Text aus. Dann wählen Sie Format > 

Standardformat verwenden. 

Wenn MindManager bei jedem Start automatisch eine neue Map beginnen soll, wählen Sie in den 

Einstellungen unter Bei Start die Option Neue Map erstellen. Die neue Map basiert auf der 

gewählten Vorlage. 

Sie können Text einsetzen und auf diese Weise neue Zweige anlegen sowie ganze Zweige 

ausschneiden, kopieren und einsetzen, um Ihre Map neu anzuordnen. Wenn Sie ein ganzes 

Dokument aus einer anderen Anwendung verwenden möchten, können Sie es importieren.  

 

SUCHEN UND ERSETZEN VON TEXT 

Sie können jeden in Ihrer Map verwendeten Text (oder jede beliebige Zeichengruppe) leicht finden 

oder ändern. Sie können wählen, ob sich Ihre Suche auf Zweigtext, Notizen, Hyperlinks, Ressourcen, 

Tags und/oder Kommentare beschränken soll. 

So suchen und ersetzen Sie wahlweise Text: 

1. Wählen Sie Bearbeiten > Suchen > Suchen. 

2. Geben Sie den Text, der gesucht werden soll, in das Feld Suchen ein. 

3. Wenn der gesuchte Text ersetzt werden soll, geben Sie den neuen Text in das Feld Ersetzen 

durch ein. 

4. Optional: Wenn Sie festlegen wollen, welche Map-Elemente von MindManager durchsucht 

werden sollen, oder wenn Wörter gesucht und ersetzt werden sollen, die komplexeren Kriterien 

entsprechen, klicken Sie in Optionen und treffen Sie die gewünschte Auswahl. Hinweis: Sie 

können Text in Tags durchsuchen, aber nicht ersetzen. 

5. Klicken Sie in eine der folgenden Tasten, um Text zu suchen oder zu ersetzen: 

 Klicken Sie in Weiter, um im Dokument die nächste Stelle mit dem gesuchten Text zu finden, 

ohne die aktuelle Auswahl ändern zu müssen. 

 Klicken Sie in Ersetzen und Suchen, um die zutreffenden Textstellen im Text zu ersetzen und 

sofort weiter die nächste Textstelle zu suchen. 

 Klicken Sie in Alle Ersetzen, um alle zutreffenden Textstellen im Dokument zu ersetzen. 

MindManager startet die Suche beim aktuellen Zweig und sucht dann in Uhrzeigerrichtung weiter. 

Wenn Sie sich in der Gliederungsansicht befinden und in Bereichen suchen wollen, die nicht 

angezeigt werden, wie z. B. Ressourcen, kann im Suchergebnis u. U. von Ihnen gesuchter Text 

angezeigt werden, der nicht sichtbar ist. Wechseln Sie in die Mapansicht, um alle Zweigelemente und 

die Suchergebnisse anzuzeigen. 
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T I P P S :  

 Zum Suchen von Text, der einem Teil des ausgewählten Textes entspricht, wählen Sie Bearbeiten 

> Suchen > Auswahl für Suche übernehmen, bevor Sie mit Schritt 1 fortfahren. 

 Wenn Sie den zu suchenden Text ausgewählt oder eingegeben haben, können Sie Befehl-G 

drücken oder Bearbeiten > Weitersuchen wählen, um die nächste Instanz des Textes zu suchen. 

Zum Suchen von Maps, die speziellen Text enthalten, können Sie Spotlight verwenden. 

 

RECHTSCHREIBPRÜFUNG 

Mithilfe der standardmäßigen Rechtschreiboption von Mac OS X können Sie die Rechtschreibung von 

Zweigtext und Text innerhalb der Zweignotizen überprüfen. Im Rechtschreibdialog von Mac OS X 

werden umfangreiche Optionen für die Rechtschreibprüfung angeboten: Sie können 

Rechtschreibvorschläge für Wörter anzeigen lassen, dem Wörterbuch Wörter hinzufügen und ein 

anderes Wörterbuch für die Rechtschreibprüfung auswählen. 

So führen Sie die Rechtschreibprüfung in Ihrer Map durch: 

1. Wählen Sie Bearbeiten > Rechtschreibung > Rechtschreibung. Das erste falsch geschriebene 

Wort wird hervorgehoben. 

2. Korrigieren Sie das Wort, und drücken Sie die Befehlstaste und das Semikolon (;), um den 

nächsten Fehler anzuzeigen. Fahren Sie fort, bis alle Schreibfehler beseitigt sind. 

T I P P :  Halten Sie die Control-Taste gedrückt, wenn Sie in ein falsch geschriebenes Wort klicken. Dann 

werden Ihnen alternative Schreibweisen angeboten, und Sie erhalten Zugriff auf weitere Befehle für 

die Rechtschreibung. 

Wenn falsch geschriebene Wörter bei der Eingabe automatisch erkannt werden sollen, wählen Sie 

Bearbeiten > Rechtschreibung > Rechtschreibung während der Eingabe prüfen. 

So verwenden Sie die erweiterten Optionen für die Rechtschreibprüfung: 

1. Wählen Sie Bearbeiten > Rechtschreibung > Rechtschreibung. 

2. Das erste falsch geschriebene Wort wird hervorgehoben. Wählen Sie eine der folgenden 

Verfahrensweisen: 

 Wählen Sie das richtige Wort oder die richtige Schreibweise in der Vorschlagsliste durch 

Doppelklicken aus, um die falsche Schreibweise im Text zu ersetzen. Wenn das richtige Wort 

nicht in der Vorschlagsliste aufgeführt ist, Sie die richtige Schreibweise aber kennen, wählen 

Sie das falsch geschriebene Wort im Fenster Rechtschreibung aus. Anschließend geben Sie 

das richtige Wort ein und klicken in Ersetzen. 
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 Klicken Sie in Ignorieren, wenn die aktuelle Schreibweise richtig ist und Sie sie beibehalten 

möchten. Wenn es sich dabei um einen Begriff oder einen Namen handelt, den Sie häufig 

verwenden, klicken Sie in Lernen, damit das Wörterbuch um diesen Eintrag ergänzt wird. 

 Um ein Wort aus dem Wörterbuch zu entfernen, klicken Sie in Entfernen. 

 Wenn in der Vorschlagsliste keine alternativen Schreibweisen angezeigt werden, wählen Sie 

das falsch geschriebene Wort im Fenster Rechtschreibung aus und versuchen Sie es mit 

einer anderen möglichen Schreibweise. Klicken Sie in Vorschlag, um zu sehen, ob in der 

Vorschlagsliste neue Alternativen angezeigt werden. Wenn Sie sich sicher sind, dass Ihre 

Schreibweise korrekt ist, klicken Sie in Lernen, damit das Wörterbuch um diesen Eintrag 

ergänzt wird. 

3. Klicken Sie in Weitersuchen, und fahren Sie mit den Schritten fort, bis alle Rechtschreibfehler in 

Ihrem Dokument korrigiert sind. 

Wenn falsch geschriebene Wörter bei der Eingabe automatisch erkannt werden sollen, wählen Sie 

Bearbeiten > Rechtschreibung > Rechtschreibung während der Eingabe prüfen. 

T I P P :  Wenn Sie ein richtig geschriebenes Wort in falscher Funktion verwendet haben, wird es nicht 

als Fehler erkannt. Die falschen Wörter können Sie mit der Suchen-/Ersetzen-Funktion ersetzen.  

 

WIDERRUFEN IHRER LETZTEN ÄNDERUNGEN 

Wenn Ihnen die letzten Änderungen in Ihrer Map nicht zusagen, können Sie sie widerrufen. 

So widerrufen Sie Ihre letzten Änderungen: 

 Wählen Sie Bearbeiten > Widerrufen. 

Zum Widerrufen mehrerer Änderungen wählen Sie mehrmals hintereinander Bearbeiten > 

Widerrufen.  

Zum Stornieren des letzten Befehls zum Widerrufen wählen Sie Bearbeiten > Wiederherstellen.  

Wenn keine Tipps für das Widerrufen und Wiederherstellen angezeigt werden sollen, wählen Sie 

MindManager > Einstellungen. Dann deaktivieren Sie unter Visuelle Effekte die Option Tipps zu 

Widerrufen/Wiederherstellen in Map anzeigen.  

Um alle Änderungen, die Sie nach dem letzten Sichern vorgenommen haben, in einem Schritt 

rückgängig zu machen, können Sie die Map auf die letzte Version zurücksetzen. 
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HINZUFÜGEN WEITERER INFORMATIONEN 

HINZUFÜGEN VISUELLER INFORMATIONEN 

MARKIERUNGEN 

Mit Markierungen lassen sich Zweige in Ihrer Map kodieren und klassifizieren. Sie finden sie in den 

Informationen zu Markierungen. 

Markierungen gibt es in drei grundlegenden Arten: Icons, Tags und Farben. 

 Ein Icon ist eine kleine Grafik mit einer zugeordneten Bedeutung: Eine grüne Fahne bedeutet 

beispielsweise "Los". 

 Ein Tag ist eine kurze Anmerkung. Sie dient in der Regel der Klassifizierung von Zweigen: z. B. 

"10-20 Einheiten". 

 Eine Farbmarkierung ist eine Füll- oder Schriftfarbe mit einer zugeordneten Bedeutung: Eine 

rote Schriftfarbe bedeutet beispielsweise "Wichtig". 

Jede Map enthält eine Liste verfügbarer Markierungen, die in den Informationen zu Markierungen in 

Gruppen zusammengefasst sind. Einige Markierungsgruppen sind mit Aufgabeninformationen 

verknüpft. 

Standard-Markierungsgruppen sind in der Markierungsliste für jede Map aufgeführt und können 

nicht gelöscht werden. Sie können diesen Gruppen aber Markierungen hinzufügen bzw. diese aus 

ihnen löschen: 

 Die Markierungen Aufgabenpriorität, Aufgabe fertig und Ressourcen können Zweigen aus 

den Informationen zu Markierungen bzw. Informationen zu Aufgaben zugewiesen werden. 

Neue Ressourcen-Markierungen können Sie in einem der beiden Informationsbereiche 

anlegen oder aus Ihrem Adressbuch importieren. 

 Einzelne Icons sind Icons, denen Bedeutungen zugeordnet sind, die aber keiner Gruppe 

angehören. 

 Füllfarben und Schriftfarben sind Füll- und Schriftfarben für Zweigtext. Wenn Sie Ihrer Map 

Füll- und Schriftfarben zuweisen, werden diesen Gruppen unbenannte Markierungen 

hinzugefügt. Sie können ihnen Namen zuweisen. Nach der Zuweisung des Namens 

verbleiben sie in der Gruppe, unabhängig davon, ob sie in der Map verwendet werden oder 

nicht. (Wird ihnen kein Name zugewiesen, verschwinden sie, wenn sie nicht verwendet 

werden.) 

Benutzerdefinierte Markierungsgruppen können Sie nach Ihren Wünschen und Bedürfnissen anlegen 

und mit Markierungen füllen. Sie können Tag-Gruppen oder Icon-Gruppen anlegen, Icons 
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Bedeutungen zuweisen und festlegen, ob die Markierungen in Gruppen einander ausschließen (dann 

kann jeweils nur eine Markierung pro Gruppe für Zweige verwendet werden) oder nicht. 

T I P P :  Die Verwaltung und Anpassung der Markierungsliste nehmen Sie in den Informationen für 

Markierungen vor. Die Markierungsliste wird mit der Map oder Map-Vorlage gesichert. Jede Map 

kann also über eine eigene Markierungsliste verfügen. 

 

KODIEREN VON ZWEIGEN MIT MARKIERUNGEN 

Mit Markierungen können Sie Zweige kategorisieren oder mit Aufgabeninformationen kodieren. Das 

Hinzufügen von Markierungen zu Zweigen nehmen Sie in der Mapansicht oder der 

Gliederungsansicht über die Informationen zu Markierungen bzw. Aufgaben vor. In der 

Gliederungsansicht werden Tags nicht angezeigt. 

So fügen Sie Zweigen Markierungen hinzu: 

1. Markieren Sie einen oder mehrere Zweige. 

2. Wenn die Informationen nicht bereits geöffnet sind, klicken Sie in der Symbolleiste in das Symbol 

Informationen. Sie können stattdessen auch Fenster > Informationen einblenden wählen. 

3. Klicken Sie in das Register Markierungen der Informationen. 

4. Klicken Sie auf die Markierung, die dem Zweig bzw. den Zweigen hinzugefügt werden soll. Wenn 

die gewünschte Markierung nicht vorhanden ist, können Sie sie einer vorhandenen Gruppen 

hinzufügen oder mit den Funktionen für das Verwalten von Markierungen eine neue Gruppe 

anlegen.  

Es lassen sich mehrere Markierungen an einen Zweig anfügen. Wenn Sie eine Markierung aus einer 

Gruppe angefügt haben, deren Markierungen einander ausschließen, und dann eine andere 

Markierung aus derselben Gruppe wählen, wird die erste Markierung entfernt. Dieses Attribut 

können Sie mit den Popup-Menübefehlen in den Informationen für eine Markierungsgruppe ändern. 

Wenn Sie die Markierung eines Zweiges durch eine andere aus derselben Gruppe ersetzen möchten, 

klicken Sie bei gedrückter Control-Taste in die Markierung und wählen die neue Markierung aus dem 

Popup-Menü. Wahlweise können Sie auch in die Markierung klicken und die Markierungen der 

Gruppe durchlaufen. 

Über die Informationen zu Aufgaben können Sie Zweigen auch Markierungen des Typs 

Aufgabenpriorität und Fortschritt hinzufügen. 

T I P P S :  

 Wenn die Icon-Markierungen in der Mapansicht größer sein sollen, wählen Sie MindManager > 

Einstellungen > Größere Icons und Bilder für Aufgabeninfos anzeigen. 
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 Wenn Sie die Markierungen in der Mapansicht ausblenden wollen (ohne sie zu löschen), wählen 

Sie Ansicht > Einblenden & Ausblenden. Sie können einzeln festlegen, dass Icons, Tags und Tag-

Gruppennamen ausgeblendet werden. 

So entfernen Sie Markierungen von Zweigen: 

1. Klicken Sie bei gedrückter Control-Taste in die Markierung. 

2. Bei Icons: Wählen Sie Entfernen, um das ausgewählte Icon zu entfernen, bzw. Alle Icons 

entfernen, um alle Icons des Zweigs zu entfernen. 

3. Bei Tags: Wählen Sie Alle Tags entfernen, wenn alle Tags des Zweigs entfernt werden sollen. 

H I N W E I S :  Wenn Sie in den Informationen zu Markierungen in eine Markierung klicken, die am 

aktuellen Zweig bereits existiert, wird die Markierung entfernt. 

Die verfügbaren Markierungen und ihre Gruppen werden als Teil der Map (oder Map-Vorlage) 

gesichert. Das Hinzufügen, Entfernen, Umbenennen und Neugruppieren der Markierungen nehmen 

Sie in den Informationen vor.  

 

Verwalten von Markierungen 

In den Informationen zu Markierungen, über Popup-Menüs und Aktionsmenüs können Sie 

Markierungen und Markierungsgruppen hinzufügen, entfernen, ändern und organisieren. Die Popup-

Menüs werden angezeigt, wenn Sie auf den Gruppen- oder Markierungsnamen zeigen. 

Verwalten von Markierungsgruppen 

Aktion 
Klicken Sie in , um das Aktionsmenü zu öffnen. Dann 
können Sie: 

Einer Gruppe eine neue Markierung 
hinzufügen 

Wählen Sie Neue Markierung, wobei "Markierung" der 
Name der Gruppe für Standardgruppen (z. B. "Neue 
Aufgabenpriorität") oder der Typ der Markierung (z. B. 
"Neues Icon") ist. Geben Sie den Namen für die neue 
Markierung ein, und (bei Icon- oder Farbmarkierungen) 
wählen Sie ihr Icon oder ihre Farbe. 

HIN W EIS : Sie können Ressourcen aus Ihrem Adressbuch 

importieren. Siehe dazu Hinzufügen von Ressourcen aus 
Ihrem Adressbuch. 

Eine neue Icon- oder Tag-Gruppe 
hinzufügen 

Wählen Sie Neue Icon-Gruppe oder Neue Tag-Gruppe. 
Geben Sie den Namen der neuen Gruppe ein, und fügen 
Sie der Gruppe dann Markierungen hinzu (nachstehend 
beschrieben). 
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Aktion 
Zeigen Sie auf den Gruppennamen, und klicken Sie in . Dann 
können Sie: 

Eine Gruppe umbenennen Wählen Sie Umbenennen, und geben Sie für die neue Gruppe 
einen Namen ein. 

TIPP : Wenn für Tags keine Gruppennamen angezeigt werden 

sollen, wählen Sie Darstellung > Einblenden & Ausblenden. Dann 
entfernen Sie das Häkchen an der Option Gruppennamen für 
Tags. 

Festlegen, dass die Markierungen 
einer Gruppe einander (nicht) 
ausschließen 

Wählen Sie Ausschließlich bzw. Nicht ausschließlich. Wenn die 
Markierungen einer Gruppe einander ausschließen, können Sie 
pro Zweig nur ein Icon aus dieser Gruppe verwenden. Diese 
Einstellung können Sie für einige Standardgruppen nicht ändern. 

Eine Tag-Gruppe sortieren Wählen Sie Sortieren. 

Eine Gruppe löschen Wählen Sie {Gruppenname} Löschen. Einige Standardgruppen 
lassen sich nicht löschen. Markierungen aus der gelöschten 
Gruppe, die in der Map verwendet werden, verbleiben in der 
Map. In den Informationen zu Markierungen werden sie als 
namenlose Icons in die Gruppe mit allgemeinen Icons verschoben. 

Verwalten einzelner Markierungen 

Aktion 
Zeigen Sie auf den Markierungsnamen, und klicken Sie in . 
Dann können Sie: 

Eine Markierung umbenennen Klicken Sie in Umbenennen. Geben Sie den neuen Namen für die 
Markierung ein. Wenn Sie ein Tag umbenennen, das in der Map 
verwendet wird, wird die Umbennung auf das Tag in der Map 
übertragen. 
Wenn Sie ein allgemeines Icon umbenennen, wird es automatisch 
in die Gruppe mit den einzelnen Icons verschoben. 

Eine Markierung bearbeiten Wählen Sie Bearbeiten. Geben Sie den neuen Namen für die 
Markierung ein und/oder wählen Sie ein neues Icon oder eine 
Farbe. Wenn Sie das Icon einer Icon-Markierung ändern, die in 
der Map verwendet wird, ändern sich die Markierungen in der 
Map nicht. Ihre Icons werden zu einem allgemeinen Icon ohne 
Namen. 

Eine Markierung löschen Wählen Sie Löschen. Wenn Sie ein Icon ändern, das in der Map 
verwendet wird, ändern sich die Markierungen in der Map nicht. 
Ihre Icons werden zu einem allgemeinen Icon ohne Namen. 
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Verwalten aller Markierungen 

Aktion 
Klicken Sie in , um das AktionsmenÜ zu 
Öffnen. Dann können Sie: 

Für diese Map eine Gruppe von Markierungen 
aus einer Datei zuweisen 

Wählen Sie Markierungen aus Datei zuweisen, und 
wählen Sie eine Datei. Dateien mit Markierungen 
haben die Namenserweiterung .mmms. 
Die Markierungen aus der Datei ersetzen die 
aktuellen Markierungen in den Informationen. 

Die Gruppe von Markierungen in dieser Map in 
einer Datei sichern 

Wählen Sie Markierungen in Datei sichern, geben 
Sie dann einen Dateinamen ein, und klicken Sie in 
OK. 

Die verfügbaren Markierungen und ihre Gruppen werden als Teil der Map (oder Map-Vorlage) 

gesichert. 

Hinzufügen von Ressourcen aus Ihrem Adressbuch 

Sie können eine Liste mit Ressourcen zur Verwendung als Aufgabeninformationen in der aktuellen 

Map aus Ihrem Adressbuch importieren. Diese werden in die Gruppe Ressourcen der Informationen 

zu Markierungen sowie die Liste Ressourcen der Informationen zu Aufgaben aufgenommen. Aus 

beiden Informationsbereichen können sie Zweigen zugewiesen werden. Ferner können Sie festlegen, 

dass die Liste mit Ressourcen, die Sie in die Map importieren, als vCards-Datei an das Hauptthema 

angehängt wird.  

So importieren Sie Ressourcen: 

1. Klicken Sie im Bereich Markierungen der Informationen in das Symbol Optionen  neben der 

Gruppe Ressourcen. 

2. Wählen Sie aus dem Adressbuch die Option Neue Ressourcen.  

3. Wählen Sie die als Ressourcen zu importierenden Kontakte. 

4. Wenn Sie die Ressourcenliste dem Hauptthema der Map beifügen möchten, wählen Sie die 

Option Ressourcen an Hauptthema anhängen. 

Die Liste wird als vCards-Datei angehängt. Ein anderer Leser Ihrer Map kann diese Kontakte aus 

der Map in sein eigenes Adressbuch oder einen anderen Kontakt-Manager importieren. 

5. Klicken Sie in Importieren. 

T I P P S :  

 Die neuen Ressourcen werden in der Gruppe Ressourcen der Informationen zu Markierungen 

angezeigt. Von hier aus bzw. aus den Informationen zu Aufgaben können Sie sie Zweigen 

hinzufügen. 
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 Die Namen von Ressourcen werden automatisch für Sie vervollständigt, wenn Sie sie ins Feld 

Ressourcen der Informationen zu Aufgaben eingeben. 

 Wenn Sie die Ressourcen an das Hauptthema angehängt haben, können Sie die Datei wie jeden 

anderen Anhang öffnen und entfernen. 

So lassen Sie Ressourcen für neue Maps automatisch importieren: 

1. Wählen Sie MindManager > Einstellungen. 

2. Wählen Sie im Menü unter Neue Map die Option Ressourcen automatisch importieren aus und 

dann die gewünschte Adressbuchgruppe. 

3. Wenn Sie die Ressourcen an die Map anhängen möchten, wählen Sie die Option Ressourcen an 

Hauptthema anhängen. 

Sie können jederzeit weitere Ressourcen importieren. MindManager legt keine Duplikate von 

vorhandenen Map-Ressourcen an. Wenn Sie die angehängten Ressourcen aktualisieren müssen, 

löschen Sie den .vcf-Anhang am Hauptthema. Dann importieren Sie die Ressourcen erneut. 

 

VERKNÜPFEN VON ZWEIGEN MIT HILFE VON VERBINDUNGEN 

Mit Verbindungspfeilen zeigen Sie Verbindungen zwischen Zweigen an, die aus der Struktur der Map 

nicht hervorgehen. Zwischen den Zweigen, die über eine Verbindung miteinander verknüpft sind, 

können Sie hin- und herspringen (dies ist besonders in großen Maps hilfreich, in denen sich die 

Verbindung über eine große Entfernung erstreckt). Zur Erläuterung der Verbindung können Sie eine 

Anmerkung beifügen. In der Gliederungsansicht werden Verbindungen nicht angezeigt. 

So fügen Sie eine Verbindung hinzu: 

1. Klicken Sie in der Symbolleiste in das Symbol Verbindung, oder wählen Sie Einfügen > 

Verbindung.  

2. Klicken Sie in den ersten und dann in den zweiten Zweig. 

3. Zum Hinzufügen einer Anmerkung zur Verbindung klicken Sie bei gedrückter Control-Taste in die 

Linie. Dann wählen Sie Anmerkung einfügen.  

4. Wenn zu jeder neuen Verbindung automatisch eine Anmerkungsbeschriftung hinzugefügt 

werden soll, wählen Sie MindManager > Einstellungen und dort Anmerkungen zu neuen 

Verbindungen hinzufügen. 

So springen Sie zu einem durch die Verbindung verknüpften Zweig: 

1. Klicken Sie bei gedrückter Control-Taste in den Verbindungspfeil. 

2. Wählen Sie im Kontextmenü Springen zu {Zweigname}. Für die Zweige an beiden Enden der 

Verbindung wird jeweils ein Springen-zu-Befehl angezeigt.  
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Das ursprüngliche Format der Verbindung (Linienstil, -farbe und -enden) wird vom Gesamtstil der 

Map bestimmt.  

 

GRUPPIEREN VON ZWEIGEN MIT HILFE VON UMRANDUNGEN 

Fügen Sie eine Umrandung ein, um Unterzweige einzurahmen und zu gruppieren, bzw. eine 

zusammenfassende Umrandung und eine Anmerkung, um sie zusammenzufassen. Sie können einen 

Anmerkungszweig einfügen, um die Gruppe zu erläutern oder zusammenzufassen, und 

Umrandungen auf andere Gruppen verschieben oder kopieren. 

So fügen Sie eine Umrandung hinzu: 

1. Markieren Sie den Zweig, dessen Unterzweige Sie gruppieren oder zusammenfassen möchten. 

2. Klicken Sie in der Symbolleiste in das Symbol Umrandung, und wählen Sie den Typ Umrandung 

aus, die Sie anzeigen wollen. Wahlweise können Sie auch Einfügen > Umrandung wählen. 

Um den Umrandungstyp zu ändern, klicken Sie in der Symbolleiste in das Symbol Umrandung 

und wählen einen anderen Typ. 

3. Zum Hinzufügen einer Anmerkung klicken Sie bei gedrückter Control-Taste in die Umrandung 

und wählen dann Anmerkung einfügen.  

Wenn zu neuen zusammenfassenden Umrandung 

en automatisch eine Anmerkungsbeschriftung hinzugefügt werden soll, wählen Sie 

MindManager > Einstellungen und dort Anmerkungen zu neuen Verbindungen hinzufügen. 

T I P P :  Innerhalb von Umrandungen lassen sich weitere Umrandungen anlegen. 

So kopieren bzw. verschieben Sie eine Umrandung zu einer anderen Gruppe von Unterzweigen: 

1. Markieren Sie die Umrandung (ein blauer Rahmen gibt an, wenn sie markiert ist). 

2. Drücken Sie Befehl-C, um die Umrandung zu kopieren, oder Befehl-X, um sie auszuschneiden. 

3. Markieren Sie den Oberzweig der Ziel-Unterzweige.  

4. Drücken Sie Befehl-V, um die Umrandung einzufügen.  

T I P P :  Um eine Umrandung zu entfernen, wählen Sie die Umrandung aus und drücken dann Löschen. 

Das ursprüngliche Format der Umrandung (Linienstil, -farbe und -füllfarbe) wird vom Gesamt-Map-

Stil bestimmt. Wenn Sie eine Umrandung hinzugefügt haben, können Sie ihr Format ändern und 

wahlweise einen Zusammenfassungszweig hinzufügen.  
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HINZUFÜGEN VON BILDERN 

Sie können in Ihre Maps Bilder aus der MindManager-Bibliothek sowie aus Dateien außerhalb von 

MindManager einfügen. Bilder lassen sich innerhalb von Zweigen, als freie Bilder, die sich frei 

positionieren lassen, und innerhalb von Zweignotizen einfügen. In der Gliederungsansicht werden 

Bilder nicht angezeigt.  

So fügen Sie ein Bild aus der Bibliothek ein: 

1. Wenn die Bibliothek nicht bereits geöffnet ist, klicken Sie in der Symbolleiste in das Symbol 

Bibliothek, oder wählen Sie Fenster > Bibliothek einblenden. 

2. Wählen Sie im oberen Popup-Menü der Bibliothek die Option Bilder. 

3. Wählen Sie in der Liste eine Bildkategorie, oder geben Sie in das Suchfeld am unteren 

Fensterrand ein Schlüsselwort ein. 

4. Ziehen Sie das Bild aus dem Fenster der Bibliothek in die Map oder Zweignotizen. In der Map 

gibt ein Visualisierungselement die neue Stelle für das Bild innerhalb eines Zweiges oder als 

neuen Zweig bzw. freies Bild an. 

T I P P :  Wenn ein freies Bild entstehen soll, halten Sie beim Ziehen des Bildes in die Map die Shift-

Taste gedrückt. Das verhindert, dass das Bild an einen Zweig angefügt wird. Freie Bilder werden als 

Bild innerhalb einer Anmerkung (freier Zweig) eingefügt. 

So fügen Sie ein Bild aus einer Datei ein: 

1. Klicken Sie bei gedrückter Control-Taste in einen Zweig (um das Bild an den Zweig anzuhängen) 

oder in den Map-Hintergrund (um ein freies Bild zu erzeugen). 

2. Wenn ein neuer Zweig erzeugt werden soll, wählen Sie Bild einfügen > Aus Ablage.  

Wenn ein freies Bild erzeugt werden soll, wählen Sie Freies Bild einfügen > Aus Ablage. Dann 

klicken Sie in die Stelle, an der das Bild eingefügt werden soll. 

3. Navigieren Sie zum gewünschten Bild, und klicken Sie in Öffnen. Als Bildformate werden BMP, 

EXR, GIF, JPEG, PSD, PICT, PNG, SGI, TGA und TIFF unterstützt.  

Wenn Sie ein großes Bild öffnen, kann dessen Größe bei Einfügen in die Map reduziert werden. 

Nach dem Einfügen können Sie seine Größe verändern. 

T I P P :  Wenn Sie ein Bild aus einer Datei in die Notizen einfügen möchten, ziehen Sie es aus dem 

Finder in das Notizenfenster. In den Notizen kann die Größe von Bildern nicht verändert werden. 

Daher müssen Sie sie vor dem Einfügen auf die richtige Größe bringen. 

Tipps zur Verwendung von Bildern 

 Pro Zweig können Sie nur ein Bild einfügen. 
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 Zum Auswählen eines Bildes klicken Sie zunächst in den Zweig, auf dem es sich befindet. Dann 

klicken Sie erneut, um das Bild auszuwählen. 

 Sie können ein Bild verschieben, indem Sie es auswählen und dann an eine neue Stelle ziehen. 

 Mehr Optionen zur Ausrichtung von Bildern (für Bilder in Zweigen) finden Sie im Bereich 

Abstände der Informationen zu Zweigen. 

 Wenn Sie die Größe eines Bildes ändern möchten, wählen Sie es zunächst aus. Dann verschieben 

Sie die Ziehpunkte. 

 Wenn Sie ein Bild löschen möchten, markieren Sie es zunächst. Dann drücken Sie die Löschen-

Taste. 

 Den Bildabstand innerhalb von Zweigen legen Sie mit den Optionen des Registers Abstände der 

Informationen zu Zweigen fest. Wenn Sie die für die Abstandsbestimmung verwendeten 

Einheiten ändern möchten, wählen Sie MindManager > Einstellungen. Dort wählen Sie die 

gewünschten Maßeinheiten. 

Bei Maps, die Sie als Bilder exportieren (einschließlich PDF-Dokumente), werden die Bilder 

mitexportiert, bei in reinem Textformat exportierten Maps nicht. Beim Export nach RTF werden nur 

Bilder in Notizen exportiert. In anderen Formaten können Sie festlegen, ob Bilder exportiert werden 

sollen. 

Wenn Sie Bilder haben, die Sie häufig in Maps verwenden, können Sie diese in die Bibliothek 

aufnehmen.  
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HINZUFÜGEN WEITERFÜHRENDER INFORMATIONEN 

ANHÄNGEN VON DOKUMENTEN AN ZWEIGE 

Sie können externe Dokumente an Zweige anhängen und so zu einem Bestandteil der Map machen. 

Nach dem Hinzufügen werden die Anhänge in der Map-Datei gespeichert und sind nicht mehr mit 

der ursprünglichen Datei verknüpft. Zur Anzeige und Bearbeitung können Sie über Hyperlink und 

Anhänge geöffnet werden. Bei der Bearbeitung wird nur der in der Map-Datei gespeicherte Anhang 

verändert: Das ursprüngliche Dokument bleibt unverändert. 

Anhänge unterscheiden sich dahingehend von Hyperlinks, dass der Inhalt des Dokuments Bestandteil 

der Map wird und beim Verschieben oder Versenden der Map immer einbezogen wird. Anhänge 

können den Umfang der Map-Datei jedoch beträchtlich erhöhen. 

So hängen Sie ein Dokument an einen Zweig an: 

1. Markieren Sie in der Map- oder Gliederungsansicht einen Zweig. 

2. Klicken Sie in der Symbolleiste in das Symbol Datei anhängen, oder wählen Sie Einfügen > 

Anhang. 

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Anhang für die Auswahl existiert, wird dies hier angezeigt. Klicken Sie 

in das Symbol Hinzufügen (+). 

3. Navigieren Sie zur gewünschten Datei, und klicken Sie in Öffnen. 

Elemente, die nicht anhängbar sind, werden abgeblendet. Dazu gehören Ordner, Dokumente, die 

Bundles sind, sowie Dateien, die Ressourcenzweige verwenden (in der Regel aus älteren 

Anwendungen). 

Anhänge werden am Zweig mit dem Anhangs-Icon  angezeigt. Wenn Sie auf dieses Icon klicken, 

werden die Informationen zu Hyperlinks und Anhängen angezeigt. An einen Zweig können Sie 

mehrere Anhänge anhängen. Diese werden dann in der Reihenfolge angezeigt, in der sie angehängt 

wurden. 

Über Ansicht > Einblenden & Ausblenden können Sie alle Anhangs-Icons in Ihrer Map für die Anzeige 

oder das Ausdrucken ausblenden. 

So öffnen Sie einen Anhang zur Anzeige oder Bearbeitung: 

 Wählen Sie den gewünschten Anhang in der Liste der Informationen zu Hyperlinks und 

Anhängen, und klicken Sie dann in Öffnen. 

H I N W E I S : Änderungen, die Sie am Dokument vornehmen, werden nur in der Map gespeichert. Die 

ursprüngliche Datei bleibt unverändert. 
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So speichern Sie einen Anhang in einer externen Datei: 

Wählen Sie den gewünschten Anhang in der Liste der Informationen zu Hyperlinks und Anhängen, 

und klicken Sie dann in Sichern unter. 

So entfernen Sie einen Anhang: 

 Wählen Sie den gewünschten Anhang in der Liste der Informationen zu Hyperlinks und 

Anhängen, und klicken Sie dann in Entfernen (-). 

H I N W E I S : Wenn Sie den Anhang entfernen, gehen alle vorgenommenen Änderungen verloren, 

sofern Sie ihn nicht in einer externen Datei gesichert haben. 

 

HINZUFÜGEN VON AUFGABENINFORMATIONEN 

Das Hinzufügen von Aufgabeninformationen zu Zweigen nehmen Sie mit den Informationen zu 

Aufgaben bzw. Markierungen vor. Aufgabeninformationen (mit Ausnahme Prioritäts- und 

Fortschritts-Icons) werden in der Gliederungsansicht nicht angezeigt. 

So fügen Sie einem Zweig Aufgabeninformationen hinzu: 

1. Markieren Sie den Zweig. 

2. Wenn die Informationen nicht bereits geöffnet sind, klicken Sie in der Symbolleiste in das Symbol 

Informationen. Wahlweise wählen Sie Fenster > Informationen einblenden. 

3. Klicken Sie in das Register Informationen zu Aufgaben. 

4. Definieren Sie dort die Aufgabeninformationen für den ausgewählten Zweig. Sie können beliebig 

viele der Eigenschaften definieren. 

Für die Angaben Priorität und Fortschritt wird dem Zweig das entsprechende Icon hinzugefügt. Die 

übrigen Aufgabeninformationen werden in einem kleinen Fenster unter dem Zweigtext angezeigt. 

T I P P S :  

 Zum Ausblenden der Fenster mit Aufgabeninformationen in Ihrer Map wählen Sie Darstellung > 

Einblenden & Ausblenden. Dann deaktivieren Sie die Option Aufgabeninfo. Zum Ausblenden der 

Icons deaktivieren Sie Icons. 

 Über die Informationen zu Markierungen können Sie Zweigen auch direkt Markierungen des 

Typs Priorität, Fortschritt und Ressourcen hinzufügen. 

 Wenn die Grafiken für die Aufgabeninfos größer sein sollen, wählen Sie MindManager > 

Einstellungen > Größere Icons und Bilder für Aufgabeninfos anzeigen. Diese Einstellung betrifft 

auch die Icons. 
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So ändern oder entfernen Sie eine Textmarkierung an einem Zweig: 

1. Klicken Sie bei gedrückter Control-Taste in das Fenster mit den Aufgabeninfos des Zweigs. 

2. Wählen Sie Aufgabeninfo ändern, um die Informationen zu ändern. Die Informationen zu 

Aufgaben werden geöffnet. Dort können Sie die Aufgabeninfo ändern. 

Wählen Sie Aufgabeninfo löschen, um die Informationen zu löschen.  

H I N W E I S :  Prioritäts- und Fortschritts-Icons werden nicht mit den Aufgabeninfos entfernt. Dazu 

klicken Sie bei gedrückter Control-Taste in das Icon und wählen dann Entfernen bzw. Alle Icons 

entfernen. 

 

EINBINDEN VON ZWEIGNOTIZEN 

Mithilfe von Zweignotizen können Sie einem Zweig Details hinzufügen. Dadurch wird verhindert, 

dass die Map mit großen Mengen von Informationen überfrachtet wird. Zweignotizen können 

formatiert werden, um formatierten Text, Hyperlinks, Beschriftungen und Bilder einzubinden. Sie 

können Zweignotizen im Notizenfenster eingeben und mithilfe seiner Symbolleiste Formatierungen 

vornehmen und Tabellen einfügen. Sie können die Zweignotizen für einen oder mehrere Zweige 

ausdrucken. 

So fügen Sie einem Zweig Notizen hinzu: 

1. Wählen Sie den Zweig in der Map- oder Gliederungsansicht aus. 

Notizen können Sie Zweigen, freien Anmerkungen und Anmerkungen hinzufügen. 

2. Klicken Sie in der Notizen-Symbolleiste in das Symbol Notizen, oder wählen Sie Darstellung > 

Notizen einblenden. 

T I P P : Sie können das Notizenfenster auf der rechten Seit oder am unteren Rand des Map-

Fensters positionieren. Klicken Sie in Darstellung > Notizen positionieren. 

3. Geben Sie Text in das Notizenfenster ein. Hinweis: Sie können auch Text von anderen 

Programmen in dieses Fenster kopieren. Falls dieser Text formatiert ist, wird die Formatierung 

dabei übertragen. 

4. Sie können Bilder überall im Notizenfenster einbinden, indem Sie sie einfach aus der Bibliothek, 

dem Finder oder aus anderen Programmen in das Notizenfenster ziehen.  

 In den Notizen kann die Größe von Bildern nicht verändert werden. Daher müssen Sie sie vor 

dem Einfügen auf die richtige Größe bringen. 

Nachdem Sie einem Zweig Notizen hinzugefügt haben, können Sie in das Notizen-Icon  klicken, 

um die Notizen einzublenden. Alternativ können Sie mit der Maus auf das Icon zeigen, um eine 

Vorschau auf den Notizentext zu bekommen. 
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T I P P S :  

 Um Notizen von einem Zweig zu entfernen, klicken Sie bei gedrückter Control-Taste in das 

Notizen-Icon und wählen Sie Notizen entfernen. 

 Um die Notizen in einen anderen Zweig mit Notizen zu kopieren, klicken Sie bei gedrückter 

Control-Taste in das Notizen-Icon. Dann wählen Sie Notizen kopieren. Anschließend klicken Sie 

bei gedrückter Control-Taste in das Notizen-Icon des Zielzweigs und wählen Notizen einsetzen. 

Die kopierte Notiz wird an die vorhandene Notiz angefügt. 

 Zum Ausdrucken der Notizen für einen Zweig klicken Sie bei gedrückter Control-Taste in das 

Notizen-Icon. Dann wählen Sie Drucken. 

 Zum Drucken der Notizen für mehrere Zweige markieren Sie die Zweige. Dann wählen Sie Ablage 

> Notizen drucken. 

Mithilfe der Symbolleiste des Notizenfensters können Sie Notizentext formatieren und Tabellen 

einfügen.  

 

FORMATIEREN VON ZWEIGNOTIZEN 

Zweignotizen lassen sich anhand von Schriftattributen, Einzügen, Aufzählungen und 

Textblockausrichtung formatieren. 

So formatieren Sie die Notizen: 

1. Zum Öffnen des Notizenfensters klicken Sie in das Icon für Zweignotizen oder wählen 

Darstellung > Notizen einblenden. 

2. Markieren Sie den Text, den Sie formatieren wollen.  

T I P P : Zur Auswahl des gesamten Notizentextes drücken Sie Befehl-A. 

3. Wählen Sie Format > Schrift (zum Einblenden eines Stil-Auswahlmenüs) oder Format > Schrift > 

Schriften einblenden (zum Einblenden des Schriftfensters). Treffen Sie dann Ihre Auswahl für 

den Text. 

Zum Ändern anderer Attribute verwenden Sie die Formatierungssymbole am oberen Rand des 

Notizen-Bereichs. 

Sie können ein Bild aus der Bibliothek, aus einer anderen Anwendung oder aus dem Finder in den 

Notizen-Bereich ziehen. Im Notizen-Bereich kann die Größe von Bildern nicht geändert werden. 

Daher sollte ihre Größe vor dem Einfügen geändert werden. 

Notizen können auch Tabellen und Hyperlinks enthalten. 

 



Mindjet MindManager Version 9 für Mac - Benutzerhandbuch 

56 

HINZUFÜGEN VON TABELLEN ZU ZWEIGNOTIZEN 

Zur Darstellung von strukturierten Informationen können Sie Tabellen zu Zweignotizen hinzufügen. 

So fügen Sie den Notizen eine Tabelle hinzu: 

1. Klicken Sie innerhalb des Notizenfensters in die Stelle, wo die Tabelle eingesetzt werden soll. 

2. Klicken Sie in der Symbolleiste des Notizenfensters in die Taste Tabelle, oder wählen Sie Format 

> Tabelle. 

3. Wählen oder geben Sie im eingeblendeten Tabellenfenster die Anzahl der benötigten Zeilen und 

Spalten ein. 

4. Geben Sie die Daten für die Tabelle ein. Drücken Sie die Tab-Taste, um jeweils eine Tabellenzelle 

weiterzuspringen. Mit Shift-Tab springen Sie eine Zelle zurück. 

So passen Sie Tabellenzellen an: 

 Zum Anpassen der Höhe oder Breite einer Zelle ziehen Sie die Ränder der Zelle auf die 

gewünschte Größe. 

 Zum Ändern der Zellenausrichtung, des Randstils oder der Hintergrundfarbe markieren Sie die 

gewünschten Zellen und wählen dann im Tabellenfenster die entsprechenden Einstellungen. 

 Zum Verbinden von Zellen markieren Sie die gewünschten Zellen und klicken dann im 

Tabellenfenster in Zellen verbinden. 

 Um Zellen nach dem Verbinden wieder zu teilen, markieren Sie die gewünschte(n) Zelle(n) und 

klicken dann auf Zellen teilen. 

T I P P :  Um die Tabelle wieder in normalen Text umzuwandeln, klicken Sie in die Tabelle und setzen 

die Spalteneinstellung auf 0. 

Mit der Symbolleiste des Notizenfensters können Sie den Text in Zellen wie regulären Notizentext 

formatieren. 
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HINZUFÜGEN VON HYPERLINKS 

HYPERLINKS 

Hyperlinks können zu Map-Zweigen und zu Text oder Bildern in den Zweignotizen hinzugefügt 

werden und auf eine externe Datei, einen Ordner bzw. eine Webseite oder eine andere Webadresse 

bzw. eine E-Mail-Adresse verweisen. Sie bieten eine elegante Möglichkeit, Informationen durch 

Referenzierung in die Map einzubinden. Dadurch bleibt die Map im Umfang klein und enthält 

dennoch stets aktuelle Informationen. 

Verlinkte Dateien können Dokumente oder Bilder sein, die in anderen Anwendungen erstellt 

wurden. Ebenfalls möglich sind MindManager-Maps. Zudem kann der Link auf einen bestimmten 

Zweig in einer Map verweisen. Zudem können Hyperlinks auf eine E-Mail-Adresse zeigen. Wird in sie 

geklickt, öffnet sich eine neue leere E-Mail-Nachricht an den angegebenen Empfänger und mit 

vordefiniertem Betreff. 

 

HINZUFÜGEN EINES WEBSEITEN- ODER URL-HYPERLINKS 

Sie können einen Hyperlink auf einem Zweig oder in den Zweignotizen ablegen. In diesen können Sie 

dann klicken, um eine Webseite im Internet oder einen anderen URL zu öffnen. 

So fügen Sie eine Webseite oder einen URL-Hyperlink hinzu: 

1. Wählen Sie in der Map- oder Gliederungsansicht einen Zweig, bzw. wählen Sie in den 

Zweignotizen Text oder eine Grafik. 

2. Klicken Sie in der Symbolleiste in das Symbol Hyperlink, oder wählen Sie Einfügen > Hyperlink.  

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Erstellen eines Hyperlinks bzw. Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

3. Wählen Sie im Popup-Menü Link zu die Option URL.  

4. Geben Sie die Link-Adresse in das Feld URL ein. 

An Zweigen mit Hyperlinks wird ein Hyperlink-Icon angezeigt. Wenn Sie zu dieser Stelle springen 

möchten, klicken Sie in das Icon. 

Mit den oben beschriebenen Schritten können Sie einem Zweig nur einen Hyperlink hinzufügen. 

Wenn Sie als Zweigtext die URLs eingeben, können Sie aber auch mehrere Links einfügen. Zwischen 

die einzelnen Adressen setzen Sie Leerzeichen. Der Zweigtext wird in aktive Inline-Links 

umgewandelt. (Zum Aktivieren bzw. Deaktivieren dieser Funktion wählen Sie Darstellung > Zweig-
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Hyperlinks erkennen.) Wenn Sie zum Link-Ziel springen möchten, klicken Sie in den verlinkten Text. 

Diese Inline-Hyperlinks werden in den Informationen nicht angezeigt. 

Webseiten-Hyperlinks können entweder im integrierten MindManager-Browser oder in Ihrem 

Standard-Browser angezeigt werden. Dies legen Sie über MindManager > Einstellungen fest. 

Über Darstellung > Einblenden & Ausblenden können Sie alle Hyperlink-Icons in der Map aus- bzw. 

einblenden. 

So entfernen oder bearbeiten Sie einen Hyperlink: 

1. Klicken Sie bei gedrückter Control-Taste in das Hyperlink-Icon am Zweig oder den verlinkten Text 

bzw. das Bild in den Notizen. 

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Erstellen eines Hyperlinks bzw. Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

2. Wählen Sie Hyperlink bearbeiten oder Hyperlink entfernen. 

3. Nehmen Sie im Dialog Änderungen am Hyperlink vor, oder klicken Sie in Hyperlink entfernen. 

T I P P :  Bei einem Link im Zweigtext (Inline-Links) müssen Sie den Zweigtext bearbeiten, um den Link 

zu modifizieren (Sie können Darstellung > Zweig-Hyperlinks erkennen wählen, um den Link zu 

deaktivieren und den Text zu bearbeiten, und anschließend diese Option wieder aktivieren, um den 

Link wieder zu aktivieren). 

 

HINZUFÜGEN EINES DATEI- ODER ORDNER-HYPERLINKS 

Sie können einen Hyperlink auf einem Zweig oder in den Zweignotizen ablegen, in den sich klicken 

lässt, um eine Datei oder einen Ordner zu öffnen. 

So legen Sie einen Hyperlink zu einer Datei oder einem Ordner an: 

1. Wählen Sie in der Map- oder Gliederungsansicht einen Zweig, bzw. wählen Sie in den 

Zweignotizen Text oder eine Grafik. 

2. Klicken Sie in der Symbolleiste in das Symbol Hyperlink, oder wählen Sie Einfügen > Hyperlink.  

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Erstellen eines Hyperlinks bzw. Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

3. Wählen Sie im Popup-Menü Link zu die Option Datei / Ordner.  

4. Klicken Sie in Auswählen, um die Datei bzw. den Ordner auszuwählen. 
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5. Wählen Sie Als absoluten Hyperlink sichern, wenn der vollständige Pfad in den Link 

aufgenommen werden soll. Andernfalls wird der Link als relativ zur Map gesichert. 

Pro Zweig können Sie nur einen Hyperlink einfügen. An Zweigen mit Dokument-Hyperlinks wird ein 

Hyperlink-Icon angezeigt. Sein Aussehen gibt die Art des Dokuments an, auf das der Link verweist: 

Das Icon  steht beispielsweise für einen Hyperlink zu einer anderen Map. Klicken Sie in das Icon, 

um das Dokument zu öffnen. 

Über Darstellung > Einblenden & Ausblenden können Sie alle Hyperlink-Icons in der Map aus- bzw. 

einblenden. 

So entfernen oder bearbeiten Sie einen Hyperlink: 

1. Klicken Sie bei gedrückter Control-Taste in das Hyperlink-Icon am Zweig oder den verlinkten Text 

bzw. das Bild in den Notizen. 

2. Wählen Sie Hyperlink bearbeiten. 

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für den ausgewählten Zweig existiert, wird er hier 

angezeigt. Zum Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

3. Nehmen Sie im Dialog Änderungen am Hyperlink vor, oder klicken Sie in Hyperlink entfernen. 

W I C H T I G:  Verlinkte Dateien werden nicht in der Map gesichert. Sie bleiben externe Dateien. Wenn 

Sie die Map verschieben oder verschicken, müssen Sie die verlinkten Dokumente mitverschieben 

bzw. -schicken, weil sonst die Hyperlinks der Map nicht mehr funktionieren. Wenn Sie dies 

bevorzugen, können Sie ein Dokument einer Map-Datei auch als Anhang beifügen. Sie können 

mehrere Dokumente an einen Zweig anhängen. Diese bleiben innerhalb der Map-Datei gespeichert. 

Wenn Sie die Map verschieben oder verschicken, werden die Anhänge automatisch einbezogen.  

 

HINZUFÜGEN EINES ZWEIG-HYPERLINKS 

Auf einem Zweig oder in den Zweignotizen können Sie einen Hyperlink einfügen. Wenn Sie später in 

ihn klicken, springen Sie zu einem speziellen Zweig in dieser Map oder einer anderen Map. 

So fügen Sie einem Zweig einen Hyperlink hinzu: 

1. Wählen Sie in der Map- oder Gliederungsansicht einen Zweig, bzw. wählen Sie in den 

Zweignotizen Text oder eine Grafik. 

2. Klicken Sie in der Symbolleiste in das Symbol Hyperlink, oder wählen Sie Einfügen > Hyperlink.  

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Erstellen eines Hyperlinks bzw. Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 
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3. Wählen Sie im Popup-Menü Link zu die Option Zweig.  

4. Wenn sich der gewünschte Zweig in einer anderen Map befindet, wählen Sie In anderer Map. 

Dann klicken Sie in Auswählen und wählen dann die Map. 

5. Markieren Sie in der Liste mit Zweigen den gewünschten Zweig. Wenn nur die Zweige aufgelistet 

werden sollen, die Sie mit Zweigbeschriftungen markiert haben, wählen Sie Nur Zweige mit 

Beschriftung anzeigen. 

6. Wählen Sie Als absoluten Hyperlink sichern, wenn der vollständige Pfad in den Link 

aufgenommen werden soll. Andernfalls wird der Link als relativ zur Map gesichert. 

Pro Zweig können Sie nur einen Hyperlink einfügen. An Zweigen mit Zweig-Hyperlinks wird ein 

Hyperlink-Icon angezeigt. Wenn Sie in das Symbol klicken, springen Sie zu diesem Zweig. 

Über Darstellung > Einblenden & Ausblenden können Sie alle Hyperlink-Icons in der Map aus- bzw. 

einblenden. 

So erzeugen Sie durch Kopieren und Einfügen einen Hyperlink zu einem Zweig: 

1. Wählen Sie den Zielzweig (den Zweig, auf den der Link verweist). Dies kann ein Zweig in der 

aktuellen Map oder einer anderen Map sein. 

2. Drücken Sie Befehl-C, um das Ziel des Zweiges zu kopieren. 

3. Klicken Sie bei gedrückter Control-Taste in den Zweig, in den der Hyperlink eingefügt werden 

soll. 

4. Wählen Sie Hyperlink einfügen. 

So entfernen oder bearbeiten Sie einen Hyperlink: 

1. Klicken Sie bei gedrückter Control-Taste in das Hyperlink-Icon am Zweig oder den verlinkten Text 

bzw. das Bild in den Notizen. 

2. Wählen Sie Hyperlink bearbeiten. 

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

3. Nehmen Sie im Dialog Änderungen am Hyperlink vor, oder klicken Sie in Hyperlink entfernen. 

W I C H T I G:  Wenn Sie die Map verschieben oder verschicken, müssen Sie Maps mit den verlinkten 

Zweigen mitverschieben bzw. -schicken, weil sonst die Hyperlinks der Map nicht mehr funktionieren.  
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VERWENDEN VON ZWEIGBESCHRIFTUNGEN 

Zum Markieren von bestimmten Zweigen in Ihrer Map können Sie diesen Beschriftungen hinzufügen. 

Dies ist insbesondere dann hilfreich, wenn Sie einen Hyperlink zu einem Zweig oder zu einer großen 

Map erzeugen wollen. Damit lässt sich das Ziel einfacher bestimmen. 

So markieren Sie einen Zweig mit einer Beschriftung: 

1. Wählen Sie den Zweig in der Map- oder Gliederungsansicht aus. 

2. Wenn die Informationen zu Aufgaben nicht bereits geöffnet sind, klicken Sie auf die 

entsprechende Schaltfläche in der Toolbar oder wählen Fenster > Informationen einblenden. 

3. Klicken Sie im Informationsfenster in das Symbol Hyperlink und Anhänge. 

4. Geben Sie die Beschriftung für den ausgewählten Zweig in den Informationen zu Hyperlink und 

Anhänge ein. Beschriftungen dürfen keine Leerzeichen, Zahlen bzw. Sonderzeichen enthalten. 

Diese werden automatisch in Unterstrichzeichen umgewandelt. 

5. Ein Icon für die Beschriftung  erscheint am Zweig. Wenn Sie mit dem Mauszeiger auf die 

Beschriftung des Zweigs zeigen, wird der Name angezeigt. 

Zum Ändern einer Zweigbeschriftung wiederholen Sie die oben beschriebenen Schritte und ändern 

bzw. entfernen den Beschriftungstext. 

T I P P :  Zum Ausblenden der Beschriftungs-Icons in Ihrer Map wählen Sie Darstellung > Einblenden & 

Ausblenden. Dann deaktivieren Sie das Kästchen für die Beschriftungen. 

Beim Erzeugen von Hyperlinks zu Zweigen können Sie Beschriftungen zum Auffinden von Zweigen 

verwenden. 

 

HINZUFÜGEN EINES E-MAIL-HYPERLINKS 

Sie können einen Hyperlink auf einem Zweig oder in den Zweignotizen einfügen, der beim Anklicken 

eine voradressierte Mail in ihrem Standard-Mail-Client öffnet. 

So fügen Sie einen E-Mail-Hyperlink hinzu: 

1. Wählen Sie in der Map- oder Gliederungsansicht einen Zweig, bzw. wählen Sie in den 

Zweignotizen Text oder eine Grafik. 

2. Klicken Sie in der Symbolleiste in das Symbol Hyperlink, oder wählen Sie Einfügen > Hyperlink.  

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für den ausgewählten Zweig existiert, wird er hier 

angezeigt. Zum Erstellen eines Hyperlinks bzw. Bearbeiten des angezeigten Links klicken Sie in 

Bearbeiten. 
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3. Wählen Sie im Popup-Menü Link zu die Option E-Mail-Adresse. 

4. Gegen Sie in die Felder Adresse und Betreff die Adresse und einen Betreff für die neue Nachricht 

ein. 

T I P P S :  

 An Zweigen mit E-Mail-Hyperlinks wird ein E-Mail-Hyperlink-Icon angezeigt.  

 Über Darstellung > Einblenden & Ausblenden können Sie alle Hyperlink-Icons in der Map aus- 

bzw. einblenden. 

 Zudem können Sie einen Inline-Hyperlink hinzufügen, indem Sie eine Mailto:-Adresse in den 

Zweigtext eingeben. Diesen Text wandelt MindManager automatisch in einen Hyperlink um. Um 

mehrere Hyperlinks hinzuzufügen, setzen Sie Leerzeichen zwischen die einzelnen URLs. (Zum 

Deaktivieren dieser Funktion wählen Sie Darstellung > Zweig-Hyperlinks erkennen.) Diese Inline-

Hyperlinks werden in den Informationen nicht angezeigt. 

So entfernen oder bearbeiten Sie einen Hyperlink: 

1. Klicken Sie bei gedrückter Control-Taste in das Hyperlink-Icon am Zweig oder den verlinkten Text 

bzw. das Bild in den Notizen. 

2. Wählen Sie Hyperlink bearbeiten. 

T I P P :  Wenn die Informationen bereits offen sind, klicken Sie in das Register Hyperlink und 

Anhänge. Wenn bereits ein Hyperlink für die Auswahl existiert, wird dieser hier angezeigt. Zum 

Bearbeiten des angezeigten Links klicken Sie in Bearbeiten. 

3. Nehmen Sie im Dialog Änderungen am Hyperlink vor, oder klicken Sie in Hyperlink entfernen. 

T I P P :  Bei einem Link im Zweigtext (Inline-Links) müssen Sie den Zweigtext bearbeiten, um den Link 

zu modifizieren (Sie können Darstellung > Zweig-Hyperlinks erkennen wählen, um den Link zu 

deaktivieren und den Text zu bearbeiten, und anschließend diese Option wieder aktivieren, um den 

Link wieder zu aktivieren). 

 

SPRINGEN ZU VERKNÜPFTEN DATEIEN, ORDNERN UND SPEICHERORTEN 

Durch Klicken oder Aktivieren eines Zweig-Hyperlinks können Sie zu einer verknüpften Datei, einem 

Ordner oder Ablageort springen oder eine E-Mail-Nachricht erstellen. 

So aktivieren Sie den Hyperlink: 

 Klicken Sie in der Map- oder Gliederungsansicht in das Hyperlink-Icon am Zweig. 
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Der verknüpfte Ablageort, die Datei oder der Ordner wird daraufhin in dem entsprechenden 

Programm (Web-Browser o. a. Programm oder im Finder) geöffnet. Durch Klicken in einen E-Mail-

Hyperlink wird Ihr E-Mail-Programm gestartet, und Sie können eine neue Nachricht erstellen. 

Webseiten-Hyperlinks können entweder im integrierten MindManager-Browser oder in Ihrem 

Standard-Browser angezeigt werden. Dies legen Sie über MindManager > Einstellungen fest. 

 

VERWENDEN DES INTEGRIERTEN WEBBROWSERS VON MINDMANAGER 

MindManager verfügt über einen integrierten Webbrowser, der grundlegende Browserfunktionen in 

einer einfachen, kompakten Benutzeroberfläche vereint. Sie können festlegen, dass Web-Hyperlinks 

automatisch im MindManager-Browser geöffnet werden, statt dazu Ihren regulären Browser zu 

verwenden. Den Browser können Sie auch für das normale Surfen im Web verwenden. 

Wenn Sie eine Seite im Webbrowser anzeigen, können Sie die Seitenadresse als Hyperlink in Ihre 

Map einfügen oder Inhalte von der Seite in Ihre Map übernehmen. Links und Inhalte werden als 

neue Zweige in die Map übernommen. 

So lassen Sie Webseiten-Hyperlinks automatisch im MindManager-Browser öffnen: 

1. Wählen Sie MindManager > Einstellungen. 

2. Aktivieren Sie die Option Links im MindManager-Browser öffnen. 

3. Wenn das MindManager-Browserfenster bei Verwendung immer im Vordergrund angezeigt 

werden soll, aktivieren Sie die Option Browser-Fenster im Vordergrund halten.  

Wenn Sie in einen Hyperlink klicken, der auf eine Website verweist, wird deren Inhalt im 

MindManager-Browserfenster angezeigt. 

So zeigen Sie eine andere Webseite an: 

1. Öffnen Sie den Browser, indem Sie in einen vorhandenen Webseiten-Hyperlink klicken. 

2. Geben Sie die Seitenadresse in das Adressfeld des Browsers ein. Wahlweise können Sie auch 

einen Link einfügen oder ihn aus der Adressleiste Ihres sonst genutzten Browsers in das Feld 

ziehen. 

So fügen Sie die Adresse einer Webseite als Hyperlink in Ihre Map ein: 

1. Navigieren Sie zu der Webseite, die Sie als Hyperlink-Ziel verwenden möchten. 

2. Markieren Sie einen Map-Zweig. Es wird ein neuer Unterzweig erzeugt, auf dem sich der 

Hyperlink befindet. 

3. Ziehen Sie die Adresse von der Symbolleiste des Webbrowsers in die Map oder klicken Sie in Zu 

Map hinzufügen . 
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Daraufhin werden ein neuer Zweig mit dem Seitentitel als Zweigtext sowie ein Hyperlink erzeugt. 

So übernehmen Sie Inhalt von einer Webseite in Ihre Map: 

1. Markieren Sie im Webbrowser den Inhalt, der in die Map übernommen werden soll. 

2. Ziehen Sie den Inhalt in die Map (der Inhalt wird als Unterzweige des aktiven Zweigs eingefügt). 

Jede Zeile mit Seiteninhalt wird in der Map zu einem neuen Zweig. 
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FORMATIEREN VON MAPS 

VERWENDEN VON STILENSTYLES 

STILE 

Im Lieferumfang von MindManager ist eine umfangreiche Auswahl an Map-Stilen enthalten, mit 

denen Sie den Look Ihrer Map auf Ihre Bedürfnisse zuschneiden können. 

Stile enthalten Standardformateinstellungen für jede Art von Map-Element und die 

Standardeinstellungen für das Layout der Map. Jede Map und Map-Vorlage enthält einen zugrunde 

liegenden Stil, der bestimmt, wie sie in ihrem Standardzustand ohne zusätzliche Formatierung 

aussieht. Wenn Sie einen neuen Zweig oder ein Element hinzufügen, wird dessen ursprüngliches 

Aussehen von diesen Stileinstellungen bestimmt. 

Diese Standardeinstellungen können Sie ändern, indem Sie der Map einen neuen Stil zuweisen. Zur 

Anzeige der Auswahl an verfügbaren Stilen wählen Sie Format > Stil > Aus Vorschau zuweisen. Auch 

das Übernehmen eines Stils aus einer Datei ist möglich. Erfahrene MindManager-Nutzer legen Ihre 

eigenen Stile an. 

 

AUSWÄHLEN EINES STILS FÜR IHRE MAP 

Der Map-Stil bestimmt die in der Map verwendeten Standardformatierungen (Schriftarten, Farben, 

Formen und Layout-Optionen). Beim Beginnen einer neuen Map wird ihr Stil durch die zum Anlegen 

verwendete Vorlage bestimmt. 

Sie können Ihrer Map jederzeit einen neuen Stil zuweisen, um die Standardformatierung der Map zu 

ändern. Es empfielt sich jedoch, dies vor dem Formatieren einzelner Zweige zu tun. Der neue Stil 

wird von Zweigen und Elementen mit Standardformatierung widergespiegelt, aber die von Ihnen 

formatierten Zweige behalten die individuell festgelegten Einstellungen bei. 

So wählen Sie einen neuen Stil: 

1. Öffnen Sie die Map. 

2. Wählen Sie Format > Stile > Aus Vorschau zuweisen oder Format > Stile > Aus Datei zuweisen. 

3. Wählen Sie den gewünschten Stil aus, und klicken Sie auf Auswählen.  

H I N W E I S :  Wenn Sie den Stil aus einer Datei gewählt haben, werden nur Stil-Dateien (.mmas) 

angezeigt. 

Die Map wird auf den neuen Stil aktualisiert.  
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T I P P :  Wenn Sie einen neuen Stil wählen, behalten alle Zweige oder Elemente ohne 

Standardformatierung (für die eine andere Formatierung festgelegt wurde) ihre individuelle 

Formatierung bei. Wenn diese auf ihre Standardformatierung zurückgesetzt werden, erhalten sie 

den neuen Stil.  

 

ERSTELLEN EINES BENUTZERDEFINIERTEN STILS 

Stildateien enthalten die Standardformatierungseinstellungen für Map-Zweige und weitere 

Elemente. Wenn Sie einen Stil auf eine Map übertragen, werden die Stileinstellungen auf alle Map-

Zweige und -Elemente angewendet, die auf die Standardformatierung gesetzt sind (also die, deren 

ursprüngliche Formatierung nicht geändert wurde). Auf der Basis des Stils einer Map oder eines 

bestehenden Stils können Sie einen benutzerdefinierten Stil anlegen. Das Anlegen eigener Stile wird 

nur erfahrenen Benutzern von MindManager empfohlen. 

So legen Sie auf der Basis einer Map einen benutzerdefinierten Stil an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zu der Map, deren Stileinstellungen Sie als Stil 

sichern möchten. 

2. Klicken Sie in Öffnen. 

3. Formatieren Sie alle Elemente der Map mit der Formatierung, die als Standard für das 

betreffende Element verwendet werden soll. Während Sie die einzelnen Elemente formatieren, 

speichern Sie die Formatierung für diesen Elementtyp als Standard: Wählen Sie dazu Format > 

Als Standardformat festlegen. Sie können die Standardformatierung für folgende Elemente 

festlegen: 

 Hauptzweige und Unterzweige (nach Ebene, bis zu 4 Ebenen) 

 freie Anmerkungen und Unterzweige (nach Ebene, bis zu 5 Ebenen) 

 Anmerkungen und Unterzweige (nach Ebene, bis zu 5 Ebenen) 

 Umrandungen 

 Verbindungen 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Stil. 

6. Geben Sie den Namen für den Stil ein. Diesem wird automatisch die Erweiterung .mmas 

zugewiesen. 

Um den Stil in der MindManager-Vorlagenvorschau verfügbar zu machen, wird er von 

MindManager automatisch im Standardordner gesichert:  

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Styles 
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  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

So passen Sie einen bestehenden Stil an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zum Stile-Ordner, in der Regel: 

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Styles 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

2. Wählen Sie den gewünschten Stil, und klicken Sie in Öffnen. 

3. Fügen Sie die Elemente ein, deren Formatierung Sie definieren möchten, formatieren Sie sie 

entsprechend, und wählen Sie für jedes Element Format > Als Standardformat festlegen. (Für 

welche Elemente Sie die Formatierung definieren können, entnehmen Sie der Liste in Schritt 3.) 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Stil. 

6. Geben Sie den Namen für den Stil ein. Diesem wird automatisch die Erweiterung .mmas 

zugewiesen. 

Um den Stil in der MindManager-Stilvorschau verfügbar zu machen, wird er von MindManager 

automatisch im Standardordner für Stile gesichert. 

Der neue oder bearbeitete Stil ist in der Stilvorschau verfügbar. Sie können diesen Stil an andere 

MindManager-Benutzer verteilen. Wenn er in deren Vorlagenvorschau verfügbar sein soll, müssen 

sie ihn auf ihrem System in den standardmäßigen Ordner für Stile kopieren. 

Sie können Ihren neuen Stil auf jede Map und sogar auf Vorlagen (darunter auch die Standard-Map-

Vorlage für alle neuen Maps) übertragen.  
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ANORDNEN VON ZWEIGEN UND FORMATIEREN DES LAYOUTS 

VERSCHIEBEN UND KOPIEREN VON ZWEIGEN MIT DRAG & DROP 

Sie können Zweige per Drag & Drop verschieben, um Ihre Map neu zu organisieren. Auf diese Weise 

können Sie Hauptzweige, freie Anmerkungen und Anmerkungen neu positionieren. Wenn Sie 

Hauptzweige verschieben, werden diese in der Mapansicht automatisch an einer optimalen Stelle 

positioniert. Wenn Sie mehr Freiheit beim Positionieren von Hauptzweigen wünschen, ziehen Sie an 

den Ziehpunkten für Hauptzweige. Anmerkungen lassen sich im Umfeld ihres Oberzweigs neu 

positionieren bzw. verschieben oder kopieren und so in einen normalen Zweig umwandeln.  

So verschieben bzw. kopieren Sie Zweige und freie Anmerkungen: 

1. Wählen Sie einen Zweig in der Map- oder Gliederungsansicht. Dessen Unterzweige werden 

automatisch mit verschoben. 

2. Ziehen Sie den Zweig an die neue Stelle. Ein optischer Anhaltspunkt zeigt den Zielort des Zweiges 

an. 

Wenn er eine freie Anmerkung werden soll, halten Sie beim Ziehen die Shift-Taste gedrückt, 

damit er nicht an einen anderen Zweig angehängt wird. 

3. Legen Sie den Zweig ab. 

Wenn der Zweig kopiert werden soll, halten Sie beim Ablegen die Wahltaste gedrückt. 

So positionieren Sie Hauptzweige frei neu: 

 Ziehen Sie den Zweig an seinem Ziehpunkt. Der Ziehpunkt wird schwarz. Damit wird angezeigt, 

dass dieser Zweig frei positioniert wurde.  

»  »  »

 

»  »  »

  
Durch Ziehen am Ziehpunkt von Hauptzweigen können Sie Hauptzweige frei positionieren. 

 Um den Zweig an seine optimale Stelle zurückzusetzen, klicken Sie bei gedrückter Control-Taste 

in den Zweig. Dann wählen Sie aus dem Kontextmenü Position zurücksetzen. 

T I P P :  Wenn die Hauptzweig-Ziehpunkte nicht angezeigt werden, sind sie u. U. ausgeblendet. Wählen 

Sie Darstellung > Einblenden & Ausblenden, und entfernen Sie das Häkchen von Ziehpunkte für 

Hauptzweige, um sie einzublenden. 

So verschieben bzw. kopieren Sie Anmerkungen: 

1. Wählen Sie die gewünschte Anmerkung in der Mapansicht. Ihre Unterzweige werden 

automatisch mit verschoben. 
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2. Ziehen Sie die Anmerkung, um sie im Umfeld ihres Oberzweiges neu zu positionieren. 

Wenn sie zu einem Zweig oder Unterzweig werden soll, halten Sie beim Ziehen die Shift-Taste 

gedrückt. 

Ein optischer Anhaltspunkt zeigt den Zielort des Zweiges an. 

3. Legen Sie den Zweig ab. 

Wenn der Zweig kopiert werden soll, halten Sie beim Ablegen die Wahltaste gedrückt. 

Eine Anmerkung, die auf einen neuen Oberzweig gezogen oder kopiert wird, wird zu einem normalen 

Zweig. 

Die Standardbefehle für das Ausschneiden, Kopieren und Einsetzen bieten beim Verschieben und 

Kopieren von Zweigen größere Flexibilität. Mit ihrer Hilfe können Sie Zweige als Anmerkungen und 

Hyperlinks einsetzen, die auf andere Zweige verweisen. 

 

VERSCHIEBEN UND KOPIEREN VON ZWEIGEN MIT AUSSCHNEIDEN, KOPIEREN UND EINFÜGEN 

Zum Verschieben und Duplizieren von Zweigen können Sie die Standardbefehle Ausschneiden, 

Kopieren und Einsetzen verwenden. Kopierte oder ausgeschnittene Zweige können Sie in dieselbe 

oder eine andere Map einsetzen. Auf diese Art lassen sich auch schnell Anmerkungen und Hyperlinks 

erzeugen. 

So verschieben oder kopieren Sie einen Zweig: 

1. Wählen Sie einen oder mehrere Zweig(e) in der Map- oder Gliederungsansicht aus. 

Sie können Zweige, freie Anmerkungen und Anmerkungen auswählen. 

2. Wählen Sie zum Ausschneiden oder Kopieren des Zweigs dann eine der folgenden 

Verfahrensweisen: 

 Drücken Sie zum Ausschneiden Befehl-X bzw. zum Kopieren Befehl-C. 

 Wählen Sie Bearbeiten > Ausschneiden bzw. Bearbeiten > Kopieren. 

 Klicken Sie bei gedrückter Control-Taste in den Zweig, und wählen Sie Ausschneiden oder 

Kopieren. 

3. Wählen Sie das Ziel aus: Markieren Sie einen Zweig, wenn der eingesetzte Zweig zum Unterzweig 

werden soll, oder klicken Sie in den Map-Hintergrund, wenn der eingesetzte Zweig zur freien 

Anmerkung werden soll. 

Das Ziel kann sich in der aktuellen Map oder einer anderen geöffneten Map befinden. 

4. Wählen Sie zum Einsetzen des Zweigs dann eine der folgenden Verfahrensweisen: 

 Drücken Sie Befehl-V. 
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 Wählen Sie Bearbeiten > Einsetzen. 

 Klicken Sie bei gedrückter Control-Taste in den Zweig, und wählen Sie Einsetzen. 

Der Zweig wird als Unterzweig des ausgewählten Zweigs eingefügt. Wie Sie ihn als Anmerkung oder 

Hyperlink einfügen, wird nachstehend beschrieben.  

T I P P S :  

 Zum Einsetzen des Zweigs als Anmerkung klicken Sie bei gedrückter Control-Taste in den 

Zielzweig und wählen aus dem Kontextmenü die Option Als Anmerkung einsetzen aus. 

Wahlweise können Sie auch den Zielzweig wählen und Bearbeiten > Einsetzen als > Anmerkung 

auswählen. 

 Wenn Sie einen Hyperlink zurück zu einem Zweig erzeugen möchten, kopieren Sie den Zielzweig 

(der Zweig, zu dem eine Verknüpfung erzeugt werden soll). Dann klicken Sie bei gedrückter 

Control-Taste in einen Zweig (in dieser oder einer anderen Map) und wählen aus dem 

Kontextmenü Hyperlink einsetzen. Wahlweise können Sie auch einen Zweig wählen und 

Bearbeiten > Einsetzen als > Hyperlink auswählen 

 Zweige, die Sie von einer Map ausschneiden oder kopieren, können in vielen anderen 

Anwendungen als Text eingesetzt werden. 

Sie können Zweige auch per Drag & Drop verschieben und kopieren.  

 

GLEICHMÄßIGE VERTEILUNG UND AUSRICHTUNG VON MAP-ZWEIGEN 

Mit den Befehlen Map ausgleichen und Zweige ausrichten können Sie die Zweige in Ihrer Map auf 

schnelle Art anordnen. 

So verteilen Sie Map-Zweige gleichmäßig: 

 Wahlen Sie Darstellung > Map ausgleichen. 

Die Hauptzweige werden in der Mapansicht gleichmäßig um das Hauptthema verteilt. 

H I N W E I S : Diese Option ist nur für Maps verfügbar, die den Map-Layout-Typ verwenden. 

So richten Sie Map-Zweige aus: 

1. Wählen Sie die auszurichtenden Zweige. Sie können zwei oder mehr Hauptzweige oder 

Anmerkungen ausrichten. 

2. Wählen Sie Format > Zweige ausrichten, und legen Sie fest, wie die Zweige ausgerichtet sein 

sollen. 
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Es sind nur die vorhandenen Ausrichtungsoptionen verfügbar. Hauptzweige im Map- oder Baum-

Layout können horizontal ausgerichtet werden. Hauptzweige im Organigramm-Layout können 

vertikal ausgerichtet werden. Anmerkungen können horizontal und vertikal ausgerichtet werden. 

 

FORMATIEREN VON UNTERZWEIG-LAYOUT UND -VERBINDUNGSLINIEN 

Für Ihre Map haben Sie die Auswahl aus mehreren Map-, Baum- und Organigramm-Layouts. In 

verschiedenen Bereichen Ihrer Map können Sie unterschiedliche Layouts verwenden. Sie können die 

Breite und das Aussehen der Linien ändern, die das Hauptthema und die Hauptzweige verbinden. Für 

alle Zweige können Sie den Stil der Verbindungslinien ändern und ihren Anschlusspunkt bzw. Anker 

am Oberzweig anpassen. 

So ändern Sie den Layout-Typ für Unterzweige: 

1. Markieren Sie in der Mapansicht den Oberzweig des Baumes, dessen Layout Sie ändern 

möchten. Wenn das Layout der gesamten Map geändert werden soll, markieren Sie das 

Hauptthema. 

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Format. 

3. Wählen Sie in den Informationen aus dem Menü für das Layout der Unterzweige den Layout-Typ 

aus. Für Organigramm-Layouts können Sie im Menü Tiefe die Anzahl der Ebenen festlegen. 

 Um den Zweig auf seinen Standardlayout-Typ zurückzusetzen, wählen Sie im Einblendmenü 

für das Layout von Unterzweigen Automatisch aus.  

So ändern Sie die Stärke und das Aussehen der Verbindungslinien von Hauptzweigen: 

1. Wählen Sie Format > Zweiglinien. 

2. Sie können eine bestimmte Breite wählen und festlegen, ob Linien ein wie von Hand 

gezeichnetes "organisches" Aussehen haben sollen. 

Wenn Sie "Organisches" Aussehen wählen, werden die Hauptzweigränder in derselben 

Linienstärke wie die Verbindungslinien dargestellt. Andernfalls bleiben diese unberücksichtigt. 

So ändern Sie den Stil der Verbindungslinien und den Ankerpunkt eines Zweigs: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Format. 
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3. Nehmen Sie in den Informationen aus den Einblendmenüs für Stil und Anker der Unterzweige 

eine Auswahl vor. 

Wenn Sie keinen Stil wählen, werden die Zweigverbindungslinien entfernt. 

T I P P S :  

 Eine weitere Möglichkeit, die Verbindungslinien zu entfernen, ist, sie transparent zu machen: 

Wählen Sie dazu im Linienfarbfeld des Einblendmenüs der Informationen Keine. 

 Sie können die Ziehpunkte für Hauptzweige auch ausblenden, indem Sie Darstellung > 

Einblenden & Ausblenden wählen und die Option Ziehpunkte für Hauptzweige deaktivieren. 

Die anfängliche Standardformatierung für Zweiglinien und Layouts wird durch den der Map 

zugrundeliegenden Stil bestimmt. Wenn Sie die ausgewählten Formatierungen für ähnliche Zweige in 

dieser Map als Standard festlegen wollen, wählen Sie Format > Als Standard festlegen. 

Um den Zweig auf seine Standardformatierung zurückzusetzen, wählen Sie Format > 

Standardformat verwenden. 

 

FORMATIEREN VON ZWEIGABSTÄNDEN, -BREITEN UND -RÄNDERN 

Ändern Sie den Abstand zwischen Zweigen, deren bevorzugte (maximale) Breite und deren 

Innenränder. 

So ändern Sie den Abstand von Unterzweigen: 

1. Markieren Sie in der Mapansicht den Oberzweig des Baumes, dessen Abstände Sie ändern 

möchten. Wenn Sie den Abstand der Hauptzweige ändern möchten, markieren Sie das 

Hauptthema.  

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Abstand. 

3. Vergrößern oder verringern Sie wie gewünscht die Einstellungen für den Abstand der 

Unterzweige. 

Von Oberzweig bestimmt den Abstand zwischen dem aktuellen Zweig und seinen Unterzweigen. 

(Dies gilt nicht für das Hauptthema.) 

Von Nebenzweig bestimmt den Abstand zwischen den Unterzweigen des aktuellen Zweigs. 

 Die Höhe und Breite der einzelnen Zweige wird mit den Einstellungen für die Ränder und 

Vorzugsbreite gesteuert. 

 Sie können die Maßeinheiten für den Zweigabstand ändern, indem Sie MindManager > 

Einstellungen wählen und die gewünschten Maßeinheiten aus der Liste wählen. 
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So legen Sie die bevorzugte Breite für Zweige fest: 

1. Wählen Sie in der Mapansicht den Zweig bzw. die Zweige dessen/deren Breite Sie ändern 

möchten.  

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Abstand. 

3. Vergrößern oder verringern Sie wie gewünscht die Einstellungen für die bevorzugte Breite. 

Diese Einstellung steuert die standardmäßige maximale Breite für die ausgewählten Zweige und 

bestimmt, an welchem Punkt Zweigtext umbrochen wird. Um Textumbrüche zu verhindern, können 

Sie entweder die Vorzugsbreite erhöhen oder die Größe des Zweigs direkt ändern, indem Sie seine 

obere rechte Ecke auf die gewünschte Größe ziehen. 

Wenn Sie die rechte obere Ecke eines Zweigs horizontal ziehen, ändert sich die bevorzugte Breite. Sie 

können jedoch keine bevorzugte Breite einstellen, die größer als der aktuelle Zweigtext ist. Dazu 

müssen Sie sie in den Informationen eingeben. 

So ändern Sie die Innenränder von Zweigen: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Format. 

3. Stellen Sie die Ränder wie gewünscht ein. Sie können die Abstände von Zweigbildern mit den 

Einstellungen für Bildabstand vergrößern. 

Die Einstellungen für die Ränder bestimmen gemeinsam mit der Vorzugsbreite, ob der Zweigtext 

automatisch umbrochen wird.  

Sie können die Maßeinheiten für den Abstand der Ränder ändern, indem Sie MindManager > 

Einstellungen wählen und die gewünschten Maßeinheiten aus der Liste wählen.  

Die anfängliche Standardformatierung für Zweiabstände, -breiten und -ränder wird durch den der 

Map zugrundeliegenden Stil bestimmt. Wenn Sie die ausgewählten Formatierungen für ähnliche 

Zweige in dieser Map als Standard festlegen wollen, wählen Sie Format > Als Standard festlegen. 

Um den Zweig auf seine Standardformatierung zurückzusetzen, wählen Sie Format > 

Standardformat verwenden. 
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VERSCHIEBEN VON ZWEIGEN IN DER GLIEDERUNGSANSICHT 

In der Gliederungsansicht können Sie Zweige auf geiche Weise wie in der Mapansicht per Drag&Drop 

oder mit den Befehlen Ausschneiden, Kopieren und Einsetzen verschieben. Zudem können Sie in der 

Gliederungsansicht zum Verschieben von Zweigen den Befehl Verschieben verwenden. 

So verschieben Sie Zweige: 

1. Markieren Sie einen Zweig. 

2. Klicken Sie in Verschieben und dann in Nach links verschieben, Nach rechts verschieben, Nach 

oben verschieben oder Nach unten verschieben. 

Nach links oder rechts verschobene Zweige werden heraufgestuft oder herabgestuft. 

Wahlweise können Sie Zweige auch mithilfe der Tastaturkurzbefehle verschieben. 
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FORMATIEREN VON ZWEIGEN UND MAP-ELEMENTEN 

FORMATIEREN DES ZWEIGTEXTES 

Für das Formatieren Ihres Zweigtextes haben Sie eine Vielzahl von Möglichkeiten. Sie können: 

 Die Schrift- und Textfarbe für gesamte Zweige oder ausgewählten Text ändern.  

 Die Ausrichtung von Zweigtext innerhalb der Zweigform ändern. Dies ist besonders bei 

Zweigen mit mehrzeiligem Text hilfreich.  

 Sie können Zweigtext einen Großschreibungsstil zuweisen, damit Sie einzelne Worte in 

Zweigen nicht per Hand groß schreiben müssen. Stattdessen geben Sie Ihren Zweigtext 

zunächst ohne Großschreibung ein und weisen den Zweigen danach Großschreibung zu.  

 Die Zweige in Ihrer Map in einer Vielzahl von Formaten automatisch nummerieren lassen.  

So ändern Sie die Schrift- oder Textfarbe: 

1. Wählen Sie einen oder mehrere Zweige bzw. Text innerhalb eines Zweigs. 

2. Wählen Sie Format > Schrift > Schriften einblenden. Wählen Sie die für Ihre Auswahl zu 

verwendende Schriftart. 

In den Informationen können Sie auch die Zweigtextfarbe ändern. Wählen Sie Format > Zweig, um 

auch im Farbfeld für den Text die Farbe zu ändern. Um den Text auf die Standardfarbe 

zurückzusetzen, wählen Sie im Menü des Textfarbfeldes Automatisch. Um den Text unsichtbar zu 

machen, wählen Sie Ohne. 

So ändern Sie die Textausrichtung: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Text, und wählen Sie die gewünschte Ausrichtung. 

T I P P :  Sie können auch die Ränder innerhalb der Zweigform ändern, um die Textanordnung innerhalb 

des Zweigs zu steuern. 

So ändern Sie die Groß-/Kleinschreibung des Textes: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Großschreibung, und wählen Sie den gewünschten Stil für die 

Großschreibung. Jeder zu diesem Zweig neu hinzugefügte Text wird diesem Stil unterworfen. 

Wenn Text bei der Eingabe groß geschrieben werden soll, wählen Sie Ohne. 

T I P P :  Eine einheitliche Großschreibung für alle Map-Zweige verleiht Ihrer Map ein einheitliches 

Erscheinungsbild. 
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So versehen Sie Map-Zweige mit einer Nummerierung: 

1. Wählen Sie den Stammzweig für die Nummerierung. Zum Nummerieren der gesamten Map 

wählen Sie das Haupthema aus. Zum Nummerieren eines Zweigbaumes wählen Sie seinen 

Oberzweig aus.  

2. Wählen Sie Format > Zweignummerierung. 

3. Wählen Sie den Nummerierungsstil aus, oder wählen Sie Anpassen, um einen eigenen Stil zu 

definieren (u. a. Nummerierungstiefe, Stil und Wiederholung).  

Die Nummerierung wird auf die Unterzweige des Stammzweiges angewendet und entspricht 

automatisch der Zweigschriftart und -farbe der einzelnen Zweige. Neue Zweige werden beim 

Hinzufügen zum Baum automatisch nummeriert. Zweige werden neu nummeriert, wenn sie 

verschoben oder einzelne Zweige gelöscht werden. 

Zum Entfernen der Nummerierung wählen Sie den Stammzweig aus. Dann wählen Sie Format > 

Zweignummerierung > Ohne. Sie können die Nummerierung nicht von einzelnen Zweigen entfernen. 

Die Zweignummerierung bleibt bei exportierten Maps erhalten. Beim Export als Gliederung wird die 

Map automatisch nummeriert. Es empfiehlt sich daher, die Nummerierung vor dem Export zu 

entfernen. 

Die anfängliche Standardformatierung für Zweige wird durch den der Map zugrundeliegenden Stil 

bestimmt. Wenn Sie die ausgewählten Formatierungen für ähnliche Zweige in dieser Map als 

Standard festlegen wollen, wählen Sie Format > Als Standard festlegen. Diese Standardformatierung 

wird für alle Zweige verwendet, denen Sie keine Formatierung zugewiesen haben, sowie allen neuen 

Zweigen, die Sie der Map hinzufügen.  

Um den Zweig auf seine Standardformatierung zurückzusetzen, wählen Sie Format > 

Standardformat verwenden. Zweignummerierungen werden beim Export ausgeklammert. 

 

FORMATIEREN VON ZWEIGFARBE UND -FORM 

In den Zweiginformationen können Sie die Farbe von Zweigumrissen und Verbindungslinien sowie 

die Form und Füllfarbe von Zweigen ändern. 

So ändern Sie die Füll- oder Linienfarbe für Zweige: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Format. 
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3. Klicken Sie in den Informationen in das Farbfeld für die Linienfarbe und wählen Sie die Farbe für 

den Zweigumriss und die Verbindungslinie aus. Zum Auswählen der Füllfarbe des Zweigs klicken 

Sie in das Farbfeld Füllen. 

Falls für die Zweigform Ohne eingestellt ist, wird die Füllfarbe als Hervorhebung dargestellt. 

Ferner können Sie hier die Textfarbe festlegen. Wenn ein Zweig ausgewählt ist, wird die Farbe 

auf den gesamten Zweigtext übertragen; wenn ein Teil des Textes ausgewählt ist, wird die Farbe 

auf die Auswahl übertragen. 

T I P P S :  

 Um den Zweig auf seine Standardfarben zurückzusetzen, wählen Sie im Menü des Farbfeldes 

Automatisch aus.  

 Zweiglinienfarben gelten für den Umriss und die nach außen abgehenden Verbindungslinien des 

aktuellen Zweigs und seiner Unterzweige. 

 Um ein Element transparent darzustellen, wählen Sie aus dem Menü des Farbfeldes Ohne 

aus. 

 Zum Deaktivieren der Zweigschattierung deaktivieren Sie unter MindManager > Einstellungen 

die Option Füllfarbenverläufe anzeigen. 

 Hinweis: Sie können den Füll- und Schriftfarben auch eine Bedeutung aus den Informationen zu 

Markierungen zuweisen. 

 Mit Format > Schrift > Schriften einblenden können Sie die Farbe des gewählten Zweigtextes 

ändern. 

So ändern Sie die Zweigform: 

1. Markieren Sie in der Mapansicht einen oder mehrere Zweige. 

2. Wählen Sie Format > Zweig. 

T I P P :  Wenn die Informationen für Zweige bereits geöffnet sind, klicken Sie in das Register 

Format. 

3. Wählen Sie in den Informationen aus dem Einblendmenü Form aus. 

Falls Sie als Form Linie oder Ohne auswählen, wird die Füllfarbe als Hervorhebung für den 

Zweigtext verwendet. 

T I P P S :  

 Um den Zweig auf seine Standardform zurückzusetzen, wählen Sie im Einblendmenü Form die 

Option Automatisch.  

 Sie können die Innenränder der Form mithilfe der Einstellungen für den Abstand steuern. 
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Die anfängliche Standardformatierung für Zweige wird durch den der Map zugrundeliegenden Stil 

bestimmt. Wenn Sie die Formatierung des ausgewählten Zweigs zum Standard für ähnliche Zweige in 

dieser Map machen wollen, wählen Sie Format > Als Standard festlegen. Um den Zweig auf seine 

Standardformatierung zurückzusetzen, wählen Sie Format > Standardformat verwenden. 

 

FORMATIEREN VON UMRANDUNGEN 

Sie können den Linienstil, die Linienfarbe und die Füllfarbe für Umrandungen ändern und eine 

Anmerkung zu Klammern hinzufügen. In der Gliederungsansicht werden Umrandungen nicht 

angezeigt. 

So formatieren Sie eine Umrandung: 

1. Markieren Sie die Umrandung (ein blauer Rahmen gibt an, wenn sie markiert ist). 

2. Um den Umrandungstyp zu ändern, klicken Sie in der Symbolleiste in Umrandung und wählen 

einen anderen Typ. 

3. Wenn das Informationsfenster noch nicht geöffnet ist, klicken Sie bei gedrückter Control-Taste in 

die Umrandung und wählen Umrandung formatieren. Andernfalls klicken Sie im 

Informationsfenster in das Register Umrandung/Verbindung. 

Klicken Sie im Informationsfenster in die entsprechenden Farbfelder, um die Linien- und Füllfarben 

zu ändern, oder wählen Sie eine andere Umrandungsform aus und passen Sie deren Linienstärke und 

-effekt an. 

Die anfängliche Standardformatierung der Umrandung wird durch den der Map zugrundeliegenden 

Stil bestimmt. Wenn Sie diese Standardformatierung als Standard für alle bestehenden 

(unformatierten) und neuen Umrandungen in Ihrer Map festlegen wollen, wählen Sie Format > Als 

Standard festlegen. Um die Umrandung auf die Standardformatierung der Map zurückzusetzen, 

wählen Sie Format > Standardformat verwenden.  

So fügen Sie einer Klammer eine Anmerkung hinzu: 

1. Klicken Sie bei gedrückter Control-Taste in die Klammer (ein blauer Rahmen gibt an, wenn sie 

markiert ist), und wählen Sie Anmerkung einfügen. 

2. Wenn die Anmerkung erscheint, geben Sie den gewünschten Text ein. 

Sie können festlegen, ob bei jedem Hinzufügen einer Klammer automatisch eine Anmerkung 

erscheinen soll. Wählen Sie dazu Einstellungen, und aktivieren Sie die Option Anmerkungen zu 

neuen Klammern hinzufügen. 

Sie können das Format der Anmerkung wie beim Formatieren anderer Zweige ändern. Sie können 

der Anmerkung auch Unterzweige hinzufügen, um den Zweigbaum nach der Klammer fortzusetzen.  
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FORMATIEREN VON VERBINDUNGEN 

Sie können die Form der Verbindung, sowie ihren Linienstil und -farbe ändern und eine Beschriftung 

hinzufügen. In der Gliederungsansicht werden Verbindungen nicht angezeigt. 

Für Verbindungen, die Sie einfügen, ist standardmäßig die Option Automatisch anpassen aktiviert: 

Wenn Sie einen der beiden verbundenen Zweige verschieben, folgt die Linie automatisch einem 

optimalen Pfad. 

So ändern Sie die Form einer Verbindungsline: 

1. Markieren Sie die Verbindung (Ziehpunkte zeigen an, wenn sie markiert ist). 

2. Mithilfe der Ziehpunkte können Sie die Form der Verbindung ändern. 

Wenn Sie die Form der Verbindung verändern, wird die Option Automatisch anpassen automatisch 

deaktiviert. Um die Verbindung auf ihren optimalen Pfad zurückzuführen, müssen Sie diese Option 

wieder aktivieren: Klicken Sie bei gedrückter Control-Taste in die Verbindung, und wählen Sie aus 

dem Kontextmenü Automatisch anpassen. 

So ändern Sie den Linienstil und die Farbe der Verbindung: 

1. Markieren Sie die Verbindung (Ziehpunkte zeigen an, wenn sie markiert ist). 

2. Wenn das Informationsfenster noch nicht geöffnet ist, klicken Sie bei gedrückter Control-Taste in 

die Verbindung. Dann wählen Sie Verbindung formatieren. Andernfalls klicken Sie im 

Informationsfenster in das Register Umrandung/Verbindung. 

3. Klicken Sie im Informationsfenster in die entsprechenden Farbfelder, um die Linien- und 

Füllfarben zu ändern, oder wählen Sie eine andere Form aus, passen Sie Linienstärke und -effekt 

an, und wählen Sie Stile für die Enden. 

Die anfängliche Standardformatierung der Verbindung wird durch den der Map zugrundeliegenden 

Stil bestimmt. Wenn Sie diese Standardformatierung zum Standard für alle bestehenden 

(unformatierten) und neuen Verbindungen in Ihrer Map machen wollen, wählen Sie Format > Als 

Standardformat festlegen. Um die Verbindung auf die Standardformatierung der Map 

zurückzusetzen, wählen Sie Format > Standardformat verwenden.  

So fügen Sie einer Verbindung eine Anmerkung hinzu: 

1. Klicken Sie bei gedrückter Control-Taste in die Verbindung (Ziehpunkte zeigen an, wenn sie 

markiert ist), und wählen Sie Anmerkung einfügen. 

2. Wenn die Anmerkung erscheint, geben Sie den gewünschten Text ein. 

Sie können festlegen, ob bei jedem Hinzufügen einer Verbindung automatisch eine Anmerkung 

erscheinen soll. Wählen Sie dazu MindManager > Einstellungen und aktivieren Sie das Feld 

Anmerkungen zu neuen Verbindungen hinzufügen. 
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Sie können das Format der Anmerkung wie beim Formatieren anderer Zweige ändern. Sie können 

der Anmerkung auch Unterzweige hinzufügen, um den Zweigbaum detaillierter fortzusetzen.  

 

FORMATIEREN DES MAP-HINTERGRUNDS 

Sie können die Hintergrundfarbe einer Map ändern und/oder ein Bild zur Erzeugung einer 

Oberflächenstruktur oder eines Wasserzeichens hinzufügen. 

So ändern Sie die Hintergrundfarbe der Map: 

1. Wählen Sie in der Mapansicht Format > Hintergrund. 

2. Zum Auswählen einer neuen Hintergrundfarbe für die Map klicken Sie in das Farbfeld Füllfarbe. 

T I P P :  Sie können eine Hintergrundfarbe mit einem teilweise transparenten Bild kombinieren, um 

eine Vielzahl von Hintergrundeffekten zu erzeugen. 

So fügen Sie ein Hintergrundbild hinzu: 

1. Optional:  Wenn Sie ein Hintergrundbild aus der MindManager-Bibliothek verwenden wollen, 

öffnen Sie diese. Klicken Sie in der Symbolleiste in die Taste Bibliothek, oder klicken Sie in 

Fenster > Bibliothek einblenden und wählen Sie am oberen Rand in der Bibliothek die 

Hintergrundkategorie aus.  

2. Wählen Sie Format > Hintergrund. 

3. Klicken Sie in Auswählen, und wählen Sie ein Bild aus, oder ziehen Sie ein Bild aus der Bibliothek, 

aus dem Finder oder aus anderen Programmen in das Fenster mit der Hintergrundvorschau. 

4. Wählen Sie eine Einstellung zum Auffüllen des Hintergrunds, und verwenden Sie den Regler für 

die Deckkraft zum Ändern der Transparenz des Bildes. 

Zum Entfernen des Hintergrundbildes wählen Sie Format > Hintergrund und dann Entfernen, oder 

klicken Sie im Bereich Hintergrund der Bibliothek in Bild als Map-Hintergrund entfernen. 

T I P P :  Sie können das Hintergrundbild direkt von der Bibliothek aus ändern. Klicken Sie dazu in der 

Symbolleiste in die Schaltfläche Bibliothek, oder wählen Sie Fenster > Bibliothek einblenden und 

dann aus dem Einblendmenü den gewünschten Hintergrund aus. Wählen Sie aus der Liste 

Hintergrund, und ziehen Sie ein Bild aus dem Fenster mit der Hintergrundvorschau in Ihre Map. Die 

neuen Bilder haben die gleichen Einstellungen für das Auffüllen des Hintergrunds und für die 

Deckkraft wie die vorherigen Bilder. 

Zum schnellen Zugriff können Sie Ihre benutzerdefinierten Hintergrundbilder zur Bibliothek 

hinzufügen.  
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VERWENDEN VON FORMATIERUNGSWERKZEUGEN 

KOPIEREN UND EINSETZEN VON FORMATEN 

Sie können einen Zweig in der Mapansicht schnell formatieren, indem Sie die Formatierung eines 

anderen Zweiges kopieren. Diese Vorgehensweise ist auch bei anderen Elementen (Umrandungen 

und Verbindungen) möglich.  

So duplizieren Sie das Format eines Zweigs oder Elements: 

1. Wählen Sie den Zweig bzw. das Element aus, dessen Format kopiert werden soll. 

2. Wählen Sie Bearbeiten > Format kopieren. 

3. Wählen Sie den Zweig aus, auf den das Format übertragen werden soll, und wählen Sie 

Bearbeiten > Format einsetzen.  

Die anfänglich verwendete Standardformatierung für Zweige und andere Elemente wird durch den 

der Map zugrundeliegenden Stil bestimmt. Unter Umständen ist es effizienter, die Standardstile für 

die Map zu ändern, als ein Format mehrfach zu kopieren und einzusetzen.  

 

ÄNDERN DER STANDARDFORMATIERUNG FÜR ZWEIGE UND ELEMENTE 

Nachdem Sie einen Zweig oder ein Element in der Mapansicht formatiert haben, können Sie diese 

Einstellungen sichern und als Standardformatierung für neue Zweige, Umrandungen und 

Verbindungen verwenden. Die Standardformatierung bestimmt das Aussehen eines Elements, wenn 

es der Map erstmalig hinzugefügt wird. Dieser Standard wird auch unmittelbar auf alle bestehenden 

Zweige und Elemente in der Map mit Standardformatierung angewendet. 

So ändern Sie das Standardformat: 

1. Wählen Sie einen Zweig, eine Umrandung oder eine Verbindung aus, dessen bzw. deren 

Formatierung Sie als Standard verwenden wollen. 

2. Wählen Sie Format > Als Standardformat festlegen, um die gegenwärtige Formatierung als 

Standard zu sichern. 

Sie können die Standardformatierung für folgende Elemente festlegen: 

 Hauptzweige  

 Unterzweige (nach Ebene, bis zu 4 Ebenen)  

 freie Anmerkungen mit Unterzweigen (nach Ebene, bis zu 5 Ebenen)  

 Anmerkungen und ihre Unterzweige (nach Ebene, bis zu 5 Ebenen)  

 Umrandungen  

 Verbindungen  



Mindjet MindManager Version 9 für Mac - Benutzerhandbuch 

82 

Alle bestehenden und nicht individuell formatierten Zweige oder Elemente übernehmen den neuen 

Standard. 

Der Anfangsstandard für Zweige und Elemente wird durch den der Map zugrundeliegenden Stil 

bestimmt.  

 

ZURÜCKSETZEN VON ZWEIGEN ODER ELEMENTEN AUF IHRE STANDARDFORMATIERUNG 

Sie können Zweige oder Elemente auf ihre Standardformatierung zurücksetzen. Dabei wird sämtliche 

Formatierung, die Sie übertragen haben, entfernt. Das Element erscheint dann mit den Attributen, 

die der zugrunde liegende Map-Stil vorgibt. 

So setzen Sie Zweige oder Elemente auf ihre Standardformatierung zurück: 

1. Wählen Sie einen oder mehrere Zweige bzw. Elemente in der Mapansicht aus. 

2. Wählen Sie Format > Standardformat verwenden. 

Wenn Sie anschließend die Standardformatierung ändern oder einen neuen Stil anwenden, spiegeln 

diese Elemente die neuen Einstellungen wider. 

Mehr über Stile erfahren Sie unter Stile. 
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SICHERN UND FREIGEBEN IHRER MAPS 

SICHERN VON MAPS 

SICHERN VON MAPS 

Wenn Sie eine Map erstellen oder bearbeiten, sind die vorgenommenen Änderungen erst dann 

permanent, wenn Sie die Map sichern. Um die Gefahr zu vermeiden, dass vorgenommene 

Änderungen verlorengehen, sollten Sie Ihre Maps in kurzen Abständen sichern. MindManager sichert 

für Maps in regelmäßigen Abständen Daten für die automatische Wiederherstellung. 

Sie können eine Map unter einem neuen Namen sichern, um zu vermeiden, dass das Original 

überschrieben wird. Zudem können Sie eine XML-Version Ihrer Map sichern, die sich in 

Anwendungen öffnen lässt, die .xmmap-Dateien lesen können. Weitere Informationen dazu finden 

Sie in den Tipps zur plattformübergreifenden Verwendung. 

So sichern Sie Ihre Map erstmalig: 

1. Wählen Sie Datei > Sichern. 

2. Geben Sie einen Namen für die Map ein. 

3. Wenn Sie die Map an einem anderen Ort sichern möchten, wählen Sie im Einblendmenü Wo 

einen Speicherort. Wahlweise können Sie auch auf das Disclosure-Triangle rechts vom Namen 

der Map klicken und dann den Speicherort auswählen. 

4. Klicken Sie in Sichern. 

So sichern Sie die Änderungen an einer bestehenden Map: 

 Zum Sichern der Map unter demselben Namen wählen Sie Ablage > Sichern. 

 Um die Map unter einem anderen Namen zu sichern (ohne das Original zu überschreiben), 

wählen Sie Ablage > Sichern unter, geben den neuen Namen ein und klicken dann auf Sichern. 

T I P P :  Nach dem Sichern bleibt die Map mit dem neuen Namen geöffnet. Wenn Sie mit der 

Vorgängerversion arbeiten möchten, müssen Sie diese gesondert öffnen. Dazu wählen Sie Ablage > 

Benutzte Dokumente und öffnen im angezeigten Untermenü die ursprüngliche Version. 

So sichern Sie die aktuelle Map im XML-Format: 

1. Wählen Sie Ablage > Sichern als. 

2. Wählen Sie aus dem Einblendmenü Dateiformat die Option .xmmap. 
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3. Geben Sie einen Namen für die Map ein. 

4. Wenn Sie die Map an einem anderen Ort sichern möchten, wählen Sie im Einblendmenü Wo 

einen Speicherort. Wahlweise können Sie auch auf das Disclosure-Triangle rechts vom Namen 

der Map klicken und dann den Speicherort auswählen. 

5. Klicken Sie in Sichern. 

Sie können Ihre Map zur Wiederverwendung als Basis für neue Maps als Vorlage sichern, zur 

Einbindung in andere Maps als Map Part sichern oder die Map-Stil-Einstellungen zur 

Wiederverwendung sichern. Wenn der Map-Inhalt in anderen Formaten gesichert werden soll, 

nutzen Sie die Funktion Exportieren. 

 

SCHLIEßEN EINER MAP, OHNE MINDMANAGER ZU BEENDEN 

Wenn Sie die Arbeit an einer Map abgeschlossen haben, können Sie die Map schließen, ohne 

MindManager zu beenden. 

So schließen Sie die aktive Map: 

 Wählen Sie Ablage > Schließen, oder klicken Sie in das Symbol Schließen in der linken oberen 

Ecke des Dokumentfensters. 

Wenn Sie seit dem letzten Sichern Ihrer Map Änderungen vorgenommen haben, fordert 

MindManager Sie auf, sie zu sichern. Sie können die Map sichern oder Ihre Änderungen verwerfen.  

 

ZURÜCKSETZEN EINER MAP AUF DIE ZULETZT GESICHERTE VERSION 

Wenn Sie nach dem Ändern einer Map noch einmal von vorn beginnen möchten, können Sie die Map 

auf die zuletzt gesicherte Version zurücksetzen. MindManager verwirft dann alle Änderungen, die Sie 

seit dem letzten Sichern vorgenommen haben und zeigt die Map in dem Zustand an, in dem sie sich 

nach dem letzten Sichern befand. 

So setzen Sie die Map auf die zuletzt gesicherte Version zurück: 

 Wählen Sie Ablage > Zurücksetzen. 

Der Befehl Zurücksetzen ist grau unterlegt, wenn Sie keine Änderungen in der Map vorgenommen 

haben. 

Außerdem können Sie Ihre letzten Änderungen widerrufen, indem Sie Bearbeiten > Widerrufen 

wählen. 
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VERWENDEN DES KENNWORTSCHUTZES 

Damit eine Map geschützt wird, können Sie ihr ein Kennwort zuweisen und die Map sichern. Von 

diesem Zeitpunkt an kann die Map nur von Benutzern geöffnet werden, die dieses Kennwort kennen. 

So legen Sie für die aktuelle Map ein Kennwort fest: 

1. Wählen Sie Ablage > Autor, und klicken Sie in das Register Kennwort. 

2. Geben Sie das Kennwort für die Map ein. Beim Kennwort muss die Groß-/Kleinschreibung 

beachtet werden. 

3. Wenn Sie das Kennwort für die Map in Ihrem Schlüsselbund speichern möchten, damit Sie es 

zum Öffnen der Map nicht wieder eingeben müssen, aktivieren Sie die Option Kennwort in 

Schlüsselbund speichern. 

W I C H T I G:  Wenn Sie dieses Kennwort verlieren oder vergessen und es nicht in Ihrem 

Schlüsselbund gespeichert haben, gibt es keine Möglichkeit, es wiederzuerlangen. 

4. Klicken Sie in OK. 

5. Zum Sichern der Map wählen Sie Ablage > Sichern. Der Kennwortschutz ist erst nach dem 

Sichern der Map aktiv. 

Vergewissern Sie sich, dass Sie Kennwörter, die nicht im Schlüsselbund gespeichert sind, an einem 

sicheren Ort erfassen und speichern. 

So ändern oder entfernen Sie den Kennwortschutz für die aktuelle Map: 

1. Wählen Sie Ablage > Autor, und klicken Sie in das Register Kennwort. 

2. Ändern oder entfernen Sie das Kennwort für die Map, und klicken Sie in OK. 

3. Zum Sichern der Map wählen Sie Ablage > Sichern. 

 

SICHERN VON AUTORENANGABEN 

Beim Sichern Ihrer Map können Autorenangaben (z. B. Name, Firma und E-Mail-Adresse) mit der 

Map gespeichert werden. Diese Angaben können Sie während der Arbeit an einer Map jederzeit 

aktualisieren. 

So geben Sie die Autorenangaben ein: 

1. Wählen Sie Ablage > Autor, und klicken Sie in das Register Autor. 

2. Geben Sie die neuen Angaben ein. 
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Die anfängliche Standardautorenangabe stammt aus Ihrer Visitenkarte im Adressbuch. Wenn Sie 

diese Angabe ändern, wird sie mit dem aktuellen Dokument gesichert. (Autorenangaben werden bei 

jedem Sichern eines MindManager Dokuments eingebunden.) 

 Wenn Sie die Standardangabe wiederherstellen möchten, klicken Sie in den Pfeil für das 

Pulldown-Menü am unteren Rand des Dialogs und wählen Standard-Autorenangabe 

verwenden. 

 Wenn Sie diese Angabe zum neuen Standard für alle Maps machen wollen, klicken Sie in den 

Pfeil und wählen aus dem Menü Als Standard-Autorenangabe sichern. 

 

SICHERN VON DATEN FÜR DIE AUTOMATISCHE WIEDERHERSTELLUNG 

MindManager bietet Schutz vor dem Verlust von Daten bei irregulärem Schließen des Programms 

(z. B. durch Stromausfall oder Absturz Ihres Computers), indem es in regelmäßigen Abständen Daten 

für die automatische Wiederherstellung sichert. 

So aktivieren Sie das Sichern von Daten für das automatische Wiederherstellen: 

1. Wählen Sie MindManager > Einstellungen. 

2. Wählen Sie Daten für automatische Wiederherstellung sichern alle _ Minuten. 

3. Legen Sie das gewünschte Intervall für die automatische Wiederherstellung fest. 

H I N W E I S :  Wenn Sie das Intervall für die automatische Wiederherstellung zu hoch einstellen, 

können beträchtliche Datenmengen verloren gehen. Wenn Sie beispielsweise das Intervall auf 

60 Minuten setzen und 59 Minuten nach Beginn des Intervalls ein Stromausfall eintritt, würden 

keine Daten für die automatische Wiederherstellung gesichert werden. Sofern Sie Ihre Maps 

zwischenzeitlich nicht von Hand gesichert haben, würde in diesem Fall Ihre gesamte Arbeit 

verloren gehen. 

Wenn Sie MindManager nach irregulärer Beendigung neu starten, versucht MindManager, alle Maps 

wiederherzustellen, die Sie zum Zeitpunkt des Beendens gerade bearbeitet haben. Falls 

MindManager die Daten zur automatischen Wiederherstellung für die von Ihnen gerade 

bearbeiteten Maps sichert, wird Ihnen eine Warnmeldung über die Wiederherstellung angezeigt. 

MindManager wird daraufhin diese Maps mit den von Ihnen vorgenommenen Änderungen erneut 

öffnen. 

 Wenn die angezeigten Änderungen erhalten bleiben sollen, sichern Sie die Map. 

 Wenn die Änderungen verworfen und die Map auf die zuletzt gesicherte Version zurückgesetzt 

werden soll, schließen Sie die Map. 
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ERSTELLEN EINER BENUTZERDEFINIERTEN MAP-VORLAGE 

Auf der Basis einer Map oder durch Bearbeitung einer vorhandenen Vorlage können Sie eine 

benutzerdefinierte Vorlage mit eigenem Design erstellen. 

So legen Sie auf der Basis einer Map eine benutzerdefinierte Vorlage an: 

1. Legen Sie eine neue Map an, oder öffnen Sie eine vorhandene Map. 

2. Nehmen Sie die gewünschten Änderungen an Formatierung und Inhalt der Map vor. Die in der 

Map enthaltenen Zweige und Elemente (Verbindungen, Umrandungen) bleiben in der Vorlage 

erhalten. 

T I P P :  Zum Definieren der Standardformatierung für Zweige oder Elemente in dieser Vorlage 

wählen Sie Format > Als Standardvorlage festlegen, nachdem Sie deren Formatierung geändert 

haben. Wenn die Vorlage zum Anlegen einer neuen Map verwendet wird, erhalten Zweige und 

Elemente automatisch diese Formatierung. Sie können die Standardformatierung für 

Unterzweige nach Ebenen bis Ebene 4 definieren. 

3. Wählen Sie Datei > Sichern als. 

4. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Vorlage. 

5. Geben Sie den Namen für die Vorlage ein. Dieser wird automatisch die Erweiterung .mmat 

zugewiesen. 

Um die Vorlage in der MindManager-Vorlagenvorschau verfügbar zu machen, wird sie von 

MindManager automatisch im Standardordner gesichert:  

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Templates 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

So passen Sie eine bestehende Vorlage an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zum Ordner Templates (in der Regel): 

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Templates 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

2. Wählen Sie die gewünschte Vorlage, und klicken Sie in Öffnen. 

3. Nehmen Sie die Änderungen in der Map-Vorlage wie in jeder anderen Map vor. Sie können die 

Formatierung und den Inhalt wie gewünscht ändern. Die in der Map enthaltenen Zweige und 

Elemente (Verbindungen, Umrandungen) bleiben in der neuen Vorlage erhalten. 

T I P P :  Zum Definieren der Standardformatierung für Zweige oder Elemente in dieser Vorlage 

wählen Sie Format > Als Standardvorlage festlegen, nachdem Sie deren Formatierung geändert 

haben. Wenn die Vorlage zum Anlegen einer neuen Map verwendet wird, erhalten Zweige und 
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Elemente automatisch diese Formatierung. Sie können die Standardformatierung für 

Unterzweige nach Ebenen bis Ebene 4 definieren. 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Vorlage. 

6. Geben Sie den Namen für die Vorlage ein. Dieser wird automatisch die Erweiterung .mmat 

zugewiesen. 

Um die Vorlage in der MindManager-Vorlagenvorschau verfügbar zu machen, wird sie von 

MindManager automatisch zurück in den Standardvorlagenordner gesichert. 

Die neue oder geänderte Vorlage steht dann beim Anlegen einer neuen Map in der Auswahl von 

Map-Vorlagen in der Vorlagenvorschau zur Verfügung. Diese Vorlage können Sie an andere 

MindManager-Benutzer verteilen. Wenn sie in deren Vorlagenvorschau verfügbar sein soll, müssen 

sie sie in den standardmäßigen Vorlagenordner kopieren. 

Die neue Vorlage können Sie als Standardvorlage für jede neu zu erstellende Map verwenden.  

 

ERSTELLEN EINES BENUTZERDEFINIERTEN MAP PARTS 

Um die Eingabe häufig verwendeter Zweige zu beschleunigen, können Sie einen eigenen Map Part 

anlegen. Wahlweise können Sie auch einen vorhandenen Map Part bearbeiten, um ihn an Ihre 

Bedürfnisse anzupassen. Der neue oder bearbeitete Map Part wird dann über den Bereich Map Parts 

der Bibliothek abrufbar sein. 

So legen Sie auf der Basis einer Map einen benutzerdefinierten Map Part an: 

1. Legen Sie eine neue Map an, oder öffnen Sie eine vorhandene Map. 

2. Geben Sie die in den Map Part einzubindenden Zweige ein oder ordnen Sie diese an. Nur der 

erste Hauptzweig (rechts oben) und seine Unterzweige werden in den Map Part übernommen.  

W I C H T I G:  Ein Map Part kann nur den ersten Hauptzweig der Map enthalten. Das Hauptthema 

oder andere Zweige in der Map bleiben ausgeschlossen. 

3. Wählen Sie Datei > Sichern als. 

4. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map Part. 

5. Geben Sie den Namen für den Map Part ein. Diesem wird automatisch die Erweiterung .mmmp 

zugewiesen. 

Um den Map Part im gleichnamigen Bereich der MindManager-Bibliothek verfügbar zu machen, 

wird er von MindManager automatisch im Standardordner gesichert:  

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Map Parts 
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  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

So passen Sie einen bestehenden Map Part an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zum Ordner Map Parts, in der Regel: 

~/Library/Application Support/Mindjet/MindManager/9/{language}/Map Parts/Templates 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

2. Wählen Sie den gewünschten Map Part, und klicken Sie in Öffnen. 

3. Bearbeiten Sie den Inhalt des Map Parts. 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map Part. 

6. Geben Sie den Namen für den Map Part ein. Diesem wird automatisch die Erweiterung .mmmp 

zugewiesen. 

Um den Map Part im gleichnamigen Bereich der MindManager-Bibliothek verfügbar zu machen, 

wird er von MindManager automatisch im Standardordner für Map Parts gesichert. 

Der neue oder bearbeitete Map Part kann dann in der Bibliothek aus der Auswahl mit Map Parts 

abgerufen werden. Sie können diesen Map Part an andere MindManager-Benutzer verteilen. Wenn 

er in deren Bibliothek verfügbar sein soll, müssen sie ihn in den standardmäßigen Map Parts-Ordner 

kopieren. 

 

ERSTELLEN EINES BENUTZERDEFINIERTEN STILS 

Stildateien enthalten die Standardformatierungseinstellungen für Map-Zweige und weitere 

Elemente. Wenn Sie einen Stil auf eine Map übertragen, werden die Stileinstellungen auf alle Map-

Zweige und -Elemente angewendet, die auf die Standardformatierung gesetzt sind (also die, deren 

ursprüngliche Formatierung nicht geändert wurde). Auf der Basis des Stils einer Map oder eines 

bestehenden Stils können Sie einen benutzerdefinierten Stil anlegen. Das Anlegen eigener Stile wird 

nur erfahrenen Benutzern von MindManager empfohlen. 

So legen Sie auf der Basis einer Map einen benutzerdefinierten Stil an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zu der Map, deren Stileinstellungen Sie als Stil 

sichern möchten. 

2. Klicken Sie in Öffnen. 

3. Formatieren Sie alle Elemente der Map mit der Formatierung, die als Standard für das 

betreffende Element verwendet werden soll. Während Sie die einzelnen Elemente formatieren, 
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speichern Sie die Formatierung für diesen Elementtyp als Standard: Wählen Sie dazu Format > 

Als Standardformat festlegen. Sie können die Standardformatierung für folgende Elemente 

festlegen: 

 Hauptzweige und Unterzweige (nach Ebene, bis zu 4 Ebenen) 

 freie Anmerkungen und Unterzweige (nach Ebene, bis zu 5 Ebenen) 

 Anmerkungen und Unterzweige (nach Ebene, bis zu 5 Ebenen) 

 Umrandungen 

 Verbindungen 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Stil. 

6. Geben Sie den Namen für den Stil ein. Diesem wird automatisch die Erweiterung .mmas 

zugewiesen. 

Um den Stil in der MindManager-Vorlagenvorschau verfügbar zu machen, wird er von 

MindManager automatisch im Standardordner gesichert:  

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Styles 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

So passen Sie einen bestehenden Stil an: 

1. Wählen Sie Ablage > Öffnen, und navigieren Sie zum Stile-Ordner, in der Regel: 

~/Library/Application Support/Mindjet/MindManager/9/{language}/Library/Styles 

  - das Tilde-Zeichen (~) steht für Ihren eigenen Ordner 

  - {language} ist die Sprache Ihrer installierten Version von MindManager (z. B. German) 

2. Wählen Sie den gewünschten Stil, und klicken Sie in Öffnen. 

3. Fügen Sie die Elemente ein, deren Formatierung Sie definieren möchten, formatieren Sie sie 

entsprechend, und wählen Sie für jedes Element Format > Als Standardformat festlegen. (Für 

welche Elemente Sie die Formatierung definieren können, entnehmen Sie der Liste in Schritt 3.) 

4. Wählen Sie Datei > Sichern als. 

5. Wählen Sie in der Liste Dateiformat die Option Mindjet MindManager-Map-Stil. 

6. Geben Sie den Namen für den Stil ein. Diesem wird automatisch die Erweiterung .mmas 

zugewiesen. 

Um den Stil in der MindManager-Stilvorschau verfügbar zu machen, wird er von MindManager 

automatisch im Standardordner für Stile gesichert. 
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Der neue oder bearbeitete Stil ist in der Stilvorschau verfügbar. Sie können diesen Stil an andere 

MindManager-Benutzer verteilen. Wenn er in deren Vorlagenvorschau verfügbar sein soll, müssen 

sie ihn auf ihrem System in den standardmäßigen Ordner für Stile kopieren. 

Sie können Ihren neuen Stil auf jede Map und sogar auf Vorlagen (darunter auch die Standard-Map-

Vorlage für alle neuen Maps) übertragen. 
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SENDEN VON MAPS 

VERSENDEN VON MAPS PER E-MAIL 

Sie können Ihre Maps an Kollegen verteilen, unabhängig davon, ob diese MindManager-Benutzer 

sind, indem Sie die Maps als E-Mail-Anhänge versenden. Die Anhänge können eine Vielzahl von 

Formaten haben.  

Das Verschicken der Map in seinem Ursprungsformat hat den Vorteil, dass alle grafischen Elemente, 

Anhänge und Hyperlinks sowie die Zweignotizen der Map eingeschlossen werden und die Datei ein 

dynamisches Format hat, das von Benutzern sowohl unter Windows als auch Mac OS geöffnet 

werden kann. 

Maps im nativen MindManager-Format lassen sich in MindManager für Windows und MindManager 

für Mac bearbeiten. MindManager-Benutzer, die unter Windows arbeiten, benötigen MindManager 

6.1 oder höher, um in MindManager für Mac erzeugte Maps öffnen zu können. 

Tipps für das Versenden von MindManager-Map-Dateien als E-Mail-Anhänge: 

 MindManager-Map-Dateien haben die Namenserweiterung .mmap. 

 Wenn Sie eine Map-Datei (.mmap) versenden, die Anhänge umfasst (angezeigt in der Map 

durch das Anhangssymbol ), werden die angehängten Dokumente automatisch als 

Bestandteil der Map versendet. 

 Wenn Sie eine Map-Datei (.mmap) mit Hyperlinks zu Dokumenten (angezeigt in der Map 

durch verschiedene Anwendungssymbole, z. B.:  MindManager-Map,  Pages-

Dokument usw.) versenden, ist dies am einfachsten, wenn die Links auf Dokumente an 

einem zentralen Speicherort wie ein Netzwerklaufwerk zeigen, auf den beide Nutzer Zugriff 

haben. Andernfalls müssen Sie die verlinkten Dokumente mit der Map versenden, um die 

Links zu erhalten. Der Empfänger muss diese dann an den richtigen Speicherort in seinem 

System kopieren. 

 Wenn Sie Maps, Grafiken oder Textdateien als E-Mail-Anhänge an Windows-Benutzer 

senden, verwenden Sie die Option zum Senden Windows-freundlicher Anhänge Ihres E-Mail-

Programms. 

MindManager bietet noch weitere Möglichkeiten für die Weitergabe Ihrer Maps: Sie können Maps 

per iChat verschicken oder MindManager Viewer-Maps online stellen. 
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SENDEN EINER MAP PER ICHAT 

Sie können Ihre Map (.mmap) an alle in Ihrer Kontakteliste senden, die gerade online sind, ohne 

MindManager dazu zu verlassen. Dazu müssen Sie bei iChat angemeldet sein. Der Empfänger muss 

Dateien empfangen können und benötigt MindManager für Mac oder Windows, um die Map 

anzeigen zu können.  

So senden Sie eine Map mit iChat: 

1. Sichern Sie die Map. 

2. Wählen Sie Ablage > Freigeben > Über iChat. 

3. Wählen Sie in der Liste der verfügbaren Freunde den Freund, der die Map erhalten soll.  

 Nur Freunde, die Dateien empfangen können, gelten als "verfügbar". 

4. Klicken Sie in Senden. 

MindManager kann die Map auch in eine Vielzahl von Formaten exportieren, die Sie dann mit iChat 

außerhalb von MindManager oder als E-Mail-Anhänge versenden können. 

Darüber hinaus können Sie interaktive Online-Versionen Ihrer Maps erzeugen und dann für andere 

freigeben.  

 

TIPPS FÜR DAS ARBEITEN MIT ANDEREN MINDJET-VERSIONEN 

Nachfolgend finden Sie einige Tipps, wie Sie Maps mit Benutzern von MindManager für Windows, 

Mindjet iPhone und Mindjet iPad austauschen können. 

E M P F A N G E N  V O N  M A P S  V O N  M I N D M A N A G E R  F Ü R  W I N D O W S - B E N U T Z E R N  

Wenn Sie Maps von MindManager Windows-Benutzern erhalten, können diese u. U. 

Formatierungen und Elemente aufweisen, die von MindManager Mac nicht vollständig 

unterstützt werden. Sie können Ihre Kollegen mit der MindManager Windows-Version bitten, 

diese Einstellungen zu vermeiden. In einigen Fällen können Sie die Formatierung der Map in der 

Mac-Version auch anpassen, um das Erscheinungsbild zu verbessern. 

Generell werden die meisten Maps wie in MindManager für Windows dargestellt. 

Kompatibilität der Versionen  

Mit MindManager für Mac können Maps aus MindManager für Windows-Versionen vor 

MindManager X5 nicht geöffnet werden. 

Formateinstellungen  

Mit MindManager für Mac können Maps aus MindManager für Windows-Versionen vor 

MindManager X5 nicht geöffnet werden. 
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 Wenn in den Formatierungseinstellungen der Map die Einstellung "Schatten anzeigen" 

gewählt ist, kann sie in MindManager für Mac nicht deaktiviert werden. 

 Hauptzweige lassen sich nur so eng aneinander setzen, wie dies mit der in der Windows-

Version von MindManager eingestellten Minimalhöhe der Hauptzweige vorgegeben 

wurde. Diese Einstellung lässt sich in MindManager für Mac nicht ändern. 

Smart Map Parts  

Smart Map Parts verlieren ihre dynamische Natur und werden zu statischen Zweigen. Sie 

enthalten die Daten, die zum Zeitpunkt des Sicherns in MindManager für Windows aktuell 

waren. Diese Zweige sind nicht länger mit ihrer Quelle (RSS Feed, Outlook-Elemente usw.) 

verknüpft. 

Tabellen, Diagramme und benutzerdefinierte Eigenschaften  

Daten oder Diagramme werden als Vorschau angezeigt, die aber nicht durchlaufen (um mehr 

Daten anzusehen) oder bearbeitet werden kann. In Maps, die mit MindManager-Versionen 

vor MindManager 6 Windows SP1 angelegt wurden, wird nur eine Vorschau mit der Meldung 

"Diagramm fehlt" angezeigt. 

Bilder  

In MindManager für Mac können alle Bilder, die in Maps aus MindManager 6 Windows SP1 

und höher enthalten sind, angezeigt werden. (Windows-Benutzern wird empfohlen, vor dem 

Speichern in den Eigenschaften die Einstellung "Maps plattformübergreifend kompatibel 

speichern" zu aktivieren.) Für Bilder in Maps, die mit MindManager-Versionen vor SP1 

gesichert wurden, wird u. U. nur eine Vorschau mit der Meldung "Bild fehlt" angezeigt, wenn 

sie aus einer Datei mit Windows-spezifischem Format (z. B. WMF oder EMF) hinzugefügt 

wurden. 

Hyperlinks  

Hyperlinks zu Ordnern und Dateien werden deaktiviert. 

Freihandeingabe  

Freihandeingaben werden von MindManager für Mac nicht unterstützt. Zweige, die in 

MindManager für Windows per Freihandeingabe eingegeben wurden, werden in 

MindManager für Mac als kleine leere Zweige angezeigt. Diese Zweige können gelöscht, aber 

nicht bearbeitet werden. 

Schrift  

Unterschiede im Schriftformat zwischen beiden Plattformen führen u. U. dazu, dass der Text 

leicht verzogen dargestellt wird. 

Outlook-Termine und Outlook-Aufgaben  

Diese Elemente können wie Kalender-Ereignisse und -Aufgaben bearbeitet werden, sind aber 

über "Darstellung" > "Kalender-Element" in iCal nicht aufrufbar. 
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Hinweis: Diese Elemente können Sie während der Bearbeitung in Ihren iCal-Kalender 

übernehmen. 

Datenbankzweige  

Diese Zweige enthalten Daten, lassen sich aber nicht bearbeiten. 

S E N D E N  V O N  M A P S  A N  M I N D M A N A G E R  F Ü R  W I N D O W S - B E N U T Z E R  

In der MindManager für Windows-Version werden Maps, die in MindManager für Mac erstellt 

wurden, generell unverändert dargestellt. 

Kompatibilität der Versionen  

In MindManager für Windows-Versionen vor MindManager X5 können Maps, die in 

MindManager für Mac angelegt wurden, nicht geöffnet werden. 

In MindManager X5 und MindManager 6 SP0 können Maps aus MindManager für Mac mit 

einer Ausnahme (siehe "Bilder") geöffnet werden. 

Hinweis: Einige Formatierungsoptionen wie Nummerierung und einzelne Unterzweig-Layouts 

werden von MindManager X5 nicht unterstützt. 

Bilder  

Die meisten Bilder in Maps aus MindManager für Mac werden in MindManager 6 SP1 Windows 

und höher problemlos angezeigt. Für Bilder aus der Bibliothek werden in MindManager die 

Äquivalente aus der Bibliothek der Windows-Version angezeigt. Grafiken in PDF-, Photoshop-, 

SGI- und TIFF-Format werden in einem anderen Format angezeigt. Grafiken in JPEG-2000-, PICT- 

und TGA-Formaten werden nicht angezeigt.  

Achtung: In MindManager X5 und MindManager 6 SP0 Windows können keine Bilder in nicht 

unterstützten Formaten dargestellt werden. Wenn Sie versuchen, eine Map mit solchen Bildern 

zu öffnen, kann das Problem unerwartet geschlossen werden. Nicht unterstützt werden Bilder 

aus der MindManager für Mac-Bibliothek (PDF-Format) sowie aus Dateien in JPEG-2000-, PDF-, 

PICT-, Photoshop- (.psd), SGI-, TGA-Format sowie allen anderen Formaten, die in den Windows-

Versionen von MindManager nicht als Bilder hinzugefügt werden können. 

Schrift  

Unterschiede im Schriftformat zwischen beiden Plattformen führen u. U. dazu, dass der Text 

leicht verzogen dargestellt wird. 

Hyperlinks  

Hyperlinks zu Ordnern und Dateien sowie Inline-Hyperlinks (im Zweigtext) werden deaktiviert. 

Kalender-Ereignisse, -Aufgaben und intelligente Kalender-Zweige  

Diese Elemente werden angezeigt, können aber nicht bearbeitet werden. 
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V E R W E N D E N  V O N  M A P S  A U S  M I N D J E T  I P H O N E  U N D  M I N D J E T  I P A D  I N  
M I N D M A N A G E R  F Ü R  M A C  

Übertragen Sie Map-Dateien im .mmap- oder .xmmap-Format von Mindjet iPhone bzw. Mindjet 

iPad per E-Mail, WiFi oder Dropbox-Transfer auf Ihren Mac. Dann öffnen Sie die Datei mit 

MindManager für Mac. 

Maps werden mit der standardmäßigen Mindjet iPhone / iPad-Formatierung angezeigt. Dies 

können Sie durch Zuweisen eines Stils zur Map ändern. 

V E R W E N D E N  V O N  M A P S  A U S  M I N D M A N A G E R  F Ü R  M A C  I N  M I N D J E T  I P H O N E  U N D  
M I N D J E T  I P A D  

Maps können Sie wie andere Dateien von Ihrem Mac auf Ihr iPhone oder iPad übertragen. Maps, 

die im nativen .mmap- oder .xmmap-Format gesichert wurden, können in Mindjet iPhone oder 

Mindjet iPad geöffnet werden. 

Folgende Objekte werden von Mindjet iPhone / iPad nicht unterstützt und aus der Map entfernt: 

 Formatierung 

 Bilder 

 Verbindungen 

 Umrandungen 

 Tags 

 Ressourcen 

 Anhänge 

 Beschriftungen 

 Lesezeichen 

 Anmerkungen 

 Kalender-Elemente 

Die folgenden Objekte werden von Mindjet iPhone bzw. Mindjet iPad zum Teil unterstützt: 

 Freie Anmerkungen: Sie werden zu regulären Zweigen mit einer anderen Farbe. 

 Icons: Einige Icons werden angezeigt (darunter Prioritäts-Icons), unterscheiden sich aber 

von MindManager-Icons. 

 Hyperlinks: Nur URL-Hyperlinks werden unterstützt. 

 Aufgabeninfo: Nur Markierungen des Typs Priorität werden unterstützt; sonstige 

Aufgabeninformationen werden entfernt. 

 



Sichern und Freigeben Ihrer Maps 

97 

FREIGABE INTERAKTIVER MAPS 

ONLINE-FREIGABE VON MAPS 

Einzelne Maps können Sie für jeden freigeben – durch Veröffentlichung oder Verteilung eines Links 

zu einer eigenständigen, interaktiven Viewer-Map. 

Wenn Sie eine Map freigeben, wird in Ihrer Online-Ablage eine Kopie der Map angelegt. 

Anschließend werden Sie durch die Schritte zur Veröffentlichung oder Verteilung eines Links zu der 

freigegebenen Map geführt. Wenn jemand in den Link klickt, zeigt er die Map in seinem Browser an. 

Zur Anzeige bzw. Interaktion mit den von Ihnen freigegebenen Maps benötigt er nicht MindManager. 

Jeder, der die Map anzeigt, kann sie mit Hilfe der Befehle in der Symbolleiste der freigegebenen Map 

wieder für andere freigeben. 

Freigegebene Maps lassen sich nicht direkt bearbeiten. Andere Mindjet-Nutzer können jedoch unter 

Verwendung eines der Befehle in der Symbolleiste der freigegebenen Map eine bearbeitbare Kopie 

der Map anlegen. 

H I N W E I S :  Einige Map-Elemente werden in Viewer-Dateien nicht unterstützt. 

So geben Sie eine Map frei: 

1. Wählen Sie Ablage > Freigeben > Zu freigegebenen Dokumenten hochladen. 

 Sie werden aufgefordert, sich mit Ihrer Mindjet-ID beim Mindjet-Onlinedienst anzumelden 

(sofern Sie nicht bereits angemeldet sind). Wenn Sie über keine Mindjet-ID verfügen, 

werden Sie aufgefordert, eine zu erzeugen. 

2. Sie werden durch die Schritte für die Freigabe Ihrer Map per E-Mail, Instant Messaging oder 

Veröffentlichung eines Links zu der Map auf der Networking-Site geführt. 

Wenn Sie das Freigeben abgeschlossen haben, können Sie sich beim Mindjet-Onlinedienst abmelden 

(dazu klicken Sie in Ablage > Freigeben > Abmelden). Sie können aber auch angemeldet bleiben, 

wenn Sie eine weitere Map freigeben möchten. 

Jeder, der Zugriff auf diesen Link hat, kann in ihn klicken und so die freigegebene Map in einem flash-

fähigen Webbrowser anzeigen und einen Teil der Map-Funktionen nutzen. Dazu wird keine 

zusätzliche Software benötigt. Die Map wird im Viewer angezeigt. Dieser enthält Befehle für die 

weitere Freigabe der Map und das Kopieren (sofern die Kopierrechte aktiviert sind) bzw. 

Herunterladen der Map. 

Ihre freigegebenen Inhalte können Sie verwalten, um zu sehen, welche Maps Sie freigegeben haben, 

das Kopierrecht für eine Map zu ändern, die Map für weitere Benutzer freizugeben, eine Kopie der 

Map herunterzuladen oder eine Map aus der Liste zu löschen, um die Freigabe für sie aufzuheben. 

Für das Verteilen von Maps an andere haben Sie noch mehrere weitere Möglichkeiten.  
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VERWALTEN VON FREIGEGEBENEN MAPS 

„Freigegebene Inhalte“ enthält Kopien aller Maps, die Sie online freigegeben haben. 

Ihre freigegebenen Inhalte können Sie verwalten, um zu sehen, welche Maps Sie freigegeben haben, 

das Kopierrecht für eine Map zu ändern, die Map für weitere Benutzer freizugeben, eine Kopie der 

Map herunterzuladen oder eine Map aus der Liste zu löschen, um die Freigabe für sie aufzuheben. 

So zeigen Sie Ihre freigegebenen Maps an und verwalten diese: 

1. Wählen Sie Ablage > Freigeben > Freigegebene Dokumente verwalten. 

2. Verwalten Sie Ihren Inhalt mit Hilfe der Einstellungen auf der Seite Freigegebene Inhalte. 

Name des freigegebenen 

Elements 

Klicken Sie auf den Namen der Map, um sie im Viewer 

anzuzeigen (so wie andere sie sehen). 

Datum der Veröffentlichung Gibt an, wann Ihre Map freigegeben wurde. Dieses Datum 

ändert sich nicht, wenn Sie die Map erneut freigeben. 

Kopien zulässig Diese Option können Sie aktivieren, wenn die Benutzer, die die 

Map anzeigen, sie in ihren Mindjet-Online-Arbeitsbereich 

kopieren oder eine lokale Kopie herunterladen dürfen sollen. 

Freigeben Klicken Sie in , um eine Map, die bereits freigegeben war, 

erneut freizugeben (um den Link an einer neuen Stelle ablegen 

oder an weitere Benutzer senden). 

Download Klicken Sie in , um eine Kopie der Map (in nativem .mmap-

Format) auf Ihr lokales System herunterzuladen. Mit dieser Map 

können Sie in MindManager für Windows und MindManager 

für Mac arbeiten. 

Löschen Klicken Sie in , um die Map aus der Liste mit freigegebenen 

Inhalten zu entfernen. Die Map ist dann nicht mehr verfügbar. 

Wenn Sie die Map bereits freigegeben haben und ein anderer 

Benutzer in den Link klickt, um die Map anzuzeigen, wird die 

Meldung "Datei nicht gefunden" angezeigt. 

Durch Klicken in die Spaltenüberschriften können Sie die Liste mit den freigegebenen Maps 

sortieren. 
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IN VIEWER-DATEIEN NICHT UNTERSTÜTZTE MAP-ELEMENTE 

In exportierten bzw. freigegebenen Viewer-Maps werden folgende Elemente nicht unterstützt: 

Map-
Markierungen 

Alle Markierungen Markierungsgruppen ignoriert  

Zweigelemente Anhänge   ignoriert 

  Notizen Bilder Notizen nicht 
angezeigt 

    Tabellen Notizen nicht 
angezeigt  

    Hervorhebung Notizen nicht 
angezeigt  

    Einrückungen ignoriert 

    Hyperlink zu lokalem Dokument  ignoriert 

    Hyperlink zu Zweig in aktueller Map ignoriert 

  Bilder außer PNG, GIF und JPG Platzhalter 

  Lesezeichen   ignoriert 

 Beschriftungen   ignoriert 

Zweige Form und Farbe Transparenz des Hauptthemas ignoriert – 
intransparente Farbe 

  Format und Ränder Ränder & Abstand ignoriert 

  Layout Unterzweige Linienanker ignoriert 

    Abstand zwischen Nebenzweigen  ignoriert 

    Abstand von Oberzweig ignoriert 

    Abstand ignoriert 

  Format Großschreibung ignoriert 

    Linienbreite für Hauptzweige ignoriert 

    Organisches Aussehen ignoriert 

    Nummerierung ignoriert 

Objekte Verbindungsform Gekrümmt Bezier 

  Umrandungsform Wolken, Wellen, Zickzack gerade 

    Abgerundetes Rechteck Rechteck 

Layout Hauptzweig-
Anschlusspunkt 

  ignoriert 
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EXPORTIEREN UND DRUCKEN VON MAPS 

EXPORTIEREN VON DATEIEN 

Sie können Ihre Map in eine Vielzahl von Formaten exportieren. Einige der Formate sind nur 

verfügbar, wenn Ihre Map Folien enthält. 

E X P O R T  I N   

Ein Pages- oder Word-Dokument mit Ihrem Map-Inhalt in Gliederungsform: 

Exportieren einer Map in ein Pages- oder Word-Dokument  

Eine Keynote- oder Powerpoint-Präsentation unter Verwendung der Folien in der Map: 

Exportieren von Folien in eine Keynote- oder PowerPoint-Präsentation 

Eine PDF-Datei mit nur einer Seite mit einem Abbild der aktuellen Ansicht der Map 

Eine interaktive, schreibgeschützte PDF-Viewer-Datei. 

Exportieren einer Map in eine PDF-Datei 

Ein Abbild der kompletten Map im Format JPEG, PNG oder TIFF. 

Mehrere JPEG-, PNG- oder TIFF-Dateien unter Verwendung der einzelnen Folien in der Map als 

separates Bild. 

Exportieren einer Map oder Folien in ein Bildformat 

Eine HTML-Datei mit einem Bild oder Textgliederung der Map. 

Eine SWF-Datei mit der kompletten Map als schreibgeschützte, interaktive Viewer-Datei. 

Exportieren einer Map in eine Webdatei 

Eine Textdatei in Text-, RTF-, RTFD- oder OPML-Format. 

Exportieren einer Map in eine Textdatei 

EXPORTIEREN VON MAP-INHALT ALS TEXT 

Sie können Ihre Map in RTF und Textformate exportieren, die von anderen Anwendungen wie Pages 

und anderen Textverarbeitungsprogrammen sowie TextEdit und anderen Texteditoren gelesen 

werden können. Die Map wird als Liste mit Zweigen exportiert. Freie Anmerkungen, Zweignotizen 

und Anmerkungen sind inbegriffen. Hyperlinks, Anhänge, Verbindungen, Icons und Zweiggrafiken 

werden nicht mit exportiert. Beim Export in reinen Text entfallen die Schriftart und -farbe. 
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So exportieren Sie Ihren Map-Inhalt als Text: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register Text/Gliederung. 

3. Wählen Sie das gewünschte Exportformat, und klicken Sie dann in Weiter. 

 Beim Export von Text wird nur der Map-Text einbezogen. Es gibt jedoch die Möglichkeit, 

Zeilenumbrüche einzufügen, um die Struktur der Map zu verdeutlichen. Die erzeugten 

Dateien können Sie mit einem Texteditor wie TextEdit öffnen. 

 Beim Export als RTF (Rich Text Format) wird der Großteil der Formatierung mitexportiert. 

Grafikdaten wie Icons oder Bilder bleiben jedoch ausgenommen. Diese Dateien können Sie 

mit den meisten Textverarbeitungsprogrammen wie Pages und Word öffnen. 

 Der Export als RTFD (Rich Text Formatting with Attachments) ist identisch mit dem RTF-

Export. Bilder in Zweignotizen werden hier jedoch ebenfalls exportiert (Zweigbilder nicht). 

 Beim Export in OPML (Outline Processor Markup Language) wird gegliederter Text ohne 

Formatierung und grafische Daten exportiert. Diese Dateien können Sie mit OPML-fähigen 

Anwendungen öffnen. 

4. Geben Sie den Namen für die neue Datei ein, und wählen Sie ihren Speicherort. Klicken Sie dann 

in Exportieren. 

MindManager kann Ihre Map auch in eine Vielzahl anderer Dateitypen exportieren und importieren.  

 

EXPORTIEREN EINER MAP IN EIN PAGES- ODER WORD-DOKUMENT 

Sie können ein neues Pages- oder Word-Dokument erzeugen, indem Sie Ihre Map exportieren. Das 

neue Dokument enthält den Inhalt der Map als Gliederung. Mit Hilfe der Exportoptionen können Sie 

festlegen, welche Map-Elemente in das Dokument aufgenommen werden sollen. Zudem lassen sich 

die Formatierung und die Stile definieren. 

Sie exportieren Sie Ihre Map in ein Pages- oder Word-Dokument: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register iWork/Office. 

3. Wählen Sie Pages oder Word als Dateityp, und klicken Sie dann in Weiter. 

4. Wählen Sie in den drei Registern die für das Erzeugen der exportierten Datei zu verwendenden 

Optionen, und klicken Sie dann in Weiter. 

5. Geben Sie den Namen für das neue Dokument ein, und wählen Sie seinen Speicherort. Klicken 

Sie dann in Exportieren. 

MindManager kann Ihre Map auch in eine Vielzahl anderer Formate exportieren und importieren.  
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OPTIONEN FÜR DAS EXPORTIEREN EINER MAP IN EIN PAGES- ODER WORD-DOKUMENT 

Mit diesen Optionen können Sie den Export in Pages oder Word konfigurieren. 

Inhalt des Dokuments 

Map-Elemente  

Hier wählen Sie die Elemente, die Sie einbeziehen möchten. 

 Icons: Werden zu Bildern. 

 Zweignotizen: Werden zu einem normalen Textabsatz. 

 Anmerkungen: Werden unter der Zweigüberschrift als Tabelle eingefügt. 

 Tags: Werden unter der Zweigüberschrift als Tabelle eingefügt. 

 Leere Zweige ignorieren: Es werden nur Zweige mit Inhalt (Notizen, Aufgaben und 

Korrekturkommentare) exportiert. 

Aufgabenattribute  

Hier wählen Sie die Elemente, die Sie einbeziehen möchten. Aufgabenattribute werden in das 

exportierte Dokument als Tabelle unter der Zweigüberschrift aufgenommen. 

Verknüpfungen und Anhänge  

Hier wählen Sie die Elemente, die Sie einbeziehen möchten. 

 Zweig-Hyperlinks: Legen Sie fest, ob Zweig-Hyperlinks (Links zu Zweigen in derselben Map) 

und Verbindungen exportiert werden sollen. Diese werden im Dokument zu einem Link zum 

verknüpften Zweig. Sie können ein Präfix zur Verwendung für die Links eingeben. 

 Anhänge - Zweiganhänge exportieren: Wenn diese Option aktiviert ist, werden aus den 

Anhängen einzelne Dateien erzeugt. Diese werden im selben Verzeichnis wie das exportierte 

Word-Dokument abgelegt. Hyperlinks zu diesen Dateien werden an den entsprechenden 

Stellen im Dokument eingefügt. 

 Verknüpfte Dokumente: Legen Sie fest, ob Hyperlinks zu externen Dokumenten oder 

Speicherorten exportiert werden sollen, und welches Präfix für sie zu verwenden ist. Diese 

werden im Word-Dokument zu Hyperlinks. 

 Name der Verbindung: Legen Sie fest, ob dasselbe Präfix, das für Zweig-Hyperlinks 

verwendet werden soll, auch für Links verwendet werden soll, die von Verbindungen erzeugt 

wurden. 

Format 

Inhalt 
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 Übersichts-Map exportieren: Wird als Bild am oberen Rand des Dokuments eingefügt.  

 Inhaltsverzeichnis einfügen: Fügt am Anfang des Dokuments unter der Überblicks-Map 

(sofern enthalten) Zweige und Seitennummern ein. 

Nummerierung  

Hier wählen Sie ein Nummerierungsschema oder "Keine Nummerierung". 

Grafiken  

Hier legen Sie die maximale Breite für Grafiken beim Export fest (einschließlich der Überblicks-

Map, sofern Sie diese ausgewählt haben). 

Kopf- und Fußzeile  

Hier geben Sie den zu verwendenden Text ein. 

Dokumentstile 

Für jede Zweigebene werden neue Stile erzeugt. Hier können Sie die Namen für diese Stile 

eingeben. 

EXPORTIEREN VON FOLIEN IN EINE KEYNOTE- ODER POWERPOINT-PRÄSENTATION 

Durch Exportieren Ihrer Map können Sie eine neue Keynote- bzw. PowerPoint-Präsentation 

erzeugen. Die neue Präsentation enthält für jede Folie in Ihrer Map eine Präsentationsfolie. Mit Hilfe 

der Exportoptionen können Sie festlegen, welche Map-Elemente in die Präsentation aufgenommen 

werden sollen. Zudem lassen sich einige grundlegende Aspekte der Formatierung und des Layouts 

definieren. 

So exportieren Sie Folien in eine Keynote- oder PowerPoint-Präsentation: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register iWork/Office. 

3. Wählen Sie Keynote oder PowerPoint als Dateityp, und klicken Sie dann in Weiter. 

H I N W E I S : Wenn Ihre Map keine Folien enthält, sind diese Optionen nicht verfügbar. 

4. Wählen Sie die für das Erzeugen der exportierten Datei zu verwendenden Optionen, und klicken 

Sie dann in Weiter. 

5. Geben Sie den Namen für die neue Präsentation ein, und wählen Sie ihren Speicherort. Klicken 

Sie dann in Exportieren. 

MindManager kann Ihre Map auch in eine Vielzahl anderer Formate exportieren und importieren.  
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OPTIONEN FÜR DAS EXPORTIEREN VON FOLIEN IN EINE KEYNOTE- ODER POWERPOINT-PRÄSENTATION 

Mit diesen Optionen können Sie den Export in Keynote oder PowerPoint konfigurieren. 

Zweigformatierung 

 Zweigtiefe: Legen Sie fest, wie viele Zweigebenen auf jeder Folie enthalten sein sollen. 

 Zweigverknüpfungen anzeigen: Bewirkt, dass Hyperlinks in die Folien übernommen werden. 

Die Links sind aktiv, wenn die Präsentation im Präsentationsmodus angezeigt wird. In der 

Vorschau funktionieren sie nicht. Hyperlinks werden nicht in Folien exportiert, auf denen 

Zweige als Objekte angezeigt werden. 

 Zweige als Objekte anzeigen: Bewirkt, dass jeder Zweig als gesondertes Objekt auf die Folie 

übernommen wird, anstatt Folien mit Listen zu erzeugen. 

Map-Inhalt 

 Zweignotizen als Sprechernotizen verwenden: Etwaige Zweignotizen werden in der 

Präsentationsdatei in das Feld für die Sprechernotizen übernommen. 

 Anmerkungen anzeigen: Anmerkungen werden als Notizen in die Folien übernommen und 

mit der festgelegten Hintergrundfarbe unterlegt. 

 Fußzeilentext einfügen: Übernimmt die eingegebene Fußzeile für jede Folie. Von einzelnen 

Folien in der Präsentation können die Fußzeilen entfernt werden. 

Stil 

 Bildränder anzeigen: Fügt dem Bild der Folie einen Rand hinzu. 

 Folienzahl anzeigen: Wenn diese Option aktiviert ist, wird in der Präsentation auf jeder Folie 

die Foliennummer angezeigt. 

 Zeilenumbrüche von Text und Notizen entfernen: Setzt die Zeilenumbrüche für Zweigtext 

und Notizen so, dass der Text auf die Folie passt. Die ursprünglichen Zeilenumbrüche aus der 

Map werden verworfen. 

EXPORTIEREN EINER MAP IN EINE PDF-DATEI 

Sie können Ihre aktuelle Map oder Folien in zwei Formen ins PDF-Format exportieren: 

 Die gesamte Map als statisches Abbild der Map. 

 Die gesamte Map als schreibgeschützte, interaktive Viewer-Datei im PDF-Format. 

Für die Umwandlung Ihrer Map in eine Viewer-Datei nutzt MindManager einen Online-Dienst. Daher 

benötigen Sie für den Export Ihrer Map in dieses Format eine Internetverbindung. Ihre Map wird 

sicher an einen Server übermittelt, umgewandelt und dann zurück auf Ihr System geschickt. 
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So exportieren Sie Ihre Map ins PDF-Format: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register PDF. 

3. Wählen Sie das gewünschte Exportformat, und klicken Sie dann in Weiter. 

4. Geben Sie den Namen für die neue Datei ein, und wählen Sie ihren Speicherort. Klicken Sie dann 

in Exportieren. 

H I N W E I S :  

Einige Map-Elemente in Viewer-Dateien werden nicht unterstützt.  

Diese Dateien können nur in Adobe Acrobat oder Adobe Reader angezeigt werden (der PDF-Reader 

muss eingebettete Flash-Dateien unterstützen). 

Sie können Ihre exportierten PDF-Dateien online stellen oder als E-Mail-Anhänge verteilen. 

MindManager bietet noch weitere Möglichkeiten für die Weitergabe Ihrer Maps: Sie können Sie in 

eine Vielzahl weiterer Formate exportieren, per E-Mail oder iChat verschicken oder als Viewer-Maps 

online stellen.  

 

EXPORTIEREN EINER MAP ALS WEBDATEI 

Sie können Ihre aktuelle Map in zwei Formaten als Webdatei exportieren: 

 Als HTML-Datei, die den Map-Text enthält, wahlweise als Gliederung formatiert. 

 Als schreibgeschützte interaktive Viewer-Datei im Flash-Format (SWF). 

Für die Umwandlung Ihrer Map in eine Viewer-Datei nutzt MindManager einen Online-Dienst. Daher 

benötigen Sie für den Export Ihrer Map in dieses Format eine Internetverbindung. Ihre Map wird 

sicher an einen Server übermittelt, umgewandelt und dann zurück auf Ihr System geschickt. 

So exportieren Sie Ihre Map als Webdatei: 

1. Wählen Sie Datei > Exportieren. 

2. Klicken Sie im Fenster Export in das Register Web. 

3. Wählen Sie das gewünschte Exportformat, und klicken Sie dann in Weiter. 

4. Geben Sie den Namen für die neue Datei ein, und wählen Sie ihren Speicherort. Klicken Sie dann 

in Exportieren. 

H I N W E I S :  Einige Map-Elemente in Viewer-Dateien werden nicht unterstützt. Diese Dateien können 

in einem Flash-fähigen Browser angezeigt werden. 

Sie können Ihre exportierten Dateien online stellen oder als E-Mail-Anhänge verteilen. MindManager 

bietet noch weitere Möglichkeiten für die Weitergabe Ihrer Maps: Sie können Sie in eine Vielzahl 
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weiterer Formate exportieren, per E-Mail oder iChat verschicken oder als Viewer-Maps online 

stellen.  

 

EXPORTIEREN EINER MAP ODER FOLIEN IN EIN BILDFORMAT 

Sie können Ihre Map in eine Grafikdatei verschiedenen Formats exportieren. Diese lässt sich dann in 

andere Anwendungen importieren. Wenn Ihre Map Folien enthält, können Sie jede Folie als 

separates Bild exportieren. 

So exportieren Sie eine Map oder Folien in ein Bildformat: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register Bild. 

3. Wählen Sie ein Bildformat, und klicken Sie in Weiter. 

4. Wählen Sie ein Bildformat. 

5. Wenn Ihre Map Folien enthält, können Sie jede Folie als separates Bild exportieren. 

6. Klicken Sie in Weiter. 

7. Wählen Sie den Namen und den Speicherort für die Bilder, und klicken Sie in Exportieren. 

 Wenn Sie sich für den Export separater Bilder für Folien entschieden haben, werden die 

exportierten Dateien in der Reihenfolge des Exportes benannt: my_image1.png, 

my_image2.png ... usw. 

Wenn Sie die gesamte Map als einzelnes Bild exportieren, wird die aktuelle Größe der Map 

verwendet. Zum Erhöhen oder Verringern der Größe der Map und des exportierten Bildes wählen Sie 

Darstellung > Zoom. Folien werden mit der Positionierung und Skalierung des Inhalts exportiert, die 

Sie für jede Folie festgelegt haben. 

MindManager kann Ihre Map auch in eine Vielzahl anderer Formate exportieren. 

 

DRUCKEN EINER MAP ODER FOLIEN 

Wenn Sie Ihre Map ausdrucken, wird sie wie in der Map- oder Gliederungsansicht dargestellt 

gedruckt. Wenn Ihre Map Folien enthält, können Sie angeben, um diese zu drucken.. 

So drucken Sie eine Map oder Folien: 

1. Wählen Sie Ablage > Drucken. 

2. Wählen Sie im Dropdown-Menü Drucker des Dialogs Drucken den gewünschten Drucker. 
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3. Klicken Sie in das Disclosure-Triangle neben dem Feld Drucker, um ein Liste mit allen 

verfügbaren Optionen anzuzeigen. 

4. Wählen Sie unter Drucken die Option Map oder Folien, und wählen Sie dann die gewünschten 

Druckoptionen. 

5. Klicken Sie in Drucken. 

Die Map oder Folien werden wie angezeigt ausgedruckt. Weitere Informationen zum Verwenden der 

Druckoptionen finden Sie in den nachstehenden Tipps.  

T I P P S :  

 Zum Ändern der Ausrichtung und der Ränder für die gedruckte Map wählen Sie Ablage > 

Papierformat. Zum Einstellen der Ränder wählen Sie MindManager aus dem Einblendmenü 

Einstellungen aus. Wählen Sie Map automatisch ausrichten, damit MindManager die beste 

Ausrichtung für Ihre Map festlegen kann. 

 Im Vorschaubereich des Dialogs Drucken können Sie die Anzahl der zu verwendenden Seiten 

festlegen: Auf diese Weise können Sie eine große Map so verkleinern, dass sie auf einer 

einzelnen Seite gedruckt wird, oder eine kleine Map so vergrößern, dass Sie auf mehreren Seiten 

gedruckt wird. 

 Wenn Sie den Map-Hintergrund nicht mit ausdrucken, erfolgt das Drucken schneller und unter 

geringerem Tintenverbrauch. Wenn der Hintergrund nicht gedruckt werden soll, deaktivieren Sie 

diese Option.  

 Zum Einbinden einer Kopf- und Fußzeile in Ihrer gedruckten Map wählen Sie Format > Kopfzeile 

und Fußzeile. Geben Sie den Text für die Kopf- und Fußzeile so ein, wie er in der Map erscheinen 

soll. Sie können Ihren eigenen Text mit Elementen verbinden, die in der Liste Einfügen zur 

Verfügung stehen. 

 Wenn nur die Zweignotizen der gegenwärtig ausgewählten Zweige gedruckt werden sollen, 

wählen Sie Ablage > Notizen drucken. 

Neben dem Ausdrucken gibt es noch andere Möglichkeiten, Maps weiterzuleiten: Sie können die 

Map in verschiedenen Formaten exportieren und dann per E-Mail weiterleiten oder in einer anderen 

Anwendung öffnen bzw. eine Map per iChat versenden. 
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ERSTELLEN EINER PRÄSENTATION 

ERZEUGEN VON FOLIEN 

Sie können Folien erzeugen, die verschiedene relevante Bereiche in der Map hervorheben. Die Folien 

werden Bestandteil der Map-Datei und können in einer MindManager-Präsentation angezeigt, als 

Keynote- oder PowerPoint-Präsentation bzw. in beide Formate exportiert oder ausgedruckt werden.  

Erstellen und verwalten können Sie Ihre Folien mit der gleichnamigen Seitenleiste. Folien können 

sich überlagern. Das heißt, dass Inhalt auf mehreren Folien auftauchen kann. 

H I N W E I S :  Für den Export in einige Formate, z. B. Keynote- oder PowerPoint-Präsentationen, muss 

Ihre Map Folien enthalten. 

So erzeugen Sie Folien: 

1. Blenden Sie die Seitenleiste Folien ein.  

 Wählen Sie Darstellung > Folien einblenden, bzw. klicken Sie in der Symbolleiste in Folien. 

Die Seitenleiste Folien erscheint. 

2. Erzeugen und verwalten Sie Ihre Folien wie gewünscht. 

Zum Hinzufügen einer Folie führen Sie folgende Schritte aus: 

 Klicken Sie bei gedrückter Control-Taste in einen Zweig in der Map, und klicken Sie dann im 

Kontextmenü in Neue Folie von Zweig. 

 Markieren Sie einen Zweig in der Map, und klicken Sie dann in das Symbol Neue Folie ( + ) 

um unteren Rand der gleichnamigen Seitenleiste. 

Zur Anzeige einer Folie im Hauptfenster der Folienansicht klicken Sie in das Folien-Miniaturbild in 

der Seitenleiste Folien. Wenn wieder die gesamte Map angezeigt werden soll, klicken Sie in 

Zurück in Mapansicht (links oben im Fenster der Folienansicht). 

Zum Entfernen einer Folie wählen Sie in der Seitenleiste ihr Miniaturbild. Dann drücken Sie die 

Löschen-Taste oder klicken bei gedrückter Control-Taste in das Miniaturbild und dann im 

Kontextmenü in Löschen.  

Zum Neuanordnen der Folien ziehen Sie die Miniaturbilder in die Seitenleiste. So ändern Sie 

deren Reihenfolge. Die Folien erscheinen in der Präsentation bzw. in einem mehrseitigen 

Dokument in der hier gezeigten Reihenfolge. 

Zum Ausschneiden, Kopieren, Einsetzen oder Duplizieren von Folien klicken Sie bei gedrückter 

Control-Taste in das Miniaturbild der Folie. Dann wählen Sie den entsprechenden Befehl im 

Kontextmenü Folie. 
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Zum Auswählen einer Folie, die mit einem bestimmten Map-Zweig verknüpft ist, klicken Sie in 

das Folien-Icon  am Zweig. Wenn der Zweig über mehr als eine Folie verfügt, wählen Sie die 

gewünschte Folie im Popup-Menü.  

3. Passen Sie den Inhalt der Folie an.  

Wenn Sie im Fenster der Folienansicht eine Folie anzeigen, können Sie die einzelnen Folien so 

anpassen, dass sie jeweils die gewünschte Detailebene anzeigen. Diese Einstellung hat keinen 

Einfluss auf die zugrunde liegende Map oder andere Folien: 

Erweitern oder reduzieren Sie Zweige, um für jeden Zweig auf der Folie die gewünschte 

Detailebene anzuzeigen. 

H I N W E I S :  Wenn Sie in der Folienansicht den Inhalt einer Folie bearbeiten, wirken sich diese 

Änderungen auf die zugrunde liegende Map aus. Alle Änderungen, die Sie auf der Folie am Inhalt 

oder der Formatierung vornehmen, werden also in die zugrunde liegende Map und alle Folien 

übernommen, die auf denselben Zweigen basieren. 

Der Folieninhalt spiegelt immer den aktuellen Status der Map wider. Das heißt, dass sich der Inhalt 

ändert, wenn Zweige bearbeitet oder formatiert werden oder Sie einen Filter anwenden, der sich auf 

die Zweige auf der Folie auswirkt, oder wenn Sie festlegen, dass eine bestimmte Kategorie von Map-

Elementen ein- oder ausgeblendet wird.  

T I P P :  Wenn Sie häufig Folien erzeugen, können Sie die Symbolleiste anpassen und um ein Symbol 

zum Erzeugen neuer Folien ergänzen. 

 

ANZEIGEN EINER DIASHOW 

Wenn Sie Folien erzeugt haben, können Sie diese in MindManager als Diashow anzeigen. Sie können 

die Art und Geschwindigkeit des Übergangs zur nächsten Folie, bzw. die auf Folien ein- bzw. 

auszublendenden Elemente festlegen.  

Während der Diashow können Sie zur Steuerung die Steuerelemente auf dem Bildschirm, die 

Tastatur, Gesten oder eine Apple-Fernbedienung verwenden.  

So legen Sie die Diashow-Optionen fest: 

1. Wählen Sie eine der folgenden Verfahrensweisen: 

 Wählen Sie Darstellung > Optionen für Diashow. 

 Öffnen Sie die Folien-Seitenleiste am unteren Rand der Seitenleiste, und klicken Sie in 

Optionen. 

2. Auf dem Register Allgemeine Optionen: 

 Wählen Sie den Übergangsstil und die Übergangsgeschwindigkeit. 
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 Klicken Sie in Vorschau, um ein Beispiel für die Übergänge zwischen den Folien in der 

Diashow zu sehen. 

3. Wählen Sie unter dem Register Einblenden & Ausblenden die Elemente, die auf Ihren Folien 

auftauchen sollen. Nicht ausgewählte Elemente werden ausgeblendet. 

H I N W E I S :  Die hier gewählten Optionen bestimmen, welche Elemente in der zugrunde liegenden 

Map angezeigt werden. 

4. Klicken Sie in Fertig. 

So starten Sie die Diashow: 

 Klicken Sie am unteren Rand der Folien-Seitenleiste auf Vorführen. 

Die Diashow beginnt mit der gerade ausgewählten Folie. 

So verwenden Sie während der Diashow die Steuerelemente auf dem Bildschirm: 

Setzen Sie den Cursor in das Fenster, um die Bildschirm-Steuerelemente am oberen und unteren 

Rand des Fensters zu verwenden. 

Zeigen Sie in den unteren Bereich des Fensters, um die Steuerelemente für die Vorführung 

einzublenden: 

 Klicken Sie in die Pfeile, um jeweils von einer Folie zur nächsten zu springen. 

 Klicken Sie auf das Laser-Pointer-Symbol, wenn zur besseren Sichtbarkeit statt des Cursors ein 

roter Punkt angezeigt werden soll. (Wenn Sie erneut klicken, wird der rote Punkt wieder zu 

einem normalen Cursor.) 

 Klicken Sie in X, um die Diashow zu beenden und zu MindManager zurückzukehren. 

Zeigen Sie in den oberen Bereich des Fensters, um die Steuerelemente für die Miniaturbilder-Galerie 

einzublenden: 

 Die aktuelle Folie ist hervorgehoben. 

 Klicken Sie in eine der Folien. Sie wird sofort angezeigt. 

 Zum Ausblenden der Galerie drücken Sie Return oder Esc. Wahlweise können Sie auch den 

Cursor wieder in das Hauptfenster setzen. 

Zur Steuerung der Diashow können Sie auch die Tastatur, Gesten oder eine Apple-Fernbedienung 

verwenden. 

 

MANUELLE BEDIENELEMENTE FÜR DIE ANZEIGE VON DIASHOWS 

Für die Steuerung einer MindManager-Diashow können Sie die Tastatur, Gesten oder eine Apple-

Fernbedienung verwenden.  
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Tastenkombinationen 

Nächste Folie anzeigen Tab 
Vorige Folie anzeigen Shift-Tab 
Diashow beenden Esc 

Gesten 

Weiter zur nächsten Folie Wischen (drei Finger) links 
Zurück zur vorigen Folie Wischen (drei Finger) rechts 

Apple-Fernbedienung 

Zur nächsten Folie springen Play / Rechts/ Nach oben 
Zur vorigen Folie springen Menü / Links / Nach unten 
Diashow neu starten Play (halten) 
Diashow beenden  Menü (halten) 

EXPORTIEREN VON FOLIEN IN EINE KEYNOTE- ODER POWERPOINT-PRÄSENTATION 

Durch Exportieren Ihrer Map können Sie eine neue Keynote- bzw. PowerPoint-Präsentation 

erzeugen. Die neue Präsentation enthält für jede Folie in Ihrer Map eine Präsentationsfolie. Mit Hilfe 

der Exportoptionen können Sie festlegen, welche Map-Elemente in die Präsentation aufgenommen 

werden sollen. Zudem lassen sich einige grundlegende Aspekte der Formatierung und des Layouts 

definieren. 

So exportieren Sie Folien in eine Keynote- oder PowerPoint-Präsentation: 

1. Wählen Sie Ablage > Exportieren. 

2. Klicken Sie im Fenster Export in das Register iWork/Office. 

3. Wählen Sie Keynote oder PowerPoint als Dateityp, und klicken Sie dann in Weiter. 

H I N W E I S : Wenn Ihre Map keine Folien enthält, sind diese Optionen nicht verfügbar. 

4. Wählen Sie die für das Erzeugen der exportierten Datei zu verwendenden Optionen, und klicken 

Sie dann in Weiter. 

5. Geben Sie den Namen für die neue Präsentation ein, und wählen Sie ihren Speicherort. Klicken 

Sie dann in Exportieren. 

MindManager kann Ihre Map auch in eine Vielzahl anderer Formate exportieren und importieren.  
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BEHEBEN VON PROBLEMEN 

Wenn Sie bei der Verwendung von MindManager auf Probleme stoßen, finden Sie nachstehend vielleicht 

eine Lösung. 

PROBLEM: IN EINER AN EINEN KOLLEGEN WEITERGELEITETEN MAP SIND DIE HYPERLINKS BESCHÄDIGT. 

Wenn Sie eine Map weiterleiten, die Hyperlinks zu anderen Dokumenten enthält, müssen Sie die verknüpften 

Dokumente mit der Map zusammen verschicken, es sei denn, die Links verweisen auf ein Dokument, das sich 

an einem zentralen Ablageort befindet (z. B. einem Netzlaufwerk, zu dem beide Benutzer Zugang haben). 

Falls das Dokument, das Ziel des Hyperlinks ist, nicht an einem zentralen Ort abgelegt ist, gehen Sie 
wie folgt vor: 

1. Überzeugen Sie sich davon, dass Sie dem Empfänger alle verknüpften Dokumente mitschicken, wenn 

Sie die Map an ihn senden. 

2. Wenn die verknüpften Dokumente nicht aus dem gleichen Ordner wie die Map stammen, muss der 

Empfänger die verknüpften Dateien in einen Ordner mit gleichem Namen und gleichem relativen 

Ablageort wie die Map-Datei kopieren. 

Wahlweise können Sie Dokumente auch als Anhänge in die Map-Datei einbinden. Diese Dokumente 

sind Bestandteil der Map-Datei und werden automatisch mitgeschickt, wenn die Map versendet oder 

kopiert wird. 

PROBLEM: WENN ICH EINE FREIE ANMERKUNG VERSCHIEBE, WIRD DIESE AUTOMATISCH AN EINEN ANDEREN ZWEIG 

ANGEHÄNGT. 

Mit den nachstehend beschriebenen Schritten können Sie verhindern, dass ein Zweig an andere Zweige 

angehängt wird. 

SO VERSCHIEBEN ODER KOPIEREN SIE EINE FREIE ANMERKUNG: 

 Halten Sie beim Ziehen und Ablegen der freien Anmerkung die Shift-Taste gedrückt. 

PROBLEM: DAS HINTERGRUNDBILD, DAS ICH AUS DER BIBLIOTHEK GEZOGEN HABE, WIRD NICHT ANGEZEIGT. 

Wenn Sie das Hintergrundbild der Map ersetzen, indem Sie einen neuen Hintergrund aus der Bibliothek in die 

Map ziehen, wird für das neue Bild die bestehende Deckkrafteinstellung verwendet. Falls das neue Bild im 

Vergleich zum alten Bild eine hellere Farbe aufweist oder transparenter ist, kann das Bild u. U. nicht angezeigt 

werden. 
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So beheben Sie dies: 

 Wählen Sie Format > Hintergrund und erhöhen Sie die Einstellung für die Deckkraft. 

PROBLEM: EINIGE ELEMENTE WERDEN IN MEINER MAP NICHT MEHR ANGEZEIGT. 

Wenn einige Elemente (Zweige, Markierungen, Aufgabeninfos usw.) in Ihrer Map nicht mehr angezeigt 

werden, könnten sie aus verschiedenen Gründen ausgeblendet sein. 

Prüfen Sie Folgendes: 

 Wenn Zweige nicht mehr sichtbar sind, prüfen Sie, ob die Zweige nicht reduziert wurden. Das 

Icon Erweitern  gibt an, dass der Zweig Unterzweige hat. Klicken Sie in das Icon, um die 

Unterzweige einzublenden, oder markieren Sie das Hauptthema und wählen Sie Darstellung > 

Detail > Alle Ebenen anzeigen, um alle Zweige in der Map zu erweitern. 

 Zweige können auch durch einen aktiven Filter ausgeblendet sein. Wenn die Map beim Sichern 

gefiltert war, ist der Filter beim erneuten Öffnen immer noch aktiv. Dann wird am unteren Map-

Rand die Filteranzeige eingeblendet. Klicken Sie in der Anzeige in Filter entfernen, um die 

ausgeblendeten Zweige einzublenden. 

 Für andere fehlende Elemente wie Aufgabeninformationen, Icons, Markierungen usw. wählen 

Sie Darstellung > Einblenden & Ausblenden und prüfen, welche Elemente gegenwärtig 

ausgeblendet sind. 

 Wenn Zweigtext oder Zweigverbindungslinien verschwunden sind, wählen Sie den betroffenen 

Zweig aus. Dann wählen Sie Format > Zweig. Prüfen Sie im Bereich Format der Informationen zu 

Zweigen unter Farben die Linien- und Textfarbe des Zweiges. Wenn als Farbe für diese Linien 

Ohne eingestellt ist, sind die Linien unsichtbar. 

PROBLEM: DER SUCHBEFEHL FINDET NICHT ALLEN GESUCHTEN TEXT IN MEINER MAP. 

Wenn Sie Probleme haben, den gesamten gesuchten Text in Ihrer Map zu finden, müssen Sie u. U. die 

Suchoptionen verändern oder einen evtl. aktiven Filter aufheben. 

So beheben Sie dies: 

1. Zum Prüfen der Suchoptionen wählen Sie Bearbeiten > Suchen > Suchen. Dann klicken Sie in 

Optionen. Prüfen Sie Folgendes: 

 Stellen Sie sicher, dass Sie die gewünschten Optionen für Suchen in, Suchen u. a. ausgewählt 

haben. 

 Wenn Sie Text in das Feld Ersetzen eingegeben haben, werden Tags automatisch von der Suche 

ausgeschlossen (weil Text in Markierungen nicht ersetzt werden kann). 
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 Wenn die Option Nur sichtbare Zweige ausgewählt ist, wird der Text in den ausgeblendeten 

Zweigen bei der Suche übersprungen. 

H I N W E I S :  Die Optionen sind auch dann für die Suche wirksam, wenn sie nicht angezeigt werden. 

2. Wenn die Map gefiltert ist, wird der Text in den ausgeblendeten Zweigen bei der Suche generell 

nicht mit einbezogen. Prüfen Sie die Filteranzeige am unteren Map-Rand. 

 Um alle aktiven Filter zu entfernen, klicken Sie in der Anzeigeleiste in Filter entfernen. 

 

PROBLEM: MEINE MAP WIRD AUF MEHREREN SEITEN AUSGEDRUCKT. 

Wenn Sie Ihre Map stattdessen auf einer Seite ausdrucken möchten, gehen Sie wie nachstehend beschrieben 

vor. 

So drucken Sie eine Map auf einer einzelnen Seite aus: 

1. Wählen Sie Ablage > Papierformat und setzen Sie die Größe auf 100 %. 

2. Wählen Sie Ablage > Drucken und dann im Dialog Drucken: 

 Setzen Sie die vertikalen und horizontalen Seiten auf 1. 

(Klicken Sie in das Disclosure-Triangle neben dem Druckername, wenn diese Optionen nicht 

aufgeführt sind.) 

 Klicken Sie in Drucken



 

115 

APPENDIX 

KURZBEFEHLE FÜR DIE ARBEIT MIT MINDMANAGER 

Mit den Kurzbefehlen Ihrer Tastatur können Sie viele Aufgaben in MindManager schnell erledigen. Die 

Kurzbefehle für allgemeine Befehle finden Sie in den Menüs (oder in der folgenden Liste). Hinweis: In 

einigen Fällen müssen Sie zum Ausführen einiger Kurzbefehle die Umschalttaste gedrückt halten. 

Verwenden Sie die folgenden Kurzbefehle, um die zugehörigen Aktionen auszuführen. In MindManager 

verfügen viele Elemente (z. B. Zweige und Bilder) ebenfalls über Kontextmenüs. Zum Einblenden eines 

Kontextmenüs klicken Sie bei gedrückter Control-Taste in das jeweilige Element.  

Zweige und E L E M E N T E  

Auswahl  

Zweig oder Element auswählen Anklicken 

Benachbarten Zweig auswählen Pfeiltasten 

Nächsten/vorherigen Zweig auswählen Tab / Shift-Tab 

Alle in einem Bereich auswählen (Mapansicht)  Auswahlrechteck zeichnen 

Zweig oder Element zur ausgewählten Gruppe 
hinzufügen /  
Mehrere Zweige auswählen  

Befehl (⌘)-Klicken oder Shift-Klicken  

Hauptthema markieren Befehl (⌘)-Anfang 

Verschieben und Kopieren  

Ausgewählten Zweig oder Element verschieben Ziehen 

Ausgewählte(n/s) Zweig oder Element kopieren Option-Ziehen 

Zweig verschieben, um ihn zum Hauptzweig zu 
machen (Mapansicht)  

Befehl (⌘)-Ziehen 

Zweig verschieben, um ihn zur freien Anmerkung 
zu machen (Mapansicht)  

Umschalt-Ziehen 

Zweig nach links verschieben (Gliederungsansicht) Control-Befehl (⌘)-Linkspfeil  

Zweig nach rechts verschieben 
(Gliederungsansicht) 

Control-Befehl (⌘)-Rechtspfeil  

Zweig nach oben verschieben 
(Gliederungsansicht) 

Control-Befehl (⌘)-Nach-oben-Pfeil  

Zweig nach unten verschieben 
(Gliederungsansicht) 

Control-Befehl (⌘)-Nach-unten-Pfeil  
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Bearbeiten  

Zweigbearbeitungsmodus mit komplett 
markiertem Text starten (Mapansicht) 

F2 

Zweigbearbeitungsmodus mit Maustaste am 
Anfang des Textes starten 

Control-A 

Zweigbearbeitungsmodus mit Maustaste am Ende 
des Textes starten 

Control-E 

Zweigbearbeitungsmodus starten 
(Gliederungsansicht) 

Doppelklicken 

Zeilenumbruch in Zweig eingeben Shift-Zeilenschalter 

Zweigbearbeitungsmodus beenden (Mapansicht) Zeilenschalter 

Zweigbearbeitungsmodus beenden 
(Gliederungsansicht) 

Enter 

Im Zweigbearbeitungsmodus bleiben und 
Nebenzweig hinzufügen (Gliederungsansicht) 

Zeilenschalter 

Kontextmenü anzeigen Control-Klicken 

M I N D M A N A G E R - M E N Ü  

Einstellungen Befehl (⌘)-, (Komma) 

MindManager ausblenden Befehl (⌘)-H 

Andere ausblenden  Wahl-Befehl (⌘)-H 

MindManager beenden Befehl (⌘)-Q 

M E N Ü  " D A T E I "  

Eine neue Map anlegen Befehl (⌘)-N 

Eine neue Map auf Basis einer Vorlage erstellen  Shift-Befehl (⌘)-N 

Eine Map öffnen  Befehl (⌘)-O 

Die aktuelle Map schließen  Befehl (⌘)-W 

Speichern  Befehl (⌘)-S 

Sichern als  Shift-Befehl (⌘)-S 

Papierformat  Shift-Befehl (⌘)-P 

Map oder Folien drucken Befehl (⌘)-P 

M E N Ü  " B E A R B E I T E N "  

Widerrufen  Befehl (⌘)-Z 

Wiederholen Shift-Befehl (⌘)-Z 

Ausschneiden  Befehl (⌘)-X 

Kopieren  Befehl (⌘)-C 

Einsetzen  Befehl (⌘)-V 

Löschen  Löschen 

Zweig entfernen  Befehl (⌘)-Löschen  

Format kopieren  Wahl-Befehl (⌘)-C 
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Format einsetzen  Wahl-Befehl (⌘)-V 

Lesezeichen  

Lesezeichen hinzufügen Befehl (⌘)-D 

Nächstes Lesezeichen Wahl-Befehl (⌘)-B 

Vorheriges Lesezeichen Shift-Wahl-Befehl (⌘)-B 

Suchen  

Suchen Befehl (⌘)-F 

Weitersuchen Befehl (⌘)-G 

Auswahl für Suche übernehmen Befehl (⌘)-E 

Auswahl anzeigen Befehl (⌘)-J 

Suchen und Ersetzen Befehl (⌘)-R 

Rechtschreibung  

Rechtschreibung Befehl (⌘)-: (Doppelpunkt) 

Rechtschreibprüfung Befehl (⌘)-; (Semikolon) 

M E N Ü  " E I N F Ü G E N "  

Zweig davor  Shift-Zeilenschalter 

Zweig dahinter  Zeilenschalter  

Unterzweig Befehl (⌘)-Zeilenschalter, Control-Zeilenschalter 

Oberzweig Shift-Befehl (⌘)-Zeilenschalter 

Anmerkung  Wahl-Befehl (⌘)-Zeilenschalter 

Anhang Shift-Befehl (⌘)-T 

Hyperlink Shift-Befehl (⌘)-K 

Bild Shift-Befehl (⌘)-I 

M E N Ü  " A U S W Ä H L E N "  

Alles markieren  Befehl (⌘)-A 

Auswahl aufheben  Shift-Befehl (⌘)-A 

M E N Ü  " F O R M A T "  

Standardformat verwenden Wahl-Befehl (⌘)-X 

Schrift  

Schriften einblenden oder ausblenden Befehl (⌘)-T 

Fett Befehl (⌘)-B 

Kursiv Befehl (⌘)-I 

Unterstreichen Befehl (⌘)-U 

Größer Befehl (⌘)-+ 

Kleiner Befehl (⌘)- - (Minus) 

Text  

Linksbündig ausrichten  Befehl (⌘)-{ 



Mindjet MindManager Version 9 für Mac - Benutzerhandbuch 

118 

Zentriert Befehl (⌘)-| 

Rechtsbündig ausrichten  Befehl (⌘)-} 

Blocksatz  Wahl-Befehl (⌘)-| 

M E N Ü  " D A R S T E L L U N G "  

Gliederungsansicht / Mapansicht Wahl-Befehl (⌘)-O 

Notizen ein-/ausblenden (Bereich) Wahl-Befehl (⌘)-N 

Symbolleiste einblenden oder ausblenden Wahl-Befehl (⌘)-T 

Zoomen  

Zoomfaktor ändern  Control-Taste beim Scrollen mit der Maus 
gedrückt halten (nicht bei jeder Maus vorhanden)  

Vergrößern Befehl (⌘)-> 

Verkleinern  Befehl (⌘)-<  

Tatsächliche Größe  Befehl (⌘)-=  

Gesamte Map  F5 

Auswahl auf Fenstergröße  F4 

Detail  

Reduzieren Wahl-Befehl (⌘)-0 

1 Ebene anzeigen Wahl-Befehl (⌘)-1 

Alle Ebenen anzeigen Wahl-Befehl (⌘)-2 

Alle Ebenen anzeigen  Wahl-Befehl (⌘)-9 

Zweig fokussieren F3 

Filter  

Ausgewählte ausblenden Befehl (⌘)-[ 

Andere ausblenden Befehl (⌘)-] 

Filter entfernen Befehl (⌘)-\ 

Nach gesicherter Regel filtern (Regeln 1 - 9)  Befehl (⌘)-1 bis Befehl (⌘)-9  

M E N Ü  " F E N S T E R "  

Im Dock ablegen Befehl (⌘)-M 

Schnelleingabefenster ein-/ausblenden Wahl-Befehl (⌘)-M 

Informationen ein-/ausblenden Wahl-Befehl (⌘)-I 

Bibliothek ein-/ausblenden Wahl-Befehl (⌘)-L 

Farben ein-/ausblenden Shift-Befehl (⌘)-C 
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MINDMANAGER-EINSTELLUNGEN 

Mit diesen Optionen steuern Sie das Programmverhalten von MindManager. 

Bei Start  

Legen Sie fest, was MindManager tun soll, wenn Sie das Programm starten. 

 Startassistent anzeigen: Sie können die Anzeige des Assistenten auch im Fenster selbst 

deaktivieren. 

 Map-Galerie anzeigen: Diese Option verwenden Sie, wenn Sie beim Start in der Regel eine 

Vorlage oder eine vorhandene Map wählen möchten. 

 Neue Map anlegen Wenn Sie diese Option wählen, wird bei jedem Start von MindManager 

automatisch eine neue Map geöffnet. Standardmäßig wird dafür die Vorlage "Leere Map" 

verwendet, mit der (nächsten) Option Neue Map können Sie aber auch eine anderen Vorlage 

oder existierende Map festlegen. 

Neue Map  

Diese Option nutzen Sie, wenn beim Start eine neue Map geöffnet werden soll oder Sie Ablage > 

Neu wählen. 

 Wählen Sie eine Vorlage oder vorhandene Map. MindManager öffnet eine Kopie der Vorlage 

oder Map als neue ungesicherte Map; das Original ist nicht betroffen. Dies ermöglicht Ihnen, 

wiederholt eine Vorlage oder bestehende Map als Basis für die neue Map zu nutzen. 

 Ressourcen automatisch importieren von: Wählen Sie diese Option und legen Sie eine 

Quelle fest, wenn MindManager bei jedem Start einer neuen Map automatisch Kontakte aus 

Ihrem Adressbuch importieren soll. Die Kontakte werden als Ressourcen-Markierungen 

hinzugefügt und sind in der Liste Ressourcen in den Informationen zu Aufgaben verfügbar. 

Wenn Sie Ressourcen an Hauptthema anhängen wählen, wird eine .vcf-Datei mit den 

Kontaktdaten angefügt. 

 Kalender  

Wählen Sie den für neue Elemente, die Sie in MindManager erstellen, zu verwendenden iCal-

Kalender. 

 Neue Elemente hinzugefügt zu: Aktivieren Sie diese Option, um dem Kalender, den Sie 

festlegen, Kalender-Ereignisse und Kalender-Aufgaben, die Sie in MindManager anlegen, 

hinzuzufügen. 

 

Bearbeiten 

Steuert die Bearbeitung von Zweigtext und das Hinzufügen einiger Zweigtypen. 



Mindjet MindManager Version 9 für Mac - Benutzerhandbuch 

120 

 Eingabe ersetzt Auswahl: Wenn diese Option gewählt ist, ersetzt Zweigtext, den Sie 

eingeben, den bestehenden Zweigtext. Ist die Option nicht aktiv, wird eingegebener Text an 

den vorhandenen Text angefügt.  

 Bei Einfachklick freie Anmerkungen einfügen: Erleichtert das Einfügen freier Anmerkungen. 

Wenn diese Option nicht aktiv ist, klicken Sie in den Hintergrund und geben dann den 

Zweigtext ein. Wenn die Option aktiv ist, müssen Sie bei gedrückter Control-Taste in den 

Map-Hintergrund klicken (oder rechtsklicken) und dann Freie Anmerkung einfügen wählen 

oder die Menübefehle verwenden.  

 Anmerkungen zu neuen Verbindungen hinzufügen: Jeder neu erstellten Verbindung wird 

automatisch eine Anmerkung hinzugefügt. Mit Anmerkungen lassen sich weitere 

Informationen zu diesen zwanglosen Verbindungen liefern. 

 Anmerkungen zu neuen Klammern hinzufügen: Wenn Sie einen Klammerzweig anlegen, 

wird automatisch eine Anmerkung hinzugefügt. Mit dieser Anmerkung können Sie 

zusammenfassende Informationen liefern. Sie kann aus einem einzelnen Zweig bestehen 

oder Unterzweige haben. 

Sichern  

Hier legen Sie fest, ob automatisch Backups von Maps gesichert werden sollen. 

 Daten für automatische Wiederherstellung sichern alle __ Minuten: Es werden für offene 

Maps im festgelegten Intervall Backup-Daten gesichert. Wir empfehlen, diese Option 

aktiviert zu lassen, um bei unerwartetem Herunterfahren des Systems Datenverluste zu 

vermeiden. 

 

Visuelle Effekte 

Steuert, wie Elemente in Ihrer Map angezeigt werden. 

 Größere Icons und Bilder für Aufgabeninfos anzeigen: Zeigt Icon-Markierungen und 

Aufgabeninfo-Markierungen vergrößert an.  

 Füllfarbenverläufe anzeigen: Zeigt bei Zweigen mit Füllfarbe Farbenverläufe an. Andernfalls 

wird eine einheitliche Farbe verwendet. Das kann das Aussehen gedruckter oder exportierter 

Maps verbessern.  

 Bei Zweig-Überfahren Hervorhebung anzeigen: Zeigt bei Berührung mit dem Mauszeiger 

eine graue Umrisslinie um Zweige an. 

 Tipps zu Rückgängig/Wiederholen in Map anzeigen: Zeigt in der Map einen Tipp an, wenn 

Sie eine Aktion rückgängig machen oder wiederholen. 
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Browser  

Hier können Sie festlegen, dass Webseiten-Hyperlinks automatisch im integrierten 

MindManager-Browser geöffnet werden. 

 Links im MindManager-Browser öffnen: Zum Öffnen von Webseiten-Hyperlinks in Ihrer Map 

wird der integrierte Browser verwendet. Wenn der Browser immer im Vordergrund bleiben 

soll, wählen Sie Browser-Fenster im Vordergrund halten. 

Maßeinheiten  

Wählen Sie die für das Messen von Rändern und Abständen verwendete Maßeinheit. 

 Diese Einheiten werden im Register Abstände der Informationen zu Zweigen verwendet. 
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